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Δπραξηζηίεο 

 
Σήκεξα βξίζθνκαη ζηελ επράξηζηε ζέζε λα νινθιεξώλσ ηηο κεηαπηπρηαθέο ζπνπδέο κνπ ζην 

παηδαγσγηθό ηκήκα δεκνηηθήο εθπαίδεπζεο ηνπ Παλεπηζηεκίνπ Αηγαίνπ.  

Φσξίο ηελ ζηήξημε ηεο γπλαίθαο κνπ ζήκεξα δελ ζα βξηζθόκνπλ εδώ. Η εκπηζηνζύλε, ε αλνρή θαη ε 

ππνκνλή πνπ κνπ έδεημε ήηαλ όπια γηα κέλα γηα λα κπνξέζσ λα νινθιεξώζσ ζηνλ ζπληνκόηεξν δπλαηό 

ρξόλν ηηο ππνρξεώζεηο κνπ ζην ηκήκα. 

Επίζεο ζα ήζεια λα επραξηζηήζσ ηνπο γνλείο καο γηα ηελ ππνκνλή ηνπο άιια θαη ηελ ζπκπαξάζηαζή 

ηνπο πνπ είρακε. 

Θα ήζεια λα επραξηζηήζσ ην γην κνπ, πνπ αλ θαη λενγέλλεηνο, έδεημε κεγάιε θαηαλόεζε γηα ηηο θξύεο 

λύρηεο ηνπ ρεηκώλα πνπ δελ ήκνπλ θνληά ηνπ θαη γηα όιεο εθείλεο ηηο πξώηεο θνξέο ηνπ  πνπ έραζα αιιά 

θαη γηα ηελ πνιύηηκε βνήζεηά ηνπ θαηά ηε δηάξθεηα ηεο ζπγγξαθήο απηήο ηεο εξγαζίαο. 

 

Τέινο ζα ήζεια λα επραξηζηήζσ όινπο ηνπο θαζεγεηέο ηνπ κεηαπηπρηαθνύ γηα ηελ άςνγε ζπλεξγαζία 

πνπ είρακε όιν απηό ην δηάζηεκα θαη εηδηθά ηνπο θαζεγεηέο πνπ κεηέρνπλ ζηελ παξνύζα εξγαζία . 

 

Τελ εξγαζία απηή ηελ αθηεξώλσ ζηελ νηθνγέλεηά κνπ, ζην γην κνπ Γηώξγν θαη ηε γπλαίθα κνπ Κιαίξε. 
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ΠΔΡΗΛΖΦΖ 

 
Ζ παξνχζα δηπισκαηηθή εξγαζία εθπνλήζεθε ζην πιαίζην ησλ ζπνπδψλ γηα ηελ απφθηεζε ηνπ 

Μεηαπηπρηαθνχ Γηπιψκαηνο «Δπηζηήκεο ηεο αγσγήο : εθπαίδεπζε κε ρξήζε λέσλ ηερλνινγηψλ» απφ 

ην Παηδαγσγηθφ ηκήκα ηνπ Παλεπηζηεκίνπ Αηγαίνπ. Δληάζζεηαη ζην ζεκαηηθφ πεδίν ησλ Φπζηθψλ 

Δπηζηεκψλ θαη ηεο ειεθηξνληθήο κάζεζεο. 

Αξρηθά ε παξνχζα εξγαζία θάλεη κία εηζαγσγή ζηελ ηερλνινγία θαη ηνπο «γεληθνχο θαλφλεο» ηεο 

ειεθηξνληθήο κάζεζεο θαη επηρεηξεί λα αλαιχζεη έσο έλα βαζκφ ηνλ ηξφπν ελζσκάησζεο ησλ Νέσλ 

Σερλνινγηψλ ηεο Πιεξνθνξίαο θαη ησλ Δπηθνηλσληψλ (ΣΠΔ) ζην ρψξν ηεο εθπαίδεπζεο. 

Πξνρσξψληαο απφ ην γεληθφ ζην εηδηθφ, πεξηγξάθεηαη ε δηαδηθηπαθή εμ απνζηάζεσο εθπαίδεπζε κε 

ηε βνήζεηα ηνπ WEB 2.0, blogs – wikis – webquest , θαη ε εθπαηδεπηηθή δηαδηθαζία κε ρξήζε ηεο 

ηελρεηήο λνεκνζχλεο. Παξάιιεια, γίλεηαη αλαθνξά ζηηο ηερληθέο πξνδηαγξαθέο, ηα ραξαθηεξηζηηθά 

θαη ηελ ππνδνκή πνπ απαηηνχληαη γηα ηελ νξζή ππνζηήξημε ηεο φιεο δηαδηθαζίαο ελψ γίλεηαη 

αλαθνξά θαη ζηηο παηδαγσγηθέο αξρέο πνπ πξέπεη λα δηέπνπλ ην εθπαηδεπηηθφ πιηθφ ψζηε λα 

επηηπγράλεηαη ε δεηνχκελε πνηφηεηα ζηελ εθπαηδεπηηθή δηαδηθαζία.  

΢ε έλα δεχηεξν ζηάδην γίλεηαη κία πξνζπάζεηα εμεηδίθεπζεο ηεο δηπισκαηηθήο εξγαζίαο κε ηελ 

παξνπζίαζε θπζηθψλ «πξνβιεκάησλ» θαη ηελ επίιπζή ηνπο κε ηε βνήζεηα ηεο ππνινγηζηηθήο 

θπζηθήο κε ηε δεκηνπξγία θψδηθα ζε δηάθνξεο γιψζζεο πξνγξακκαηηζκνχ C++, Fortran 90 θαη Java 

κε ηέηνην ηξφπν ψζηε λα κπνξεί λα γίλεη ε ρξήζε ηνπο ηφζν ζε νπνηαζδήπνηε κνξθήο ειεθηξνληθήο 

κάζεζεο φζν θαη κε ηελ κνξθή ςεθηαθήο βηβιηνζήθεο (ςεθηαθνχ αληηθεηκέλνπ) γηα ελζσκάησζε ησλ 

δηαδηθαζηψλ θαη ζε άιια θπζηθά ή κε «πξνβιήκαηα». Αλαιχνληαη ηα ραξαθηεξηζηηθά ηεο επηζηήκεο, 

ν ξφινο ησλ γισζζψλ πξνγξακκαηηζκνχ θαη ε ζεσξεηηθή δηαδηθαζία κεηαθνξάο θαη επίιπζεο ησλ 

πξνβιεκάησλ ζηνπο Ζ/Τ. 

Ζ εξγαζία θαηαιήγεη ζε ζπκπεξάζκαηα θαη πξνηάζεηο ρξήζεο ησλ λέσλ ηερλνινγηψλ ζηελ 

εθπαίδεπζε θαη εηδηθά ην ξφιν ηεο ζηηο θπζηθέο επηζηήκεο. 

 

  

 

 

Λέμεηο θιεηδηά: Blogs , wiki , webquest, Τερλεηή λνεκνζύλε, Έκπεηξα ζπζηήκαηα γηα ηελ εθπαίδεπζε, 

Υπνινγηζηηθή επηζηήκε, Εθπαίδεπζε θαη Τερλεηή λνεκνζύλε, Εμ απνζηάζεσο εθπαίδεπζε, Web 2.0.   
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ABSTRACT 

 
The present diplomatic work was worked out in the frame of study for the acquisition of Master 

Diploma of “Sciences of education: education with the use of new technologies” from the Pedagogic 

department of Aegean University. It is included in the thematic field of Physics Sciences and 

elearning. Initially the present work makes an intro in the e-technology and the “general rules of” 

elearning and it attempts it analyzes until one degree the way of incorporation of new Technologies of 

Information and Communications (ICT) in the space of education. Advancing from general to the 

expert, are described the elearning with the help of WEB 2.0, blogs - wikis - webquest, and the 

educational process via PC with the use of Artificail intelligence. At the same time, becomes a report 

in technical specifications, characteristics and infrastructure that is required for the equitable support 

of all process while becomes report and in the pedagogic theories that should condition the educational 

material so that is achieved the asked quality in the educational process. In a second stage becomes a 

effort of specialisation of diplomatic work with the presentation of physics “problems” and their 

solution with the help of computational physics with the creation of code in various programming 

languages such as C++, Fortran 90 and Java in such a way that it can become their use so much in any 

form of elearning and also to in using them as a form of digital library (digital object) for 

incorporation of processes in other physics or not “problems”. Are analyzed the characteristics of 

science, the role of programming language and the theoretical process of transport and solution of 

problems with the simple use of one PC. The work leads to conclusions and proposals how to use the 

new technologies for education and specifically their role to physical sciences.  

 

 

Key Words: Blogs , wiki , webquest, Artificial Intelligence, Computational Science , AI and 

Education , E-learning ,Web 2.0.   
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1 ΔΗ΢ΑΓΧΓΗΚΔ΢ ΔΝΟΣΖΣΔ΢ 

1.1 Δηζαγσγή 

΢ήκεξα ζην ηνκέα ηεο εθπαίδεπζεο ηα πάληα αιιάδνπλ. Απφ ηελ παξαδνζηαθή εθπαίδεπζε έρνπκε 

αξρίζεη λα πεξλάκε ζηελ ειεθηξνληθή κάζεζε θαη ηελ εμ απνζηάζεσο εθπαίδεπζε. Πνιηηηθέο θαη 

νηθνλνκηθέο αλάγθεο έρνπλ αιιάμεη ην ηνπίν θαη ηνπο θαλφλεο ηνπ παηρληδηνχ. Σν δηαδίθηπν 

δεκηνπξγεί αληαγσληζκφ. Ζ ηερλνινγία θέξδε. ΢ήκεξα έρνπκε πεξάζεη απφ ην αξγφ Internet 

ηερλνινγίαο PSTN ησλ 56kbps ή ζηελ θαιχηεξε πεξίπησζε ηεο ηερλνινγίαο ISDN θαη ηηο «ηξνκεξήο» 

ζηαζεξήο ηαρχηεηαο ησλ 64kbps ή 128 kbps ζε επξπδσληθέο ή δνξπθνξηθέο ζπλδέζεηο ADSL κε 

ηαρχηεηεο ζηελ Διιάδα πνπ θηάλνπλ έσο ηα 20mbps ππφ ηδαληθέο ζπλζήθεο αιιά κε εγγπεκέλα. Ση 

ζεκαίλεη απηφ; Σελ δεκηνπξγία λέσλ ηερλνινγηψλ γηα ην δηαδίθηπν. Ο θεξδηζκέλνο, θπζηθά ε 

εθπαίδεπζε. Αλ πξηλ απφ κεξηθά ρξφληα έιεγε θάπνηνο φηη ζα κπνξέζεη απφ ην ζπίηη ηνπ λα 

παξαθνινπζήζεη δσληαλά καζήκαηα ή «θαληαζκέλνο» ζα ήηαλ ή αξθεηά πινχζηνο ψζηε λα κπνξέζεη 

λα αληέμεη ην θφζηνο κηαο DSL ζχλδεζεο. Πιένλ ην έδαθνο είλαη θαηάιιειν θαη ε εθπαίδεπζε κέζσ 

δηαδηθηχνπ αλαπηχζζεηαη ηαρχηαηα θαη δεκηνπξγεί λέεο δπλαηφηεηεο θαη δεδνκέλα. Νέεο ηερλνινγίεο, 

πεξηζζφηεξα θαη πνηνηηθφηεξα εθπαηδεπηηθά πξνγξάκκαηα θαη καζήκαηα παξέρνληαη απφ ηα 

εθπαηδεπηηθά ηδξχκαηα ηφζν ζε δηεζλέο επίπεδν φζν θαη ζηε ρψξα καο. Πξνζθέξνληαη ειεθηξνληθά 

καζήκαηα γηα φιεο ηηο εθπαηδεπηηθέο βαζκίδεο είηε κέζσ εμεηδηθεπκέλσλ εθαξκνγψλ Web 2.0 (Blog, 

wiki, webquest, RSS θιπ) θαη θαιχπηνπλ έλα επξχ θάζκα ζεκαηηθψλ ελνηήησλ θαη πεδίσλ θαη 

«δνπιεχνπλ» είηε ζπκπιεξσκαηηθά ζηελ παξαδνζηαθή εθπαίδεπζε είηε απηφλνκα γηα ηελ εθπαίδεπζε 

δηα βίνπ είηε σο εηδηθά καζήκαηα πνπ πξνζθέξνληαη εμ απνζηάζεσο παξάιιεια κε ηελ παξαδνζηαθή 

εθπαίδεπζε.  

Νέεο πξννπηηθέο θαη πξνθιήζεηο έξρνληαη θαη απφ ηελ αλάπηπμε ηεο ηερλνινγίαο ζηελ ηερλεηή 

λνεκνζχλε. Αλάγθεο γηα εμαηνκηθεπκέλε κάζεζε, γηα θαηαλφεζε δχζθνιψλ πξνβιεκάησλ, γηα 

θαζνδήγεζε θαη παξνρή βνήζεηα, γηα αλαδεηήζεηο «ζσζηψλ» πιεξνθνξηψλ,  έξρνληαη λα ιπζνχλ 

κέζα απφ ηελ αλάπηπμε ηεο ηερλνινγίαο ζηελ ηερλεηή λνεκνζχλε θαη ηελ ρξήζε ηεο ζηελ εθπαίδεπζε 

θαη ην δηαδίθηπν (ζεκαζηνινγηθφο ηζηφο).  

Οη εθπαηδεπηηθνί κε ηελ ηερλνινγηθή ηνπο επηκφξθσζε είλαη ζε ζέζε λα ρξεζηκνπνηήζνπλ έηνηκα 

εξγαιεία ή λα δεκηνπξγήζνπλ απφ κφλνη ηνπο ηα δηθά ηνπο εξγαιεία γηα ηελ δηεπθφιπλζε ηνπ 

εθπαηδεπηηθνχ ηνπο έξγνπ.  

Όιεο νη εθαξκνγέο ηεο ηερλνινγίαο ζηελ εθπαίδεπζε πεγάδνπλ κέζα απφ ηελ πηνζέηεζε βαζηθψλ 

παηδαγσγηθψλ αξρψλ θαη ζεσξηψλ. Όπσο ζα δνχκε ζε επφκελν θεθάιαην ηα βήκαηα είλαη δχν: πξψηα 

γίλεηαη ν παηδαγσγηθφο ζρεδηαζκφο θαη κεηά ν ηερλνινγηθφο ζρεδηαζκφο.  

Αληηθείκελν ηεο εξγαζίαο είλαη κηα ζχληνκε επηζθφπεζε ηεο ηερλνινγίαο  web 2.0 θαη ηεο ηερλεηήο 

λνεκνζχλεο γηα ρξήζε ζηελ εθπαίδεπζε θαη ε δεκηνπξγία εθαξκνγψλ (θψδηθα πξνγξάκκαηνο) γηα 

ηελ πξνζνκνίσζε καζεκάησλ ηεο θπζηθήο ζηνλ ππνινγηζηή.  
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Πξέπεη πάληα λα έρνπκε θαηά λνπ φηη βαζηθφ ζηνηρείν ζηελ πνηνηηθή εθπαίδεπζε είλαη ε ελζσκάησζε 

θαηάιιεισλ παηδαγσγηθψλ κεζφδσλ. Γηα λα έρνπκε κηα πνηνηηθή εθπαηδεπηηθή δηαδηθαζία δελ αξθεί 

ε απιή ρξήζε εγγξάθσλ, θεηκέλσλ, θσηνγξαθηψλ θαη ινηπνχ εθπαηδεπηηθνχ πιηθνχ ζηηο δηαδηθηπαθέο 

ζειίδεο ησλ καζεκάησλ. 

1.2 ΢θνπόο θαη ζηόρνη – εξεπλεηηθά εξσηήκαηα 

Ζ δηαηχπσζε ησλ ζθνπψλ κηαο έξεπλαο απνηειεί ηε βάζε ή ηνπο άμνλεο πάλσ ζηνπο νπνίνπο 

ζηεξίδεηαη ν εξεπλεηήο γηα λα απαληεζνχλ ηα εξεπλεηηθά εξσηήκαηα πνπ έρνπλ ηεζεί. Ζ παξνχζα 

δηπισκαηηθή εξγαζία έρεη σο ζθνπφ: i) ηελ αλάιπζε ηνπ επηπέδνπ δηείζδπζεο θαη ρξήζεο ησλ λέσλ 

ηερλνινγηψλ θαη εηδηθά ηνπ web 2.0 θαη ηελ ηερλεηήο λνεκνζχλεο ζηελ εθπαίδεπζε θαη ii) πνπ είλαη 

θαη ν βαζηθφηεξνο, ηε δεκηνπξγία πξνγξακκάησλ πξνζνκνίσζεο κε ηελ ρξήζε θψδηθα 

πξνγξακκαηηζκνχ γηα πεξηπηψζεηο ησλ θπζηθψλ επηζηεκψλ κε ηελ βνήζεηα ηεο ππνινγηζηηθήο 

θπζηθήο. Παξάιιεια, ε εξγαζία αλαθέξεη ηερληθέο θαη δηαδηθαζηηθέο πξνδηαγξαθέο γηα ηηο εθαξκνγέο 

ηνπ Web 2.0 θαη ηεο ηερλεηήο λνεκνζχλεο πνπ αμηνπνηνχληαη ζην πεδίν ηνπ e-learning δίλνληαο θαη 

ζχληνκεο πεξηγξαθέο ηνπο, αιιά θαη θάπνηα ζρέδηα καζήκαηνο. Αθνινχζσο ζα θάλεη κηα ζχληνκε 

πεξηγξαθή ηεο ππνινγηζηηθήο επηζηήκεο θαη ζπλνπηηθά ζα πεξηγξάςεη ηα «εξγαιεία» πνπ ρξεηάδνληαη 

γηα ηελ πινπνίεζε ησλ πξνγξακκάησλ δειαδή γίλεηαη αλαθνξά ζηηο γιψζζεο πξνγξακκαηηκζκνχ, 

ζην πεξηβάιινλ ηνπ ππνινγηζηή θαη ζηηο δηαδηθαζίεο εθηέιεζεο ελφο πξνξάκκαηνο. Δπηπιένλ   

αλαιχνληαη ηα ηερληθά ραξαθηεξηζηηθά, ε θηινζνθία ηνπ ζρεδηαζκνχ θαη νη απαηηήζεηο πνπ 

ρξεηάδνληαη ηελ αλάπηπμε ελφο νινθιεξσκέλνπ εθπαηδεπηηθνχ πιηθνχ γηα ην δηαδίθηπν. 

 Αλαδεηθλχνληαη βαζηθνί θαλφλεο θαη θαηεπζχλζεηο γηα ηνλ ζσζηφ ζρεδηαζκφ θαη πινπνίεζε κηαο 

εθπαηδεπηηθή δξαζηεξηφηεηαο ζην δηαδίθηπν. ΢ην ζεσξεηηθφ κέξνο ηεο εξγαζίαο δίλεηαη ην πιαίζην 

ησλ παηδαγσγηθψλ πξνδηαγξαθψλ θαη πξνρσξψληαο πξνο ζηηο δηαδηθηπαθέο ηερλνινγίεο νξίδεηαη έλα 

ζχλνιν απφ πξνδηαγξαθέο πνπ απαηηείηαη γηα ηελ ηειηθή κνξθή πνπ ζα έρεη ε δξαζηεξηφηεηα. Μέζα 

απφ απηή ηε δηαδηθαζία αλαδεηθλχνληαη νη δηαζέζηκεο ηερλνινγίεο ηνπ Web 2.0 θαη ηεο ηερλεηήο 

λνεκνζχλεο γηα ρξήζε ηνπο ζηελ εθπαίδεπζε. Αθνινπζεί ε πεξηγξαθή ησλ δηαζέζηκσλ ηερλνινγηψλ 

θαη εμεηάδεηαη ην αλ θαη ην πσο ζα κπνξέζεη λα ρξεζηκνπνηεζεί ζηελ εθπαίδεπζε. 

΢ην ηειεπηαίν θνκκάηη ε δηπισκαηηθή εξγαζία γίλεηαη πιένλ πξαθηηθή – πεηξακαηηθή. Αθνινπζνχλ 

πεξηπηψζεηο πξνζνκνίσζεο θάπνησλ θαηλνκέλσλ ησλ θπζηθψλ επηζηεκψλ. Γίλεηαη κεγάιε πξνζνρή 

ζην ηειηθφ απνηέιεζκα δειαδή ζηελ νπηηθνπνίεζε ησλ απνηειεζκάησλ πνπ ζα δψζνπλ ηα 

πξνγξάκκαηα πνπ δεκηνπξγήζεθαλ. ΢ηφρνο ινηπφλ είλαη ε νπηηθνπνίεζε ησλ θαηλνκέλσλ είηε κέζσ 

γξαθηθψλ παξαζηάζεσλ είηε κε ηε δεκηνπξγία πίλαθα ηηκψλ.  Σα πξνγξάκκαηα ζα πξέπεη λα 

ππνζηεξίδνπλ ηελ ηερλνινγία πνπ κειεηνχκε γη’ απηφ ην ιφγν επηιέγνπκε σο γιψζζα 

πξνγξακκαηηζκνχ ηελ Java πνπ ππνζηεξίδεη εθαξκνγέο ζην δηαδίθηπν. Σαπηφρξνλα ηα ίδηα 

πξνγξάκκαηα δίλνληαη θαη ζε άιιεο γιψζζεο φπσο C++ ή Fortran90 γηα ζχγθξηζε αιιά θαη γηα 

εθηέιεζε ηνπηθά ζε ειεθηξνληθφ ππνινγηζηή ρσξίο λα ππάξρεη αλάγθε γηα ζχλδεζε ζην δηαδίθηπν. 
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Γίλεηαη αλαθνξά θαη ζρνιηαζκφο - ζχγθξηζε πάλσ ζηελ «δηαθνξεηηθφηεηα» ησλ γισζζψλ 

πξνγξακκαηηζκνχ αιιά θαη γηα ηα επηκέξνπο ηκήκαηα πνπ ζπλζέηνπλ κηα γιψζζα πξνγξακκαηηζκνχ.   

΢ηα πνξίζκαηα – αμηνιφγεζε απνηειεζκάησλ ηεο δηπισκαηηθήο εξγαζίαο ζα αλαδεηθηνχλ νη 

δπλαηφηεηεο πνπ παξέρνπλ νη ηερλνινγίεο ηνπ web 2.0 θαη ηεο ηερλεηήο λνεκνζχλεο ζην ρψξν ηεο 

εθπαίδεπζεο, αιιά θαη ην πφζν εχθνια κπνξεί έλαο εθπαηδεπηηθφο λα βξεη ή λα δεκηνπξγήζεη απφ 

κφλνο ηνπ ηηο θαηάιιειεο ζπλζήθεο ψζηε λα κεηαθέξεη ηα πξνβιήκαηα ησλ καζεκάησλ πνπ δηδάζθεη 

ζηνλ ππνινγηζηή είηε κέζα απφ έηνηκεο πιαηθφξκεο ηεο ηερλεηήο λνεκνζχλεο είηε κε ηελ δεκηνπξγία 

πξνγξακκαηηζηηθνχ θψδηθα ζε κηα γιψζζα είηε κε ηελ ρξεζηκνπνίεζε έηνηκσλ θαη ειεχζεξσλ 

πξνγξακκάησλ πνπ ππάξρνπλ ζην δηαδίθηπν.  

 

Οη εξγαζία ζα πξνζπαζήζεη λα δψζεη ιχζεηο ζηα παξαθάησ εξεπλεηηθά εξσηήκαηα: 

1. Πξνάγνπλ ηειηθά ηελ ζπλεξγαηηθή κάζεζε ηα Blogs; 

2. Μπνξεί ε ηερλεηή λνεκνζχλε λα ζπκβάιεη ζηελ θαηαλφεζε ησλ θαηλνκέλσλ ησλ θπζηθψλ 

επηζηεκψλ; 

3. Οη έηνηκεο πιαηθφξκεο Σ.Ν. βνεζνχλ ηνπο εθπαηδεπηηθνχο λα ζρεδηάδνπλ καζήκαηα πνπ 

αλαπηχζζνπλ ηελ θξηηηθή ηθαλφηεηα ησλ καζεηψλ ηνπο; 

4. Τπάξρνπλ δηαζέζηκεο ειεχζεξεο εθαξκνγέο ή πξνγξάκκαηα πνπ λα εμππεξεηνχλ ηνπο 

δηδαθηηθνχο ζθνπνχο ή ζα πξέπεη ν εθπαηδεπηηθφο λα θηηάμεη δηθφ ηνπ θψδηθα;  

5. Μπνξνχλ νη καζεηέο απφ κφλνη ηνπο λα δεκηνπξγήζνπλ γξαθηθέο παξαζηάζεηο ησλ ζεσξηψλ 

ησλ θπζηθψλ επηζηεκψλ;  

6. Γηαηί λα επηιέμνπκε ηελ γιψζζα πξνγξακκαηηζκνχ Java θαη φρη ηελ C++ ή ηε Fortran γηα ηηο 

πξνζνκνηψζεηο εθπαηδεπηηθψλ εθαξκνγψλ ζην δηαδίθηπν; 

 

Οη απαληήζεηο ζηα παξαπάλσ κπνξνχλ λα ζπλεηζθέξνπλ ζην επξχηεξν πεδίν ηνπ e-learning θαη 

ζπγθεθξηκέλα ζηελ έληαμε απηψλ ησλ ηερλνινγηψλ επξχηεξα ζηελ εθπαηδεπηηθή δηαδηθαζία θαη ηελ 

αμηνπνίεζή ηνπο απφ εθπαηδεπηηθνχο θνξείο.  

Οη πιεξνθνξίεο πνπ ζα παξαζρεζνχλ πξνέξρνληαη απφ πξνζσπηθέο εκπεηξίεο θαη απφ εξεπλεηηθά 

πξνγξάκκαηα πνπ έρνπλ πινπνηεζεί ηελ ηειεπηαία δεθαεηία ζηελ Διιάδα θαη ην εμσηεξηθφ. Οη 

πιεξνθνξίεο απηέο κπνξνχλ λα θάλνπλ ρξήζηκεο ηφζν ζε εθπαηδεπηηθνχο φζν θαη ζε ζρεδηαζηέο 

ζπζηεκάησλ e-learning πνπ επηζπκνχλ λα εκπινπηίζνπλ ηνλ ηξφπν δηδαζθαιίαο ηνπο, λα 

δεκηνπξγήζνπλ λέεο πιαηθφξκεο ή λέα εθπαηδεπηηθά πξνγξάκκαηα, λα δεκηνπξγήζνπλ παθέηα 

εθπαηδεπηηθψλ ζεκαηηθψλ ελνηήησλ ζην δηαδίθηπν (webmaster – ζρεδηαζηέο), κε ζχγρξνλεο κεζφδνπο.  

 

1.3 Μεζνδνινγία - Μέζνδνο πξνζέγγηζεο 

΢ηελ παξνχζα εξεπλεηηθή εξγαζία δελ αθνινπζείηαη κία ζπγθεθξηκέλε κέζνδνο. Αλάινγα κε ηελ 

πεξίπησζε πνπ κειεηά ρξεζηκνπνηείηαη ε θαηάιιειε κέζνδνο ψζηε ζε θάζε πεξίπησζε λα 
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πεηπραίλνπκε ηε ζσζηή πξνζέγγηζε ζην αληηθείκελν ηεο κειέηεο καο. ΢ηελ παξνχζα εξγαζία θαηά 

θχξην ιφγν ζα ρξεζηκνπνηεζεί ε πεξηγξαθηθή κέζνδνο. Γίλεηαη ε πεξηγξαθή θαη αλάιπζε ησλ 

ζπζηεκάησλ web 2.0 θαη ηεο ηερλεηήο λνεκνζχλεο , ησλ ηερλνινγηψλ ηνπο, ηνπ ζρεδίνπ καζήκαηνο, 

θαη ησλ ζελαξίσλ ρξήζεο. Αθνινπζεί ε αλάιπζε γηα ηελ εθπαηδεπηηθή ρξήζε ησλ ηερλνινγηψλ απηψλ 

θαη παξνπζηάδνληαη επηγξακκαηηθά  δηαδηθηπαθνί ηφπνη πνπ πξνζθέξνπλ είηε ηελ ηερλνινγία απηή 

είηε καζήκαηα. Δπίζεο γίλεηαη αμηνιφγεζε εθπαηδεπηηθψλ site σο πξνο ηηο κεζφδνπο πνπ αθνινπζνχλ.  

΢ην δεχηεξν κέξνο ζα ρξεζηκνπνηεζεί ε κειέηε πεξίπησζεο πνπ απνβιέπεη ζηελ παξαηήξεζε 

ζπγθεθξηκέλσλ θαηλνκέλσλ ηεο θπζηθήο κε ηελ δεκηνπξγία θψδηθα. Θα ρξεζηκνπνηεζνχλ σο 

εξγαιεία γιψζζεο πξνγξακκαηηζκνχ, έλαο απιφο θεηκελνγξάθνο ρσξίο ζήκαλζε γηα ηελ ζπγγξαθή 

ηνπ θψδηθα θαη ην ινγηζηηθφ θχιιν ηνπ Excel γηα ηε δεκηνπξγία ησλ γξαθηθψλ παξαζηάζεσλ.  Θα 

εμεηαζηνχλ 10 πεξηπηψζεηο θπζηθψλ «πξνβιεκάησλ».  

Αλαιπηηθά ρξεζηκνπνηνχληαη ηα παξαθάησ εξγαιεία γηα ην πξνγξακκαηηζηηθφ κέξνο :  

Γηα ηελ πινπνίεζε ησλ πξνγξακκάησλ επηιέρζεθαλ ηα πξoγξάκκαηα Java ζηεο Sun, ε C++ ηεο 

Microsoft θαη ε Fortran επίζεο ηεο Microsoft. Χο ζπληάθηεο ηνπ θψδηθα ρξεζηκνπνηήζεθε ην 

πξφγξακκα JCreator ηεο Xinox Software. Γηα ηελ αλάγλσζε ησλ απνηειεζκάησλ ρξεζηκνπνηήζεθε ην 

ζεκεησκαηάξην ηεο Microsoft θαη ηέινο γηα ηελ γξαθηθή αλαπαξάζηαζε ησλ ηηκψλ πνπ πήξακε απφ 

ηα απνηειέζκαηα ρξεζηκνπνηήζεθε ην ινγηζηηθφ πξφγξακκα ηεο Microsoft Excel. Δπίζεο έγηλαλ 

ξπζκίζεηο ζηνλ ππνινγηζηή ζρεηηθά κε ηελ αμία ηεο ππνδηαζηνιήο θαη ηεο ηειείαο.  

Γηα ηελ εθηέιεζε ηνπ θψδηθα ρξεηάζηεθε ε εγθαηάζηαζε ηεο ηειεπηαίαο έθδνζεο ηνπ java sdk απφ 

ηελ εηαηξία Sun. Σα πξνγξάκκαηα δνθηκάζηεθαλ γηα ζπκβαηφηεηα θαη ζε πεξηβάιινλ Linux ρσξίο λα 

ρξεηαζηεί θακία αιιαγή ζηνλ θψδηθα. 

Γηα ηελ εθηέιεζε ησλ πξνγξακκάησλ ζε C++ ή Fortran απαξαίηεην είλαη λα ππάξρεη ην αληίζηνηρν 

ινγηζκηθφ. (Τπάξρνπλ εθδφζεηο ειεχζεξνπ ινγηζκηθνχ γηα ηα παξαπάλσ). 

Σέινο ρξεζηκνπνηείηαη ε ζπγθξηηηθή κέζνδνο γηα ηελ αμηνιφγεζε ησλ γισζζψλ πξνγξακκαηηζκνχ 

πνπ ρξεζηκνπνηνχληαη ζηελ παξνχζα εξγαζία. Μέζα απφ ηελ ζχγθξηζε θαηαιήγνπκε γηα πνηνλ ιφγν 

γίλεηαη ε επηινγή ζπγθεθξηκέλεο γιψζζαο γηα ηελ πινπνίεζε ησλ εθπαηδεπηηθψλ πξνγξάκκαησλ. 
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2 ΒΗΒΛΗΟΓΡΑΦΗΚΖ ΑΝΑ΢ΚΟΠΖ΢Ζ  
Ζ απνηειεζκαηηθή ρξήζε ησλ λέσλ ηερλνινγηψλ ζηελ εθπαίδεπζε έρεη απαζρνιήζεη πνιινχο 

εξεπλεηέο ηελ ηειεπηαία δεθαεηία εηδηθά κεηά ηελ ηερλνινγηθή έθξεμε ζηνλ ηνκέα ηεο πιεξνθνξηθή 

θαη ην δηαδίθηπν κε ηελ επξπδσληθφηεηα. Σα εξσηήκαηα πνπ κειεηψληαη θαη θαινχκαζηε λα δψζνπκε 

απαληήζεηο ζρεηίδνληαη κε ηελ απνηειεζκαηηθφηεηα ηεο ρξήζεο ησλ Ν.Σ. θαη ηεο «ζπλεξγαζίαο» ηνπο 

κε ηηο παηδαγσγηθέο ζεσξίεο θαη κεζφδνπο. ΢ήκεξα, εθηφο απφ ηηο έηνηκεο πιαηθφξκεο γηα εμ 

απνζηάζεσλ εθπαίδεπζε πρ Moodle, WebCT, E-class , Vista, Blackboard θιπ έρνπλ εηζέιζεη 

δπλακηθά ζην ρψξν ηεο εθπαίδεπζε ηερλνινγίεο φπσο ε ηερλεηή λνεκνζχλε θαη ην web 2.0 (Blog – 

wiki- webquest). 

Σνλ ξφιν ηνπ δηαδηθηπαθνχ ινγηζκηθνχ ζηε δηδαζθαιία ησλ θπζηθψλ επηζηεκψλ κειέηεζε ν 

Ενππίδεο (2007). ΢ηφρνο ηνπ ήηαλ ν ζρεδηαζκφο δηαδηθηπαθνχ ινγηζκηθνχ θαη ε ρξήζε ηνπ απφ 

καζεηέο θαη θαζεγεηέο πνπ βξίζθνληαη ζε δπζπξφζηηα ζρνιεία. Μέζα απφ απηή ηε δξαζηεξηφηεηα νη 

εθπαηδεπφκελνη ζα αλαπηχμνπλ θαη ζα αμηνπνηήζνπλ ηθαλφηεηεο απηνδχλακεο απφθηεζεο γλψζεο θαη 

ζα ηνπο δνζνχλ επθαηξίεο γηα ζπλεξγαηηθή κάζεζε θαη απηναμηνιφγεζε . ΢ηνπο θαζεγεηέο δίλεηαη ε 

δπλαηφηεηα λα νξγαλψζνπλ θαιχηεξα ην πιηθφ πνπ ζα δνζεί ζηνπο καζεηέο. ΢ηελ αμηνιφγεζε ηεο 

δηαδηθαζίαο απφ ηνπο καζεηέο ραξαθηεξηζηηθέο ήηαλ θάπνηεο απφ ηηο απαληήζεηο φπσο:  «κνπ άξεζε 

γηαηί ρξεζηκνπνηεί ηελ νπηηθναθνπζηηθή κέζνδν πνπ είλαη θαη πην απνηειεζκαηηθή» ελψ ζηελ 

εξψηεζε αλ ηελ βνήζεζε ε δηαδηθαζία απηή λα θαηαιάβεη πφηε έλα ζψκα επηπιέεη θαη πφηε βπζίδεηαη 

απάληεζε «λαη γηαηί έβιεπα ηε δηαδηθαζία πνπ γίλεηαη» δίλνληαο έκθαζε ζηε ρξεζηκφηεηα ησλ 

πνιπκεζηθψλ ζηνηρείσλ ησλ καζεζηαθψλ αληηθεηκέλσλ». 

Ο Mödritscher (2006) εξεχλεζε ηηο ζεσξίεο γηα ην e-learning ζηελ πξάμε θαη ζχγθξηλε ηηο ηξεηο 

ζεσξίεο κάζεζεο κε θχξην ζθνπφ λα δείμεη φηη ε κάζεζε κε ειεθηξνληθψλ κέζσλ δελ είλαη κηα απιή 

ππφζεζε ηερλνινγίαο θαη αλ εζηηάζεη θαλείο κφλν εθεί ηα απνηειέζκαηα δελ είλαη εγγπεκέλα. 

Πξνηείλεη ηε κεηαηφπηζε ηνπ ζρεδηαζκνχ ζηηο ζεσξίεο κάζεζεο θαη φρη ζηνλ ηερλνινγηθφ ηνκέα. Χο 

ζπκπέξαζκα ε έξεπλα έδεημε φηη πεηπραίλνπκε θαιχηεξε κεηαθνξά γλψζεο φηαλ νη ζπνπδαζηέο 

νινθιεξψλνπλ ηνπο ζηφρνπο κφλνη ηνπο. Γη’ απηφλ ηνλ ιφγν ζα πξέπεη νη εθπαηδεπηηθνί ζρεδηαζηέο λα 

εζηηάδνπλ ηελ πξνζνρή ηνπο ζηελ επηινγή ηεο  θαηάιιειεο ζηξαηεγηθή γηα e-κάζεζε. 

Οη  Pradeep θ.α (2004) εξεχλεζαλ ηηο εθπαηδεπηηθέο δπλαηφηεηεο ηνπ webquest θαη ηνλ ηξφπν πνπ ζα 

κπνξνχζαλ λα  ζπλδπάζνπλ ηελ ηερλνινγία κε ηηο εθπαηδεπηηθέο έλλνηεο πάλσ ζε κία δηαδηθαζία 

κάζεζεο πνπ είλαη βαζηζκέλε ζηελ έξεπλα.  Μάιηζηα εθάξκνζαλ ηελ έξεπλα ζε θνιιέγην ηεο 

Αιακπάκα πάλσ ζε ηξία καζήκαηα φπνπ ππήξρε δηπιή βαζκνινγία. Ζ βαζκνιφγεζε γηα ηελ 

δξαζηεξηφηεηα ηνπ webquest είρε σο ζθνπφ ηε ζχγθξηζή ηνπ κε ηελ επίδνζε πνπ είραλ κε ηελ 

παξαδνζηαθή δηδαζθαιία ψζηε λα βγνχλε θάπνηα πξψηα ζπκπεξάζκαηα γη’ απηήλ ηελ δξαζηεξηφηεηα.  

Οη Gulbahar θαη Madran (2006) εξεχλεζαλ ηνπο ηξφπνπο ρξεζηκνπνίεζεο ηνπ webquest ζε κία 

εθπαηδεπηηθή δξαζηεξηφηεηα. ΢θνπφο ηεο κειέηεο ηνπο ήηαλ λα ζρεδηαζηεί θαη αλαπηπρζεί έλα 
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δπλακηθφ webquest πνπ ζα άθελε πίζσ ηνλ απιντθφ θαη ζηαηηθφ ζρεδηαζκφ κηαο ηζηνζειίδαο θαη ζα 

έδηλε ηελ δπλαηφηεηα ηεο άκεζεο επηθνηλσλίαο κεηαμχ ησλ ζπκκεηερφλησλ.   

Γηα ηελ ρξήζε ησλ wikis ζηελ εθπαίδεπζε ε Grant (2006) εξεχλεζε ηελ δπλαηφηεηα ησλ wikis σο 

εξγαιεία κάζεζεο ζε online δηαδηθηπαθά πεξηβάιινληα. Δμέηαζε ηελ δπλαηφηεηα ππνζηήξημεο ηεο 

ζπλεξγαηηθήο κάζεζεο θαζψο επίζεο θαη ην θαηά πφζν ζα κπνξνχζε λα απηή ε κέζνδνο κάζεζεο λα 

ππνζηεξηρζεί απφ ηα ζρνιεία. 

Σν wiki σο εθπαηδεπηηθφ εξγαιείν κε ζε έλα ζπλεξγαηηθφ πεξηβάιινλ κειέηεζαλ θαη νη Parker θαη 

Chao (2007). Δπηβεβαηψλνπλ θαη ηελ έξεπλα ησλ Evans θαη Wolf (2005) φηη ηα wiki πξνζθέξνπλ 

εμαηξεηηθέο επθαηξίεο γηα ζπλεξγαζίεο κεηαμχ ησλ ζπκκεηερφλησλ θαη θάλνπλ ηα ηδξχκαηα πνπ ηα 

ρξεζηκνπνηνχλ αληαγσληζηηθά. Οη ζεκεξηλνί ζπνπδαζηέο φρη κφλν ζα δηαρεηξηζηνχλ ηηο 

επηρεηξεζηαθέο θαηλνηνκίεο ηνπ κέιινληνο, αιιά ζε πνιιέο πεξηπηψζεηο ζα ηηο νδεγήζνπλ. Με ηελ 

ελζσκάησζε ησλ wikis ζηελ ηάμε, νη εθπαηδεπηηθνί κπνξνχλ λα πξνεηνηκάζνπλ θαιχηεξα ηνπο 

ζπνπδαζηέο ηνπο ψζηε λα θάλνπλ θαηλνηφκεο ρξήζεηο ησλ ζπλεξγαηηθψλ εξγαιείσλ ησλ ινγηζκηθψλ. 

Οη Duffy θαη Bruns  (2006) εξεχλεζαλ ηηο εθπαηδεπηηθέο δπλαηφηεηεο ηνπ  Web 2.0 (ησλ blogs, wikis 

θαη ησλ RSS).  Μέζα απφ ηελ έξεπλά ηνπο έβγαιαλ ζεηηθά ζπκπεξάζκαηα γηα ην ξφιν ησλ Blogs θαη 

wikis πάλσ ζηε δηαινγηθή δέζκεπζε θαη αιιειεπίδξαζε κεηαμχ ζπνπδαζηψλ θαη κεηαμχ ζπνπδαζηψλ 

θαη δαζθάισλ. Καη ε δηθή ηνπο έξεπλα έδεημε φηη ε ηερλνινγία απηή ζπκβάιεη ζηελ ζπλεξγαηηθή 

δεκηνπξγία ηεο γλψζεο αιιά επηπιένλ αλάδεημε θαη ηελ δπλαηφηεηα αμηνιφγεζε ησλ εξγαζηψλ απφ 

ηνπο ίδηνπο ηνπο ζπνπδαζηέο, ηελ κάζεζε κέζα απφ βησκαηηθέο εκπεηξίεο θαη ηελ δπλαηφηεηα 

αλάπηπμεο απζεληηθψλ ζηφρσλ κάζεζεο. Ζ έξεπλά ηνπο αλάδεημε θαη ηελ «ππνρξέσζε» ησλ 

δαζθάισλ θαη ησλ καζεηψλ λα παξαθνινπζνχλ απφ θνληά ηηο ηερλνινγηθέο αιιαγέο επεηδή ε 

αλάπηπμε ζ’ απηφλ ηνλ ηνκέα είλαη κεγάιε θαη εκθαλίδνληαη λέα εξγαιεία θαη λέεο πξνζεγγίζεηο.     

Έλα βήκα παξαπάλσ έθαλε ε έξεπλα ηνπ Laine (2007) φπνπ εξεχλεζε ηελ δπλαηφηεηα ρξήζεο ησλ 

Blogs ζηελ εθπαίδεπζε φρη κε ηνλ παξαδνζηαθφ ηξφπν, ηνπο ππνινγηζηέο, αιιά κέζσ θηλεηψλ 

ηειεθψλσλ κέζσ ηεο πιαηθφξκαο ViSCos. 

Οη Huann, Ow θαη Yuen (2006) εμέηαζαλ ηελ ρξήζε ηνπ Blog ζηελ εθπαίδεπζε ζε ζρνιεία ηεο 

΢ηγθαπνχξεο. Ζ έξεπλα πνπ έθαλαλ ήηαλ ζρεηηθή κε ηνλ ηξφπν ρξήζεο απφ ηνπο δαζθάινπο ζηηο 

θαζεκεξηλέο δξαζηεξηφηεηεο , ηελ θνηλσληθή δηάζηαζε θαη ηνπο θαλφλεο «ιεηηνπξγίαο» ελφο blog 

δειαδή ζην ηη πξέπεη λα πξνζηίζεηαη σο πιεξνθνξία γηα γλψζε θαη ηη φρη, εηδηθά ζε κία επαίζζεηε 

πεξηνρή φπνπ ππάξρνπλ δηαθνξεηηθέο θπιέο ζηα ζρνιεία απηά. 

Ζ ρξήζε ηεο ηερλεηήο λνεκνζχλεο ζηελ εθπαίδεπζε δελ είλαη θάηη λέν. Σν λέν έξρεηαη απφ ηελ 

αλάπηπμε ηεο ηερλνινγίαο θαη ησλ λέσλ δπλαηνηήησλ πνπ πξνζθέξεη. Σα ςεθηαθά αληηθείκελα, ν 

επαλαρξεζηκνπνηνχκελνο θψδηθαο, νη πξάθηνξεο θαη ηα κνληέια δίλνπλ κηα λέα δηάζηαζε ζηε ρξήζε 

ηεο ζηελ εθπαίδεπζε. 
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Ο Backer (2000) εμέηαζε ηνλ ξφιν ησλ κνληέισλ ζηελ ηερλεηή λνεκνζχλε θαη ηελ εθπαίδεπζε. 

Δμέηαζε ηα πξφηππα σο επηζηεκνληθά εξγαιεία,  σο ζπζηαηηθά ησλ εθπαηδεπηηθψλ αληηθεηκέλσλ, θαη  

σο βάζεηο γηα ην ζρέδην  εθπαηδεπηηθψλ αληηθεηκέλσλ.  

Οη Chen θαη Chiu (2005) κειέηεζαλ ηελ θαηαζθεπή ζπζηήκαηνο γηα e-learning βαζηζκέλν ζηε ρξήζε 

πξαθηφξσλ. Ζ αξρηηεθηνληθή ελφο πεξηβάιινληνο e-κάζεζεο πξέπεη λα απνηειείηαη απφ : ηα εξγαιεία 

κάζεζεο,  έλα ζχζηεκα δηαρείξηζεο κάζεζεο, θαη  ςεθηαθέο δξαζηεξηφηεηεο κάζεζεο. Ζ ρξήζε ησλ 

επθπψλ πξαθηφξσλ  ζηελ e-κάζεζε πξέπεη λα είλαη κηα δηεπαθή ζεκηλαξίνπ ή κάζεζεο γηα ηνπο 

ζπκκεηέρνληεο, θαη ζθνπφο ηνπο είλαη λα βνεζήζνπλ ηε δηδαζθαιία θαη ηελ κάζεζε παίδνληαο 

δηαθνξεηηθνχο ξφινπο αλάινγα κε ηηο αλάγθεο πάληα ζε ζπλζήθεο online ζχλδεζεο. Οη Online βνεζνί 

δηδαζθαιίαο κπνξνχζαλ λα ρσξίζνπλ ηνπο πξνθαζνξηζκέλνπο, απφ πιεπξάο ηδηνηήησλ, πξάθηνξεο 

ζχκθσλα κε ηηο αλάγθεο θαη απηνί λα παξάγνπλ ζηφρνπο κάζεζεο φπσο θίλεηξν, θαζνδήγεζε θαη 

αλάιπζε ηνπ ζρεδίνπ κάζεζεο ζηνπο καζεηέο.   

Ο Kwong (2000) είρε λα αληηκεησπίζεη ηα παξαδνζηαθά πεηξάκαηα ηεο θπζηθήο ζηελ β/βάζκηα 

εθπαίδεπζε. Σα παξαδνζηαθά πεηξάκαηα θπζηθήο ζηα λέα  επίπεδα γπκλαζίνπ θαη θνιιεγίσλ 

απαηηνχλ απφ ηνπο ζπνπδαζηέο λα αθνινπζήζνπλ απζηεξά ζπγθεθξηκέλα βήκαηα γηα λα εθηειέζνπλ 

πεηξάκαηα. Απηά ηα πεηξάκαηα είλαη ζπρλά βαξεηά θαη ηηο πεξηζζφηεξεο θνξέο δελ πεηπραίλνπλ ηνπο 

εθπαηδεπηηθνχο ηνπο ζηφρνπο γηα ηνπο πεξηζζφηεξνπο ζπνπδαζηέο. Απηή ηελ «πξνβιεκαηηθή» κάζεζε 

πξνζπάζεζε λα ιχζε κε  ρξήζε ινγηζκηθνχ αλάιπζεο ζηνηρείσλ ζε έλαλ πξνζσπηθφ ππνινγηζηή. 

Οη Yung-Jen θαη Jung Ting (1998) ρξεζηκνπνίεζαλ ηελ εθαξκνγή PHYSIMC, ε νπνία ππνζηεξίδεη ηε 

δνκεκέλε εθκάζεζε ηεο ζηνηρεηψδνπο θπζηθήο κέζα απφ έλα πεξηβάιινλ πξνζνκνίσζεο ζε έλαλ 

ππνινγηζηή. 

Οη Pattnaik θαη άιινη (1986) έθαλαλ κηα πξνζπάζεηα λα ζπλδέζνπλ παηδαγσγηθά ραξαθηεξηζηηθά  κε 

ηελ ρξήζε ηεο ηερλνινγίαο γηα ηελ δηδαζθαιία ηεο θπζηθήο. Ζ πξφζθαηε έθξεμε ζε πξνγξάκκαηα 

ηερλεηήο λνεκνζχλεο θέξλεη κηα απνιχησο λέα θαηεγνξία εξγαιείσλ ππνινγηζκνχ θαη 

θαηαδεηθλχνπλ ηε ρξεζηκφηεηα ηνπ αιγεβξηθνχ πξνγξακκαηηζκνχ κε ηελ παξνπζίαζε ελφο 

ζπγθεθξηκέλνπ παξαδείγκαηνο ζηελ έξεπλα ηεο θπζηθήο ζηεξεάο θαηάζηαζεο . 

Οη Amorim θαη άιινη (2004)  αζρνιήζεθαλ κε ηνλ γελεηηθφ αιγφξηζκν ν νπνίνο είλαη έλαο απφ ηνπο 

επηηπρέζηεξνπο ηξφπνπο γηα λα ιπζνχλ δχζθνια ζπλδπαζηηθά πξνβιήκαηα. Οη δηαδηθαζίεο πνπ 

πεξηγξάθνληαη ζην άξζξν ηνπο θαηαδεηθλχνπλ πψο νη έλλνηεο πνπ πξνέξρνληαη απφ ηα καζεκαηηθά, 

ηνπο ππνινγηζηέο θαη ηε βηνινγία  κπνξνχλ λα ρξεζηκνπνηεζνχλ γηα λα ιχζνπλ πνιιά δηαθνξεηηθά 

πξνβιήκαηα. ΢ε απηήλ ηελ εξγαζία, εμεηάδεηαη έλα πξφβιεκα ζρεδίαζεο ελφο ηειεζθφπηνπ. 

Ζ ηερλνινγία ησλ θηλεηψλ ηειεθψλσλ θαη ε δπλαηφηεηα ππνζηήξημεο ηερλεηήο λνεκνζχλεο γηα 

εθπαηδεπηηθφ ζθνπφ έρεη εμεηάζηεθε πξφζθαηα απφ ηελ έξεπλα ησλ Castano θαη άιισλ (2008). 

΢ηφρνο ηνπο ε ηερλνινγία Bluetooth πνπ κπνξεί λα ππνζηεξίμεη πνιιαπινχο ρξήζηεο κέζα ζε έλα 

πεξηνξηζκέλν πεξηβάιινλ «κηα ηάμε». Οη δξαζηεξηφηεηεο ησλ ζπνπδαζηψλ κπνξνχζαλ λα 
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επνπηεπζνχλ κε ηε βνήζεηα ζηξαηεγηθψλ ΣΝ (πξνγξακκαηηζκφο, ζρεδηαζκφο θαη έκπεηξα 

ζπζηήκαηα). Δλζσκαηψλνληαο απηέο ηηο ηερλνινγίεο, νιφθιεξν ην ζχζηεκα ζα είλαη ζε ζέζε λα 

αλαγλσξίζεη θάζε ρξήζηε, λα νξγαλψζεη ηελ εξγαζία ηνπ/ηεο θαη λα αμηνινγήζεη ηα απνηειέζκαηά 

ηνπ/ηεο ρσξίο ή ιίγε επέκβαζε εθπαηδεπηηθψλ. 

Μεγάιε αμία ζηελ θαηαλφεζε δχζθνισλ ελλνηψλ θαη θαηλνκέλσλ ζε δηάθνξνπο ηνκείο φπσο είλαη νη 

θπζηθέο θαη νη ηαηξηθέο επηζηήκεο έρνπλ θέξεη νη γιψζζεο πξνγξακκαηηζκνχ κε ηελ δεκηνπξγία 

πξνγξακκάησλ πξνζνκνίσζεο. Μία γιψζζα πνπ έρεη θέξεη κεγάιε αιιαγή ζηελ εθπαίδεπζε κέζσ 

ηνπ Internet , εμαηηίαο ηνπ φηη πξνζθέξεηαη δσξεάλ θαη είλαη πιήξσο ζπκβαηή κε ην δηαδίθηπν, είλαη ε 

Java. Οη εθαξκνγέο ηεο , applets  θαη javascripts , κπνξνχλ λα βνεζήζνπλ ζηελ δεκηνπξγία κηαο 

δηαινγηθήο δηεπηθάλεηαο  θαη κέζα απφ ηηο γξαθηθέο ηεο ηθαλφηεηεο κπνξεί λα απμήζεη ην ελδηαθέξνλ 

θαη ην θίλεηξν ησλ ζπνπδαζηψλ ψζηε λα ζπκκεηέρνπλ πην ελεξγά ζηηο εθπαηδεπηηθέο δξαζηεξηφηεηεο. 

Ο Bulnova (2003) εξεχλεζε ηε ζπκβνιή ηεο γιψζζαο Java θαη ησλ πξνγξακκάησλ ηεο ζηελ 

εθπαηδεπηηθή δηαδηθαζία. ΢ηφρνο ηεο κειέηεο ήηαλ λα παξνπζηαζηνχλ ηα πιενλεθηήκαηα πνπ δίλεη ε 

γιψζζα πξνγξακκαηηζκνχ Java ζηελ εθπαίδεπζε κε ηελ πξνζνκνίσζε θαηαζηάζεσλ αθνχ ε 

ζπγθεθξηκέλε γιψζζα ζπλεξγάδεηαη απφιπηα κε ηελ δηαδηθηπαθή ηερλνινγία θαη ην πξσηφθνιιν 

HTML. Λφγσ ηεο δνκήο ε Java πξνζθέξεη πινχζηεο γξαθηθέο ηθαλφηεηεο θαη ηα πξνγξάκκαηά ηεο 

επηηξέπνπλ ζε πξαγκαηηθφ ρξφλν αιιειεπίδξαζε κε ηνπο ρξήζηεο. ΢ην δηαδίθηπν ππάξρεη πιεζψξα 

πξνγξακκάησλ ειεχζεξσλ πξνο ρξήζε θαη επεμεξγαζία. 

Ζ αλάγθε ρξήζεο ελφο γξαθηθνχ πεξηβάιινληνο πξνζνκνίσζεο γηα εθπαηδεπηηθνχο ζθνπνχο 

εμεηάδεηαη θαη απφ ηνπο Heermann θαη Fuhrmann ( 1999) γηα ηελ εμέηαζε ησλ θπζηθψλ λφκσλ. Οη 

καζεηέο κπνξνχλ λα πξνζνκνηψζνπλ θαη λα επηβεβαηψζνπλ ή φρη εχθνια ηηο ππνζέζεηο πνπ έθαλαλ 

γηα θάπνην θπζηθφ θαηλφκελν, λα εμεηάζνπλ θάπνηεο επηπιένλ πεξηπηψζεηο θαη  λα επεθηείλνπλ ηηο 

ζεσξίεο ηνπο . Απηφ κπνξεί λα γίλεη εχθνια κε ηε ρξήζε ζπκπιεξσκαηηθνχ θψδηθα ή ηξνπνπνίεζε 

ηνπ ήδε ππάξρνληα. 

Οη Wolfgang, Belloni θαη Dancy (2001) κειέηεζαλ ηελ ρξήζε κηαο έηνηκεο πιαηθφξκαο κε εξγαιεία 

Java γηα καζήκαηα θπζηθήο βαζηζκέλα ζην δηαδίθηπν. Παξά ηνπ φηη ε πιαηθφξκα πεξηέρεη έηνηκα 

εξγαιεία, δίλεη ζηνπο ρξήζηεο ηε δπλαηφηεηα λα δεκηνπξγήζνπλ νη ίδηνη λέα θαη αλ επηζπκνχλ λα ηα 

«κνηξάζνπλ» θαη ζε άιινπο. Μάιηζηα κε βάζε ηα απνηειέζκαηα ηεο έξεπλαο ζεσξνχλ ην εξγαιείν 

ζεκαληηθφ ζην κέξνο ηνπ δηαινγηθνχ δηδαθηηθνχ πιηθνχ πνπ ζρεδηάδεηαη γχξσ απφ ηηο αλάγθεο ηνπ 

ζπνπδαζηή.  

΢ε λέα έξεπλά ηνπο νη Wolfgang, Belloni θαη Dancy (2004) επαλέξρνληαη γηα ηηο δπλαηφηεηεο πνπ 

πξνζθέξεη ε Java θαη ην Physlets δεκηνπξγψληαο αζθήζεηο θαη πξνζνκνηψζεηο ζρεηηθά κε ηελ νπηηθή- 

θπκαηηθή. Οη αζθήζεηο θαη νη πξνζνκνηψζεηο πνπ δεκηνπξγήζεθαλ εζηηάδνπλ ζηελ  απεηθφληζε 

ελλνηψλ πνπ νη ζπνπδαζηέο δελ θαηαλννχλ κε ηελ παξαδνζηαθή δηδαζθαιία. Ζ ζπγθεθξηκέλε νκάδα 

έρεη δεκηνπξγήζεη πνιιέο εθπαηδεπηηθέο αζθήζεηο πάλσ ζε ζέκαηα ησλ θπζηθψλ επηζηεκψλ πνπ 
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ζπκβάιινπλ ζεηηθά ζηελ θαηαλφεζε θαη θαηάθηεζε ηεο γλψζεο ζε «δχζθνιεο» γηα ηνπο καζεηέο 

ζεκαηηθέο ελφηεηεο. 
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3 ΤΠΖΡΔ΢ΗΔ΢ ΓΗΑΓΗΚΣΤΟΤ: E-LEARNING 

3.1 Δηζαγσγή 

Ο παγθφζκηνο ηζηφο απνηειεί έλα ηδαληθφ πεξηβάιινλ δηδαζθαιίαο. Σέηνηνπ είδνπο δηδαζθαιία 

θαιείηαη εθπαίδεπζε απφ απφζηαζε. Έλαο νιφθιεξνο θφζκνο δνπιεχεη πξνο απηήλ ηελ θαηεχζπλζε 

κε ζθνπφ ηελ βειηίσζε ησλ ππαξρφλησλ ζπζηεκάησλ – εξγαιείσλ αιιά θαη ηελ δεκηνπξγία λέσλ, 

ζχγρξνλσλ θαη πην απνηειεζκαηηθψλ.  Χο απνηέιεζκα απηήο ηεο εξγαζίαο είλαη ηα ιεγφκελα 

ζπζηήκαηα εθπαίδεπζεο απφ απφζηαζε βαζηδφκελα ζην δηαδίθηπν, Web Based Educational Systems 

(WBES) θαη  Web Based Distance Learning systems (WDLS). 

΢ηελ ειεθηξνληθή κάζεζε γεληθά δελ ππάξρεη επηθνηλσλία πξφζσπν κε πξφζσπν κεηαμχ εθπαηδεπηή - 

εθπαηδεπφκελνπ. Ο εθπαηδεπφκελνο εξγάδεηαη κφλνο ηνπ γη’ απηφ θαη ζα πξέπεη ην εθπαηδεπηηθφ πιηθφ 

λα έρεη κία δνκεκέλε κνξθή. Σν πιηθφ ζα πξέπεη λα πξνζνκνηψλεη ηελ επηθνηλσλία εθπαηδεπφκελνπ – 

εθπαηδεπηή κε ηελ πξαγκαηηθή επηθνηλσλία ψζηε λα δεκηνπξγείηαη ε αίζζεζε φηη ν εθπαηδεπφκελνο 

βξίζθεηαη  πξαγκαηηθά κέζα ζε ηάμε, ή ζε ηδηαίηεξν κάζεκα. ΢χκθσλα κε ηνλ Peraya (1994) « ε 

εθπαηδεπηηθή πιεξνθνξία πξέπεη λα είλαη νινθιεξσκέλε θαη λα παξέρεη ζηνλ εθπαηδεπφκελν φιεο ηηο 

πιεξνθνξίεο πνπ ηνπ ρξεηάδνληαη. Πνηεο είλαη απηέο: Πεξηερφκελα, εμεγήζεηο, παξαδείγκαηα, 

εθαξκνγέο, αζθήζεηο κε ηηο ιχζεηο ηνπο, νξνινγία, βνεζήκαηα θιπ ». 

Ζ εθπαηδεπηηθή πιεξνθνξία φκσο κπνξεί λα βξεζεί θαη ζε κε δνκεκέλεο πξνζπάζεηεο φπσο (ζειίδεο 

δηαδηθηχνπ πνπ δεκνζηεχεη εθπαηδεπηηθφ πιηθφ ζε ςεθηαθή κνξθή). Ζ ζπλεξγαζία θαη 

δηαιεηηνπξγηθφηεηα ησλ εθπαηδεπηηθψλ πεγψλ πξέπεη λα πεξηιακβάλεη θάζε είδνπο δπλαηή 

εθπαηδεπηηθή πιεξνθνξία πνπ κπνξεί λα βξεζεί. (΢νισκφο, 2005).   

Σν πιαίζην ηεο ζπλεξγαζίαο ησλ εθπαηδεπηηθψλ πεγψλ πεξηιακβάλεη ηφζν ηε δηαδηθαζία αλεχξεζεο 

θαηάιιεινπ εθπαηδεπηηθνχ πιηθνχ, φζν θαη ηεο εηζαγσγήο ηεο εθπαηδεπηηθήο πιεξνθνξίαο έηζη ψζηε 

λα θαιχπηνπλ ηφζν ηνλ εθπαηδεπφκελν φζν θαη ην ζπγγξαθέα-δάζθαιν ηνπ εθπαηδεπηηθνχ πιηθνχ. 

3.2 Νέεο ηερλνινγίεο θαη παηδαγσγηθή 

Ο Moore (ζηελ εξγαζία ηνπ Bonk, 2006) ππελζπκίδεη φηη θάπνηνο κπνξεί, θαη πξέπεη, λα κειεηήζεη 

ηελ έλλνηα ηεο εμ απνζηάζεσο εθπαίδεπζεο απφ ηελ άπνςε ηνπ δαζθάινπ ηάμεσλ θαη ησλ 

παηδαγσγηθψλ ζεσξηψλ πνπ θξχβνληαη θάησ απφ ηηο πξαθηηθέο ησλ ηάμεσλ. Οη παηδαγσγηθέο ζεσξίεο 

ζπλδένληαη κε ηνπο ζπνπδαζηέο θαη ηα απνηειέζκαηα κάζεζεο  θαη έρνπλ γίλεη επξέσο απνδεθηέο γηα 

επηζηεκνινγηθνχο θαη εκπεηξηθνχο ιφγνπο. Καηά απηφλ ηνλ ηξφπν, ην δήηεκα ηεο ελζσκάησζεο ηεο 

εμ απνζηάζεσο εθπαίδεπζεο  ζην παηδαγσγηθφ ζχζηεκα έρεη πξνθχςεη πξφζθαηα σο ην πιένλ 

ζεκαληηθφ δήηεκα πηέδνληαο γηα άκεζε  έξεπλα (Mehanna, 2004). Ο Mayes (2004) δειψλεη φηη γηα 

έλα θαιφ παηδαγσγηθφ ζρέδην, ππάξρεη απιά  ε αλάγθε λα πηνζεηεζεί κηα ζεσξία κάζεζεο. 
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3.3 Παηδαγσγηθνί ζηόρνη γηα ην E-learning 

Σα δπλακηθά εηθνληθά πεξηβάιινληα  - Virtual Learning Environment (VLE) - ζηνρεχνπλ ζην λα 

ππνζηεξίμνπλ φζνπο ζέινπλ λα ρξεζηκνπνηήζνπλ ηελ ηερλνινγία γηα κάζεζε θαη επηθνηλσλία κε 

άιινπο πνπ κεηέρνπλ ζηελ ίδηα δηαδηθαζία φπσο «ζπκκαζεηέο» , εθπαηδεπηέο, ππεξεζίεο βηβιηνζήθεο 

θιπ. 

΢χκθσλα κε ηηο νδεγίεο ηνπ Quality Assurance Agency (QAA 2006) - Τπεξεζία  Δμαζθάιηζεο 

Πνηφηεηαο -  γηα ηελ απφ απφζηαζε εθπαίδεπζε: «Σν VLE ζχζηεκα, ν ζρεδηαζκφο θαη ε παξάδνζε 

πξνγξάκκαηνο, ε αλάπηπμε θαη ε ππνζηήξημε ζπνπδαζηψλ, ε επηθνηλσλία θαη ε αληηπξνζψπεπζε 

ζπνπδαζηψλ, θαη ε αμηνιφγεζε φισλ ησλ ζπνπδαζηψλ απνηεινχλ θξίζηκα εξσηήκαηα γηα ηδξχκαηα – 

ζρνιεία ζρεηηθά κε ηνπο ηξφπνπο κε ηνπο νπνίνπο ζα πξέπεη λα νξγαλψζνπλ ηε  δηδαζθαιία ψζηε  λα 

εμαζθαιίδεηαη  ε πνηφηεηα  κάζεζεο».  Ο Stanley έρεη πεη  «Έρσ δηαβάζεη πνιιέο θνξέο όηη ην VLE 

είλαη έλαο δνύξεηνο ίππνο πνπ νδεγεί ην πξνζσπηθό λα ζθεθηεί ην πώο ζα δηδάμνπλ. Μόιηο θάλνπκε ηελ 

θίλεζε λα εκπιαθνύκε κε ην E-learning , καο θάλεη λα ζθεθηνύκε  άκεζα ηελ  πξόζσπν κε πξόζσπν 

δηδαζθαιία.» (Staley, 2004) 

Ζ πνιηηηθή ηεο αλνηθηή θαη εμ απνζηάζεσο εθπαίδεπζεο  ζέηεη  ηνπο παξαθάησ ζηφρνπο: 

 Σα καζήκαηα ζε κεγάιν πνζνζηφ λα έρνπλ ππνζηήξημε VLE  ηνπιάρηζηνλ ζε επίπεδν Online 

βνήζεηα αλά  ελφηεηα  

 Σν κεγαιχηεξν κέξνο ησλ καζεκάησλ λα ππνζηεξίδνληαη νπζηαζηηθφηεξα απφ Online αλνηθηή 

κάζεζε  

 Να ππάξρεη ζπλερψο απμαλφκελν πνζνζηφ ησλ εγγξακκέλσλ ζπνπδαζηψλ ζε δηαδηθηπαθέο 

γλσζηηθέο ζεκαηηθέο ελφηεηεο   

 Να παξέρεη νινθιεξσκέλν ζχζηεκα δηαρείξηζεο ζπνπδαζηψλ  

 Να ππάξρεη απμαλφκελνο αξηζκφο πξνζσπηθνχ WebCTtrained (πξνζσπηθφ εμεηδηθεπκέλν γηα 

παξνρή ηέηνησλ ππεξεζηψλ) . 

3.4 Αλάπηπμε – ΢ηάδηα ηνπ E-learning 

Ζ ειεθηξνληθή κάζεζε αλαθέξεηαη ζηε βηβιηνγξαθία σο έλα πνιπζχλζεην ζχζηεκα ζεζκψλ απφ ηνλ  

Moore (1996). Αλαθέξεη κάιηζηα φηη απνηειείηαη απφ επηκέξνπο ηερληθέο θαη θνηλσληθά ζπζηαηηθά. Ζ 

εκπεηξία φκσο ηνπ e-learning είλαη ελζσκαησκέλε ζε φια ηνπ ηα επηκέξνπο ζπζηαηηθά. Μηα αιιαγή 

ζε έλα κέξνο ζα έρεη επηπηψζεηο ζε νιφθιεξν ην ζχζηεκα (Garrison, 2004).  Ο Garrison πξνζεγγίδεη 

ηελ ειεθηξνληθή κάζεζε κέζσ ησλ γελεψλ κάζεζεο, θάλνληαο  θξηηηθή πάλσ ζην ζρέδην ηαμηλφκεζεο 

πνπ έρεη θάλεη, θαη  πξνζδηνξίδεη ηελ αμία ηεο ζην θέξδνο ηεο πξννπηηθήο θαη  ζην γεληθφ πιαίζην . Ο 

παξαθάησ πίλαθαο 3.1 επηηξέπεη λα γίλεη κηα ζχγθξηζε  θαη λα αληηπαξαβάιεη  ηελ αλάπηπμε ηεο  

ηερλνινγίαο ζε ζρέζε κε ηελ παηδαγσγηθή. Έλα VLE κπνξεί λα πεξηιακβάλεη  ηα ζηνηρεία 

δηαθνξεηηθψλ γελεψλ.  
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Πίλαθαο 3.1: Σαμηλφκεζε e-learning θαηά Garrison 2004 

 

3.5 Σν E-Learning σο πεξηερόκελν. 

To e-learning είλαη ε παηδαγσγηθή πνπ εμνπζηνδνηείηαη απφ ηελ ηερλνινγία. Δίλαη έλαο ζπλδπαζκφο 

ηνπ αγγιηθνχ γξάκκαηνο e πνπ δειψλεη ην ειεθηξνληθφ (electronic) θαη ηεο κάζεζεο. Ζ ειεηξνληθή 

κάζεζε θαηεπζχλεηαη πάληα απφ ηελ παηδαγσγηθή. Ζ ηερλνινγία επηηξέπεη κεξηθέο θνξέο ηε ρξήζε  

λέσλ παηδαγσγηθψλ κεζφδσλ, αιιά αθφκα θη έηζη, ε παηδαγσγηθή πξνζέγγηζε νθείιεηαη λα 

θαζνξηζηεί κε ζαθήλεηα θαη έπεηηα λα δψζεη  θαηεχζπλζε ζηελ ηερλνινγία. Έηζη γηα λα έρνπκε e-

learning ζα πξέπεη πξψηα λα έρεη επηιερζεί ε θαηάιιειε παηδαγσγηθή κέζνδνο θαη κεηά λα 

ζπλδπαζηεί κε αμηφπηζηε θαη εχρξεζηε ηερλνινγία. Σν e-learning εμαξηάηαη άκεζα απφ ηελ 

παηδαγσγηθή : Δάλ ππάξρεη ειάρηζηνο ή θαλέλαο παηδαγσγηθφο ζρεδηαζκφο, ηα εξγαιεία ηνπ e-

learning ζα απνηχρνπλ, εάλ ε ηερλνινγία είλαη αλαμηφπηζηε ή πάξα πνιχ ζχλζεηε , ην e-learning  ζα 

είλαη κηα δπζάξεζηε εκπεηξία.  

Θα εμεηάζνπκε παξαθάησ δειψζεηο - θαλφλεο πνπ ηζρχνπλ θαη δηέπνπλ ην e-learning απφ ην 2003 

ζχκθσλα κε ην IEEE (Institute of Electrical and Electronics Engineers):  

Καλόλαο 1: Σν e-leaning  είλαη έλαο ηξφπνο  εθπαίδεπζεο πνπ κπνξεί λα εθαξκνζηεί κέζα απφ ηα 

πνηθίια πξφηππα εθπαίδεπζεο  (φπσο παλεπηζηήκηα , ζρνιέο εμ απνζηάζεσο εθπαίδεπζεο θ.α) θαη ηηο 

εθπαηδεπηηθέο – παηδαγσγηθέο  θηινζνθίεο  (παξαδείγκαηνο ράξηλ κπηρεβηνξηζκφο  θαη 

θνλζηξνπθηηβηζκφο). ΢χκθσλα κε ηα παξαπάλσ ην e-learning θαζηεξψλεηαη σο ην κέζν παξά σο έλαο 

ηξφπνο εθπαίδεπζεο. Σν ζίγνπξν είλαη φηη ην e-learning  δελ κπνξεί λα ζπγθξηζεί κε ηελ παξαδνζηαθή 

δηδαζθαιία. Σν e-learning  ρξεζηκνπνηεί ηερλνινγηθά εξγαιεία  πνπ κπνξνχλ λα εθαξκνζηνχλ κέζα 

απφ δηάθνξα πιαίζηα αιιά δελ είλαη έλα επδηάθξηην εθπαηδεπηηθφ ζχζηεκα . Μπνξνχλ λα  

εθαξκνζηνχλ  δηαθνξεηηθέο θηινζνθίεο εθπαίδεπζεο κε απνηέιεζκα νη ζπνπδαζηέο λα κπνξνχλ λα 

θαηαζθεπάζνπλ ηε γλψζε ηνπο  ρξεζηκνπνηψληαο  εξγαιεία ηερλνινγίαο. Αμηνζεκείσην είλαη φηη ηα 
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ίδηα εξγαιεία κπνξνχλ λα ρξεζηκνπνηεζνχλ γηα λα παξνπζηάζνπλ ηελ χιε θαη λα νδεγήζνπλ ηνπο 

ζπνπδαζηέο ζε πξνθαζνξηζκέλα ζπκπεξάζκαηα κε ηδηαίηεξα δνκεκέλνπο ηξφπνπο. Ο θαλφλαο απηφο 

εθαξκφδεηαη θαηά ηελ πξνζνκνίσζε θπζηθψλ πξνβιεκάησλ πνπ αθνινπζεί ζε παξαθάησ ελφηεηα.  Ο 

ζπνπδαζηήο κέζα απφ ηελ δεκηνπξγία θαηάιιεινπ θψδηθα ή ρξήζε έηνηκνπ θψδηθα κπνξεί λα 

αληηιακβάλεηαη θαη λα θαηαλνεί θαιχηεξα ηα θπζηθά θηαλφκελα θαη πξνβιήκαηα. Δληνχηνηο, ην e-

learning επηηξέπεη κηα κνξθή εθπαηδεπηηθήο ζχγθιηζεο θαη απηφ καο νδεγεί ζηνλ επφκελε θαλφλα: 

Καλόλαο 2: Σν e-learning επηηξέπεη ηνλ ζπλδπαζκφ ησλ ππαξρνπζψλ εθπαηδεπηηθψλ κνλάδσλ,  φπσο 

ζρνιείνπ θαη εμ απνζηάζεσο εθπαίδεπζεο.  Δλδερνκέλσο απηφ λα είλαη ε πην ζπλαξπαζηηθή πηπρή ηνπ 

e-learning: Ζ ρξήζε λέσλ κνξθψλ έθθξαζεο ζηελ εθπαίδεπζεο πνπ φκσο λα έρνπλ ηε δπλαηφηεηα λα 

ζπλδπάζνπλ ηηο «δπλάκεηο» άιισλ βαζκίδσλ θαη κνξθψλ εθπαίδεπζεο θαη ηεο εμ απνζηάζεσο 

εθπαίδεπζεο κε  δηάθνξνπο ηξφπνπο θαη κε ηε ρξεζηκνπνίεζε πνηθίισλ ηερλνινγηψλ, φπσο ηα bulletin 

boards πνπ επηηξέπνπλ ηελ απεπζείαο ζπδήηεζε, θαη ηα wikis, ηα νπνία πξνσζνχλ ην ζπλεξγάζηκν 

γξάςηκν. Οη Dillon θαη Greene (2003) πξνηείλνπλ φηη ε αηνκηθή εμ απνζηάζεσο εθπαίδεπζε κπνξεί 

λα γίλεη ζπλεξγαηηθή  εθπαίδεπζε παξφιν πνπ νη ζπνπδαζηέο είλαη θπζηθά ρσξηζκέλνη.  

Καλόλαο 3: Σν πσο ρξεζηκνπνηείηαη ε ηερλνινγία είλαη πην ζεκαληηθφ απφ ην πνηα  ηερλνινγία 

ρξεζηκνπνηείηαη. Δάλ ην e-learning ζεσξεζεί σο έλαο ηξφπνο εθπαίδεπζεο, ηφηε κπνξνχλ λα 

εθαξκνζηνχλ  πνηθίιεο παηδαγσγηθέο κεζφδνη. (Thorpe, 2002).  

Ο Weller (2002) απαξηζκεί ηηο αθφινπζεο παηδαγσγηθέο κεζφδνπο:  

 θνλζηξνπθηηβηζκφο ( constructivism) 

 βαζηζκέλε ζε πφξνπο εθκάζεζε ( resource-based learning) 

 ζπλεξγαηηθή κάζεζε ( collaborative learning) 

 βαζηζκέλε ζε πξνβιήκαηα κάζεζε ( problem-based learning) 

 αθεγεκαηηθή δηδαζθαιία ( narrative-based teaching) 

 ηνπνζεηεκέλε εθκάζεζε ( situated learning) 

 κπηρεβηνξηζκφο 

 

 Ζ ηερλνινγία είλαη παηδαγσγηθά νπδέηεξε επεηδή κπνξεί λα ππνζηεξίμεη νπνηαδήπνηε απφ ηηο 

παξαπάλσ κεζνδνινγίεο. Όπσο έρνπκε αλαθέξεη θαη πξνεγνπκέλσο εθφζνλ γίλνπλ νη θαηάιιεινη  

παηδαγσγηθνί ζρεδηαζκνί θαη ε πην απιή ηερλνινγία κπνξεί λα είλαη  πνιχ ρξήζηκε. 

Καλόλαο 4:  Δίλαη απηφ πνπ αλαθέξεηαη ζπλέρεηα. Πξφνδνο ππάξρεη κφλν κέζα απφ ηνλ επηηπρή 

ζρεδηαζκφ θαη εθαξκνγή ηεο παηδαγσγηθήο κεζφδνπ. Καηά γεληθφ θαλφλα απηφ πνπ επλνεί ηελ 

αλάπηπμε ηνπ e-learning είλαη νη θηλήζεηο πνπ γίλνληαη ζηελ πξαθηηθή εθαξκνγή ηεο  δηδαζθαιίαο 
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παξά ζηελ αλάπηπμε ηεο ηερλνινγία. Ζ ηερλνινγία απφ κεξηάο ηεο κπνξεί λα πξνζθέξεη λέεο 

επθαηξίεο ζην ηξφπν δηδαζθαιίαο. Όπσο ζεκεηψλεηαη απφ ηνλ Laurillard (2002) απηνί πνπ ρξεηάδεηαη 

λα νξγαλψζνπλ θαη λα αλαπηχμνπλ έλα e-learning είλαη νη εθπαηδεπηηθνί ζρεδηαζηέο θαη φρη νη 

ηερληθνί. Οη θαηλνηφκνη εθπαηδεπηηθνί ζα πξνζζέζνπλ αμία ζην e- learning θαη ζα εμαζθαιίζνπλ ηελ 

πεξαηηέξσ αλάπηπμή ηνπ.  

Καλόλαο 5: Σν e- learning εθαξκφδεηαη κε δχν ηξφπνπο:  

 παξνπζίαζε ηνπ πεξηερνκέλνπ εθπαίδεπζεο,  

 θαη δηεπθφιπλζε ησλ δηαδηθαζηψλ εθπαίδεπζεο.  

΢ήκεξα φιεο νη εθαξκνγέο ηνπ e- learning πεξηιακβάλνπλ ηελ δηαλνκή ςεθηαθψλ πιηθψλ (θείκελα, 

ηζηνρψξνη, θαη πνιπκέζα) σο ζηνηρεία παξνπζίαζεο, θαη ηε ρξεζηκνπνίεζε ησλ δηαπξνζσπηθψλ 

επηθνηλσληψλ θαη δξαζηεξηνηήησλ σο ζηνηρεία δηαδηθαζίαο.  

Καλόλαο 6: «Απηφ πνπ  ρηίδεηο, απηφ ζα έξζεη». Σα εξγαιεία πνπ ρξεζηκνπνηνχληαη ζην e-learning 

γίλνληαη φιν θαη θαιχηεξα γηα λα ιεηηνπξγήζνπλ κέζα ζε έλα πξνζεθηηθά επηιεγκέλν θαη βέιηηζηα 

ελζσκαησκέλν πξφηππν ζρεδίνπ ζεηξάο καζεκάησλ. Σν δεηνχκελν δελ είλαη απιά λα πξνζηεζνχλ 

εξγαιεία e- learning επάλσ ζε κηα ππάξρνπζα ζεηξά καζεκάησλ, ην  e- learning πξέπεη λα ζρεδηαζηεί 

θαη λα εθαξκνζηεί ζαλ λα πξφθεηηαη γηα «θπζηνινγηθή» παξάδνζε καζεκάησλ ζε ηάμε.  

Ζ αμηνιφγεζε, πνπ ζηηο κέξεο καο είλαη πνιχ επίθαηξε,  είλαη έλα ζεκαληηθφ ζπζηαηηθφ πνπ πξέπεη λα 

ελζσκαησζεί ζε φια ηα επίπεδα θαη κε φιεο ηηο κνξθέο ηεο. Ο Oliver (1999) αλαθέξεη φηη νη 

θαηάινγνη πεξηερνκέλνπ ηθαλνπνηνχλ ηηο καζεζηαθέο δξαζηεξηφηεηεο θαη ηελ ππνζηήξημε ησλ 

εθπαηδεπνκέλσλ γηα ηελ online δηδαζθαιία θαη κάζεζε. Τπάξρεη ε άπνςε φηη πέξα απφ ηελ 

ππάξρνπζα βηβιηνγξαθία  ν ζπλεξγαηηθφο δηάινγνο θαη ε επηθνηλσλία κε ηνπο εθπαηδεπηηθνχο είλαη νη 

ζεκαληηθφηεξνη παξάγνληεο γηα ηελ επηηπρή κάζεζε. 

Καλόλαο 7 : Σα εξγαιεία θαη νη ηερληθέο ηνπ e- learning πξηλ επηιερζνχλ γηα λα ρξεζηκνπνηεζνχλ ζα 

πξέπεη λα έρνπλ δνθηκαζηεί πξνεγνπκέλσο θαη online θαη offline. Απηφ γίλεηαη επεηδή ε ηαρχηεηα 

πξφζβαζεο ζην δηαδηθηχνπ πνηθίιεη αλάκεζα ζηηο γξήγνξεο  επξπδσληθέο ζπλδέζεηο θαη ηηο αξγέο 

ζπκβαηηθέο ζπλδέζεηο αιιά θαη επεηδή ε ζχλζεζε ηνπ θάζε ππνινγηζηή δηαθέξεη κε απνηέιεζκα 

θάπνηα εξγαιεία  ιφγσ αζπκβαηφηεηαο λα θέξνπλ θαηάξξεπζε ηνπ ζπζηήκαηνο. Έρνληαο απηνχο ηνπο 

πεξηνξηζκνχο ζην κπαιφ κπνξεί λα γίλεη θαη ρξήζε άιισλ κέζσλ φπσο CD-ROM ή DVD-ROM ψζηε 

λα πεξηνξηζηεί ε αλάγθε γηα Online ζχλδεζε, νπφηε ηα εξγαιεία ζα πξέπεη λα δνπιεχνπλ εμίζνπ θαιά 

θαη απνηειεζκαηηθά, θαη κε ηνπο φπνηνπο ζπκβηβαζκνχο ζηελ πνηφηεηα αλαπαξάζηαζεο (εηθφλα – 

ήρν) . Γεληθά, ην web ρξεζηκνπνηείηαη θαιχηεξα γηα επηθνηλσλία φπσο:  ελεκεξψζεηο, αλαλεψζεηο – 

αλαβαζκίζεηο ,  αζχγρξνλε ή  ζχγρξνλε ζπδήηεζε, θαη γηα ελεκέξσζε αιιαγήο πεξηερνκέλνπ, φπνπ 

απηφ αιιάδεη ζπρλά (wiki , blogs) ή δηαηίζεηαη κφλν θαηά ηε δηάξθεηα ηεο ζεηξάο ησλ καζεκάησλ.  
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Καλόλαο 8: Ζ απνηειεζκαηηθή εθαξκνγή ηνπ e-learning εμεηάδεη ηξφπνπο κε ηνπο νπνίνπο νη ηειηθνί 

ρξήζηεο ζα ζπκκεηάζρνπλ ζηελ δηαδηθαζία θαη πσο ζα αμηνπνηήζνπλ ηηο επθαηξίεο κάζεζεο πνπ ζα 

ηνπο πξνζθεξζνχλ. Ζ πξφγλσζε ηεο ζπκπεξηθνξάο ησλ ηειηθψλ ρξεζηψλ είλαη ζεκαληηθή γηα ηελ 

απνηειεζκαηηθή πινπνίεζε κηαο e-learning ζεηξάο καζεκάησλ. Σν παξαθάησ παξάδεηγκα καο 

θαλεξψλεη ην πφζν ζεκαληηθή είλαη ε πξφβιεςε : Αξθεηά ηδξχκαηα γηα ιφγνπο νηθνλνκίαο αιιά θαη 

ιφγνπο νηθνινγηθήο ζπλείδεζεο έρνπλ ζηακαηήζεη λα παξέρνπλ έληππα πιηθά-ζεκεηψζεηο 

πξνηηκψληαο  λα ηα αληηθαηαζηήζνπλ κε online ζεκεηψζεηο, θείκελα ή βηβιία ή CD-ROM’s.  Ζ ζθέςε 

είλαη ηδαληθή αιιά γηα λα δνχκε ηη πξφβιεςε κπνξνχκε λα θάλνπκε γηα ηνπο ηειηθνχο ρξήζηεο - 

ζπνπδαζηέο; Ζ πιεηνςεθία ησλ ζπνπδαζηψλ, πνπ δηαζέηνπλ Ζ/Τ,  δελ επηζπκνχλ λα δηαβάδνπλ απφ 

κηα νζφλε ή δελ κπνξνχλ λα πάξνπλ ηνλ ππνινγηζηή καδί ηνπο ζηηο δηαθνπέο ή  ηα ΢αββαηνθχξηαθα ή 

ηε λχρηα ζην θξεβάηη ηνπο, νπφηε ζα  αλαγθαζηνχλ λα ηππψζνπλ ηηο ςεθηαθέο ζεκεηψζεηο ηνπο. Άξα 

ηίζεηαη ην εξψηεκα εάλ πέηπρε ην εγρείξεκα ή φρη. Σν ίδξπκα κπνξεί λα πέηπρε ζην νηθνλνκηθφ κέξνο 

αιιά κεηαηφπηζε ην θφζηνο απηφ ζην ζπνπδαζηή αθνχ ζεκεηψζεηο εμαθνινπζνχλ λα ηππψλνληαη.  

Δπίζεο ζα πξέπεη λα εμεηαζηεί θαη ν ηξφπνο πξφζβαζεο ζην δηαδηθηχνπ πνπ έρνπλ νη πεξηζζφηεξνη 

ζπνπδαζηέο . Αλ ε ζχλδεζε είλαη αξγή ηφηε  δελ κπνξνχλ λα απνιαχζνπλ ηα πιήξε νθέιε ησλ 

πνιπκέζσλ ζε πξαγκαηηθφ ρξφλν (εδψ ε ηαρχηεηα είλαη ζε βάξνο ηεο πνηφηεηαο). 

 Ζ εμέηαζε ηεο εκπεηξίαο ησλ ζπνπδαζηψλ πάλσ ζηηο λέεο ηερλνινγίεο είλαη ηδηαίηεξα ζεκαληηθή  θαη 

αλ ιεθζεί ππφςε κπνξεί λα εμαζθαιίζεη κε αθξίβεηα ηελ απνηειεζκαηηθφηεηα ηνπ ζρεδίνπ κάζεζεο 

γηα ηελ παξάδνζε ηεο ζεηξάο καζεκάησλ, θαη δίλεη ζεκαληηθέο ελδείμεηο γηα ην πψο θαη πνπ ζα πξέπεη 

λα ππνζηεξηρζνχλ νη ζπνπδαζηέο ζηε δξαζηεξηφηεηα κάζεζεο. 

 

Καλόλαο 9: Ζ νπζηαζηηθή δηαδηθαζία ηεο εθπαίδεπζεο (δειαδή ε επηηπρία ησλ καζεζηαθψλ ζηφρσλ 

απφ πιεπξάο εθπαηδεπφκελνπ) δελ αιιάδεη φηαλ εθαξκφδεηαη ην e-learning. Με άιια ιφγηα, ην 

πξφγξακκα ζπνπδψλ είλαη αθφκα ν βαζηιηάο. Σα εξγαιεία ηνπ e-learning κπνξνχλ βεβαίσο λα 

ρξεζηκνπνηεζνχλ γηα λα ελζαξξχλνπλ ηνπο ζπνπδαζηέο  λα εξεπλήζνπλ πεξαηηέξσ ηα ζέκαηα πνπ 

έρνπλ δηδαρζεί κφλνη ηνπο αιιά απηφ ζα πξέπεη λα πξαγκαηνπνηεζεί κέζα ζην πιαίζην ελφο ηππηθά 

εγθεθξηκέλνπ πξνγξάκκαηνο ζπνπδψλ.  

Σν πξφγξακκα ζπνπδψλ είλαη ην ζεκείν αλαθνξάο γηα ηελ εθπαηδεπηηθή εκπεηξία. Οη online 

ζπδεηήζεηο  πξέπεη λα κεηξάλε ην πφζν θαιά έλαο ζπνπδαζηήο έρεη θαηαλνήζεη ην ζέκα ζχκθσλα κε 

ηνπο ζηφρνπο ηνπ καζήκαηνο. Δάλ ε ζπκκεηνρή ζε Online  ζπδεηήζεηο δελ είλαη ζρεηηθή κε ην 

πξφγξακκα ζπνπδψλ, ηφηε πξέπεη λα εμεηάδνπκε ηε ρξήζε ηεο απιά σο έλα εξγαιείν αμηνιφγεζεο.  

Σν πξφγξακκα ζπνπδψλ είλαη πξφηππν θαη φρη ε ρξήζε ηεο ηερλνινγίαο απφ ηνπο εθπαηδεπφκελνπο. 

Καλόλαο 10: Μφλν ηα παηδαγσγηθά πιενλεθηήκαηα κπνξνχλ λα δψζνπλ κηα κφληκε ινγηθή γηα ηελ 

εθαξκνγή ησλ πξνζεγγίζεσλ ηνπ e-learning. Οη ζεζκηθέο, θνηλσληθέο θαη πνιηηηθέο αιιαγέο δελ 

νδεγνχλ απηφκαηα ζηελ θαιχηεξε δηαδηθαζία κάζεζε ησλ ζπνπδαζηψλ. Οη Eisenstadt θαη Vincent 
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(2000: xi) δηαηήξεζαλ ηα πιενλεθηήκαηα ηεο ηερλνινγίαο γηα εθείλεο ηηο εθαξκνγέο πνπ ζηεξίδνληαη 

ζηελ πγηή παηδαγσγηθή: «Σηνηρεία ζπλερίδνπλ λα επηβεβαηώλνπλ όηη ην web, όπσο θαη άιιεο 

ηερλνινγίεο θαη κέζα, κπνξεί λα ρξεζηκνπνηεζεί επηηπρώο ππό ηνλ όξν όηη ε εθπαηδεπηηθή αλάγθε ζηελ 

νπνία εθαξκόδνληαη πξνζδηνξίδεηαη πξώηα».  

Οη  Chickering θαη Gamson (ζηνλ Keeton 2004) εμεηάδνπλ επηά αξρέο νξζήο εθαξκνγήο:  

1. Ζ νξζή εθαξκνγή ελζαξξχλεη ηελ ηθαλφηεηα επηθνηλσλίαο ηνπ ζπνπδαζηή.  

2. Ζ νξζή εθαξκνγή ελζαξξχλεη ηε ζπλεξγαζία κεηαμχ ησλ ζπνπδαζηψλ.  

3. Ζ νξζή εθαξκνγή ελζαξξχλεη ηελ ελεξγφ κάζεζε.  

4. Ζ νξζή εθαξκνγή δεκηνπξγεί αλαηξνθνδφηεζε.  

5. Ζ νξζή εθαξκνγή δίλεη έκθαζε ζην ρξφλν θαη ζην ζηφρν.  

6. Ζ νξζή εθαξκνγή νδεγεί ζε επηθνηλσλία κε πςειέο πξνζδνθίεο.  

7. Ζ νξζή εθαξκνγή ζέβεηαη ηε δηαθνξεηηθφηεηα θαη ηνλ ηξφπν - ξπζκφ κάζεζεο. 

 Ζ νξζή εθαξκνγή είλαη πάληα ε θαιή πξαθηηθή.  

Οη αξρέο Chickering θαη Gamson εθαξκφδνληαη ζην e-learning φπσο  αθξηβψο ηηο εθαξκφδνπλ ζηελ 

ηάμε θαη ζηελ εμ απνζηάζεσο εθπαίδεπζε. Οη Keeton, Sheckley, θαη Krejci-Griggs’s παξέρνπλ επίζεο 

ηηο παξαθάησ αξρέο κε θαηεχζπλζε ζηε παηδαγσγηθή (Keeton, 2004):  

 θάλεηε ηνπο ζηφρνπο κάζεζεο θαη ηελ πνξεία πξνο απηνχο ζαθείο.   

 ρξεζηκνπνηείζηε εθηελήο θαη ζθφπηκε πξαθηηθή. 

 παξέρεηε γξήγνξε θαη εθηελήο αλαηξνθνδφηεζε.  

 παξέρεηε ηζνξξνπεκέλε πξφθιεζεο θαη ππνζηήξημε  πνπ λα πξνζαξκφδεηαη ζηελ εηνηκφηεηα 

θαη ηε δπλαηφηεηα ηνπ θάζε ζπνπδαζηή.   

 αλαδείμηε ηε γλψζε πνπ πξνέξρεηαη απφ ηελ απμαλφκελε εκπεηξίαο ηνπο.   

 ζπλδέζηε ηηο έξεπλεο κε γλήζηα πξνβιήκαηα ή  δεηήκαηα πςεινχ ελδηαθέξνληνο γηα ηνπο 

εθπαηδεπφκελνπο  (πνπ κε απηφλ ηνλ ηξφπν εληζρχεηαη ην θίλεηξν θαη επηηαρχλεηαη ε κάζεζή 

ηνπο).   

 αλαπηχμηε ηελ απνηειεζκαηηθφηεηα ησλ εθπαηδεπνκέλσλ απφ ηελ αξρή ηεο εθπαίδεπζή ηνπο.   

 δεκηνπξγήζηε έλα ζεζκηθφ πεξηβάιινλ πνπ ππνζηεξίδεη θαη ελζαξξχλεη ηελ έξεπλα. 
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3.6 Οθέιε από ηε ρξήζε ηνπ e-learning 

Πέληε ζεκαληηθά νθέιε γηα ηελ εθπαίδεπζε  πνπ απνξξένπλ απφ ην e-learning ζχκθσλα κε ηνπο  

Oblinger θαη Hawkins (2005) είλαη:  

1. Ζ επθνιία θαη ε επειημία ηνπ e-learning λα παξέρεη εχθνιε πξφζβαζε ζηελ εθπαίδεπζε γηα φζνπο 

ην επηζπκνχλ. Απηή ε επειημία θαη ε επθνιία επεθηείλεηαη θαη ζην ζπνπδαζηή θαη ζηνλ εθπαηδεπηηθφ. 

Γελ ρξεηάδεηαη ε θπζηθή παξνπζία ηνπ αηφκνπ ζηελ αίζνπζα, κπνξεί λα ζπκβεί «παληνχ» θαη 

εληζρχεη ηελ δηα βίνπ εθπαίδεπζε. 



Μήηαιαο Αλδξέαο                                                                          Κεθάιαην 3: Τπεξεζίεο Γηαδηθηχνπ :E-learning  

Γηδαθηηθή κε ρξήζε λέσλ ηερλνινγηψλ : Σερλεηή Ννεκνζχλε, Web 2.0 : Blogs- wiki – webquest 25 

2. Σα κέζα πνπ ρξεζηκνπνηνχληαη ζην e-learning ζήκεξα παξέρνπλ κηα πην απνηειεζκαηηθή εκπεηξία 

κάζεζεο απφ ηηο παξαδνζηαθέο κνξθέο εθπαίδεπζεο.  

3. Σν e-learning ζήκεξα έρεη ηε δπλαηφηεηα λα θαηαζηήζεη ηελ εθπαίδεπζε απνδνηηθφηεξε ζε ζρέζε 

κε ηελ παξαδνζηαθή εθπαίδεπζε ρσξίο ην ζπκβηβαζκφ ηεο πνηφηεηαο. Απηφ ζα κπνξέζεη λα δψζεη 

ζηνπο αθαδεκατθνχο ηελ ειεπζεξία πνπ ζέινπλ γηα ηελ εξεπλεηηθή ηνπο δξαζηεξηφηεηα.  

4. Σν e-learning βειηηψλεη ηελ αληαγσληζηηθφηεηα. Σα παξαδνζηαθά εθπαηδεπηηθά ηδξχκαηα θάλνπλ 

φιν θαη πεξηζζφηεξε ρξήζε ηεο  εμ απνζηάζεσο εθπαίδεπζε. Απηφ νδεγεί ζε λέεο πεγέο εζφδσλ θαη 

βειηίσζε ησλ εξγαιείσλ κάζεζεο.  

5. Σν e-learning απεηθνλίδεη ηηο εμειίμεηο θαη ηελ θαηλνηνκία κέζα ζηελ επξχηεξε θνηλσλία. 

΢ήκεξα δνχκε πιένλ ην web 2.0 ην νπνίν δείρλεη κηα ηάζε κεηαηφπηζεο πξνο ηελ εκπνξηθή, 

επαγγεικαηηθή θαη θνηλσληθή δξαζηεξηφηεηα. Παξφια απηά είλαη αλαπφθεπθην φηη ε ηερλνινγία ζα 

ζπλερίζεη λα αιιάδεη ηελ εθπαηδεπηηθή πξαθηηθή.  

 

3.7 Σερλνινγίεο πνπ ζπλζέηνπλ έλα πεξηβάιινλ e-learning  

Οη βαζηθφηεξεο ηερλνινγίεο πνπ ζπλζέηνπλ έλα e-learning πεξηβάιινλ είλαη: 

i. Computer Based Training (CBT) 

Ζ ηερλνινγία απηή πεξηιακβάλεη εθείλεο ηηο ηερλνινγίεο πνπ εκπιέθνπλ ηε ρξήζε 

πνιπκεζηθψλ εθαξκνγψλ ζηελ εθπαίδεπζε. Σν κέζν πνπ ρξεζηκνπνηείηαη εδψ είλαη θπξίσο ην 

CD-ROM ή DVD-ROM ην νπνίν κπνξεί λα πεξηέρεη έλα κάζεκα  ή κηα ζεηξά καζεκάησλ θαη 

κπνξεί λα ηελ παξαθνινπζήζεη κέζα απφ ηνλ πξνζσπηθφ ηνπ ππνινγηζηή ή κέζα απφ CD ή 

DVD player. Τπάξρεη κηθξή αιιειεπίδξαζε θπξίσο κέζα απφ αζθήζεηο ή εξσηήζεηο, θαη δελ 

πξνζθέξεηαη εμσηεξηθή βνήζεηα.  

ii. Web Based Training (WBT) 

Απνηειεί ηελ κεηαθνξά  ηνπ CBT ζην δηαδίθηπν. Δηδηθά φηαλ παξνπζηάζηεθαλ ηερλνινγίεο 

πνπ επηηξέπνπλ ηελ ζπλερή ξνή πιεξνθνξηψλ , streaming , γηα ηηο «βαξηέο» πιεξνθνξίεο 

φπσο  ( ήρνο θαη βίληεν) πηνζεηήζεθε ην WBT σο ην λέν κέζν κάζεζεο. 

iii. Instructor Led Training (ILT) 

΢ηελ θαηεγνξία απηή έρνπκε ηελ δπλαηφηεηα επηθνηλσλίαο κεηαμχ εθπαηδεπφκελνπ θαη 

εθπαηδεπηή αιιά φρη φκσο ζε πξαγκαηηθφ ρξφλν. Οπζηαζηηθά έρνπκε ηελ ρξήζε CBT ή WBT 

θαη ηε δπλαηφηεηα επηθνηλσλίαο, κε ειεθηξνληθή αιιεινγξαθία ή κε ηελ ρξήζε πεξηνρήο 

ζπδεηήζεσλ (Discussion Board), κε ηνλ εθπαηδεπηή γηα ηελ ππνβνιή εξσηήζεσλ ή γηα 

θαζνδήγεζε. 

iv. Virtual Classroom (VC) 
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Οη εηθνληθέο αίζνπζεο είλαη ε ηειεπηαία εμέιημε  ηεο ηερλνινγίαο αθνχ πξνζθέξνπλ ηε 

δπλαηφηεηα γηα ηελ δηεμαγσγή κηαο νιφθιεξεο ζπλεδξίαο ζε πξαγκαηηθφ ρξφλν κε ηε 

δπλαηφηεηα ζηνπο εθπαηδεπνκέλνπο λα κπνξνχλ λα βξίζθνληαη  ζε πνιχ καθξηλή απφζηαζε 

απφ ηελ πξαγκαηηθή αίζνπζα δηδαζθαιίαο. Ο εθπαηδεπηήο παξαδίδεη θαλνληθά ην κάζεκα  

ρξεζηκνπνηψληαο εξγαιεία φπσο  (π.ρ. ειεθηξνληθφ πίλαθα γξαθήο, Powerpoint θ.α) θαη φιε 

ε πιεξνθνξία πνπ γελληέηαη κέζα ζηελ αίζνπζα κεηαθέξεηαη ζηνλ εθπαηδεπφκελν ζε 

πξαγκαηηθφ ρξφλν. ΢ηελ πξαγκαηηθφηεηα ε «αίζνπζα» είλαη έλα κηθξφ studio φπνπ κηα 

θάκεξα θαηαγξάθεη ηελ εθπαίδεπζε θαη έλα εηδηθφ ινγηζκηθφ MCU (Multipoint Control Unit)  

αλαιακβάλεη λα ζπλζέζεη φια ηα ζηνηρεία ηεο εθπαίδεπζεο (βίληεν, νζφλε εθπαηδεπηή,  

αζθήζεηο θ.α.) θαη λα ηα κνηξάδεη κέζα απφ ην Internet ή κέζα απφ απεπζείαο ζπλδέζεηο ζηνλ 

εθπαηδεπφκελν. ΢ηελ πεξίπησζε απηή βέβαηα απαηηείηαη κεγάιν bandwidth (εχξνο δψλεο) 

γηαηί ν φγθνο ησλ πιεξνθνξηψλ πνπ ξέεη απφ ηελ αίζνπζα πξνο ηνλ εθπαηδεπφκελν είλαη 

κεγάινο. Τπάξρεη ε δπλαηφηεηα επηθνηλσλίαο κεηαμχ ησλ ζπκκεηερφλησλ κέζσ ησλ chat 

rooms (αίζνπζα ζπδεηήζεσλ) . 

Σν e-learning πεξηγξάθεηαη θαη σο : on-line κάζεζε , εηθνληθή κάζεζε, δηαλεκεκέλε κάζεζε, 

δηθηπαθή θαη ηελ βαζηζκέλε ζην WEB κάζεζε.  

Ο φξνο e-learning πεξηιακβάλεη πνιχ πεξηζζφηεξα απφ ηα παξαπάλσ.  Απηνί νη δηαθνξεηηθνί ηχπνη ή 

κνξθέο ηεο e-learning δξαζηεξηφηεηαο αληηπξνζσπεχνληαη ζηνλ πίλαθα 3.1 (Romiszowski, 2004). 

 
Πίλαθαο 3.1: E-learning ηχπνη 

 Ζ εμαηνκηθεπκέλε online απηνεθπαίδεπζε αλαθέξεηαη ζε θαηαζηάζεηο φπνπ έλαο 

κεκνλσκέλνο εθπαηδεπφκελνο έρεη πξφζβαζε ζε πφξνπο κάζεζεο φπσο  βάζεηο δεδνκέλσλ ή 

ζεηξάο καζεκάησλ on-line κέζσ ελφο ηνπηθνχ δηθηχνπ ή ηνπ δηαδηθηχνπ. Έλα ραξαθηεξηζηηθφ 

παξάδεηγκα απηνχ είλαη έλαο εθπαηδεπφκελνο πνπ κειεηά κφλνο ή πνπ πξαγκαηνπνηεί θάπνηα 

έξεπλα ζην δηαδίθηπν ή έλα ηνπηθφ δίθηπν. 

 Ζ εμαηνκηθεπκέλε offline απηνεθπαίδεπζε αλαθέξεηαη ζε θαηαζηάζεηο φπνπ έλαο 

κεκνλσκέλνο εθπαηδεπφκελνο ρξεζηκνπνηεί πφξνπο κάζεζεο φπσο κηα βάζε δεδνκέλσλ ή έλα 

πξφγξακκα κάζεζεο βαζηζκέλν ζε Ζιεθηξνληθφ ππνινγηζηή ρσξίο λα είλαη ζπλδεδεκέλνο κε 

άιιν ζχζηεκα ή δίθηπν. Έλα παξάδεηγκα απηνχ είλαη έλαο εθπαηδεπφκελνο πνπ εξγάδεηαη 

κφλν απφ έλαλ ζθιεξφ δίζθν, ην CD ή έλα DVD. 
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 Οκαδηθή κάζεζε βαζηζκέλε ζηε ζύγρξνλε επηθνηλσλία, φπνπ νη νκάδεο εθπαηδεπφκελσλ 

εξγάδνληαη καδί ζε πξαγκαηηθφ  ρξφλνο κέζσ ελφο ηνπηθνχ δηθηχνπ ή ηνπ δηαδηθηχνπ. Μπνξεί 

λα πεξηιάβεη ηε βαζηζκέλε ζε θείκελν ζχζθεςε (chat), θαη ζηελ κνλφδξνκε ή ακθίδξνκε 

ζπλεδξίαζε κέζσ εηθφλαο ήρνπ. Σν παξάδεηγκα απηνχ πεξηιακβάλεη ηνπο εθπαηδεπφκελνπο 

λα κεηέρνπλ ζε κηα ζπλνκηιία  ή ηειεδηάζθεςε ζε πξαγκαηηθφ ρξφλν. 

 Οκαδηθή κάζεζε βαζηζκέλε ζηελ αζύγρξνλε επηθνηλσλία φπνπ νη νκάδεο εθπαηδεπφκελσλ 

εξγάδνληαη κέζσ ελφο ηνπηθνχ δίθηπν ή ηνπ δηαδηθηχνπ φπνπ φκσο  νη «αληαιιαγέο 

πιεξνθνξηψλ» κεηαμχ ησλ ζπκκεηερφλησλ εκθαλίδνληαη κε κηα ρξνληθή θαζπζηέξεζε (δει., 

φρη ζε πξαγκαηηθφ - ρξφλνο). Σν ραξαθηεξηζηηθφ παξάδεηγκα απηνχ ηνπ είδνπο 

δξαζηεξηφηεηαο πεξηιακβάλνπλ ηηο online ζπδεηήζεηο κέζσ ησλ ειεθηξνληθψλ θαηαιφγσλ 

αιιεινγξαθίαο. 

 

3.8 Φεθηαθά Αληηθείκελα 

Σν ελδηαθέξνλ γηα ηα ςεθηαθά αληηθείκελα κάζεζεο άξρηζε λα ππάξρεη κε ηελ αχμεζε ηνπ 

ελδηαθέξνληνο γηα e-learning. Ση είλαη φκσο ηα ςεθηαθά αληηθείκελα; Έλα «ςεθηαθφ αληηθείκελν 

κάζεζεο» είλαη νπνηνζδήπνηε ειεθηξνληθφο πφξνο πνπ έρεη ηε δπλαηφηεηα λα πξνσζήζεη ηελ 

κάζεζε. Σα ςεθηαθά αληηθείκελα κάζεζεο είλαη φπσο ηα βηβιία, ηα άξζξα ζε πεξηνδηθά θαη άιισλ 

ηχπσλ πφξσλ κάζεζεο θαη δηδαζθαιίαο ηα νπνία ζα κπνξνχζαλ λα βξεζνχλ ζε ξάθηα βηβιηνζεθψλ 

θαη  βηβιηνπσιείσλ κε ηε κφλε δηαθνξά φηη απηά απνζεθεχνληαη κφλν κε ειεθηξνληθή κνξθή, σο εθ 

ηνχηνπ είλαη αλαπφζπαζηα απφ ην e-learning. (Wikipedia, 2008) Σα ςεθηαθά αληηθείκελα κάζεζεο 

κπνξνχλ λα πεξηιάβνπλ νηηδήπνηε μεθηλψληαο απφ απιά ζρέδηα κάζεζεο θαη θηάλνληαο ζε νιφθιεξεο 

ζεηξέο καζεκάησλ κε ρξήζε πνιπκέζσλ. Όπσο ηα βηβιία θαη ηα άξζξα ζε πεξηνδηθά, έηζη θαη ηα 

ςεθηαθά αληηθείκελα κάζεζεο είλαη θαηαρσξεκέλα θαη απνζεθεπκέλα ζηηο απνζήθεο αληηθεηκέλσλ 

κάζεζεο ψζηε λα κπνξνχλ λα αλαδεηεζνχλ, λα αλαγλσξηζηνχλ εχθνια, θαη λα επαλα-

ρξεζηκνπνηεζνχλ. Δλψ ηα πξφηππα θαη νη ζπκβάζεηο γηα ηελ θαηαρψξεζε ησλ βηβιίσλ θαη ησλ 

πεξηνδηθψλ είλαη επξέσο γλσζηά θαη πηνζεηεκέλα, ηα πξφηππα γηα ηελ θαηαρψξεζε ησλ ςεθηαθψλ 

αληηθεηκέλσλ κάζεζεο είλαη αθφκα ζηα πξψηα ζηάδηα ηεο αλάπηπμήο ηνπο. 

Σα ςεθηαθά αληηθείκελα πεξηιακβάλνπλ ρεηξφγξαθα, εηθφλεο, θαη ελφηεηεο πνιπκέζσλ θ.ιπ. ζε 

ςεθηαθή κνξθή. Αλαπηχζζνληαη ζπρλά σο ηδηαίηεξεο νληφηεηεο έηζη ψζηε κπνξνχλ λα 

επαλαρξεζηκνπνηεζνχλ απφ πνιιαπινχο ρξήζηεο ζε κηα ζεηξά εθπαηδεπηηθψλ ηνπνζεηήζεσλ. 

Παξάδεηγκα ελφο αληηθεηκέλνπ είλαη έλα απηνθίλεην, ην νπνίν γηα παξάδεηγκα, έρεη έλα φλνκα - 

κάξθα, έρεη πηλαθίδεο, ζα είλαη θάπνην κνληέιν ή ζεηξά, έρεη ηππνδχλακεο θαη απφδνζεο κεραλήο, 

ρξψκα , ξφδεο θιπ. Με ηνλ ίδην ηξφπν, έλα αληηθείκελν κάζεζεο κπνξεί λα έρεη «ηα ίδηα πξάγκαηα» 

ψζηε λα κπνξνχλ εχθνια θαη αθξηβψο λα πξνζδηνξηζηνχλ γηα ηελ επαλαρξεζηκνπνίεζε ηνπο απφ  

πνιιαπινχο ρξήζηεο θαη πνιιαπιέο εθπαηδεπηηθέο εθαξκνγέο.  
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Έλα παξάδεηγκα ςεθηαθνχ αληηθεηκέλνπ πνπ ρξεζηκνπνηείηαη ζηελπαξνχζα δηπισκαηηθή είλαη ε 

ζθαίξα – δεκηνπξγία ηνπ κνξίνπ, βξίζθεηαη ζηνλ θψδηθα πνπ αθνινπζεί ζε επφκελν θεθάιαην γηα ηελ 

πξνζνκνίσζε ηεο θίλεζεο ησλ κνξίσλ. Έρεη δηάζηαζε θαη ρξψκα θαη κπνξεί λα επαλαρξεζηκνπνηεζεί 

ν θψδηθαο γηα δεκηνπξγία κπάιαο, ηξνρνχ ή άιινπ ζθαηξηθνχ αληηθεηκέλνπ.  

 

 



Μήηαιαο Αλδξέαο                                                                                       Κεθαιαίν 4: Blogs –Wikis - Webquest 

Γηδαθηηθή κε ρξήζε λέσλ ηερλνινγηψλ : Σερλεηή Ννεκνζχλε, Web 2.0 : Blogs- wiki – webquest 29 

4 2
ε
 ΓENIA WEB (Blogs – Wiki – Webqust)  

4.1 Δηζαγσγή 

Σα πξψηεο γεληάο εξγαιεία, αζύγρξνλε επηθνηλσλία, ζπλερίδνπλ κέρξη θαη ζήκεξα λα παίδνπλ 

ζεκαληηθφ ξφιν ζην δηαδίθηπν. Σν ειεθηξνληθφ ηαρπδξνκείν ζπλερίδεη λα είλαη έλα βηψζηκν εξγαιείν 

γηα ηηο δηαδνρηθέο αληαιιαγέο πιεξνθνξηψλ κάζεζεο. Δηδηθά ηψξα πνπ ηα πεξηζζφηεξα πξνγξάκκαηα 

ειεθηξνληθνχ ηαρπδξνκείνπ ππνζηεξίδνπλ ην ζρεκαηνπνηεκέλν θείκελν θαη ηε γξαθηθή παξάζηαζε, 

ην ειεθηξνληθφ ηαρπδξνκείν είλαη ειθπζηηθφηεξν θαη εππξνζάξκνζην απ' φηη ζηηο εκέξεο ηνπ θησρνχ 

πιελ αμηφπηζηνπ ASCII. Δληνχηνηο, πνιινί εθπαηδεπηηθνί έρνπλ επηιέμεη ηα θφξνπκ ζπδήηεζεο σο ην 

θχξην εξγαιείν γηα ηηο γξαπηέο αληαιιαγέο πιεξνθνξηψλ κεηαμχ ησλ κειψλ θαηεγνξίαο ή θνηλφηεηαο. 

Έλαληη ηνπ ειεθηξνληθνχ ηαρπδξνκείνπ, ηα θφξνπκ ζπδήηεζεο δηεπθνιχλνπλ ηηο αληαιιαγέο 

πιεξνθνξηψλ κέζα ζηελ νκάδα, θαη δηαηεξνχλ απηφκαηα έλα αξρείν φισλ ησλ κελπκάησλ κε κηα  

ηεξαξρηθή δνκή. Αλ θαη ππάξρνπλ απνθιεηζηηθά ινγηζκηθά γηα ηε δεκηνπξγία θφξνπκ ζπδήηεζεο, 

φπσο WWWBoard, πνιινί εθπαηδεπηηθνί έρνπλ πξφζβαζε ζε έλα ζχζηεκα δηαρείξηζεο κάζεζεο 

(LMS) κε ελζσκαησκέλε δπλαηφηεηα δεκηνπξγίαο θφξνπκ φπσο WebCT , Moodle ή Blackboard.  

4.2 Blogs 

Σν ζπλεξγαηηθφ πεξηβάιινλ πνπ έρεη πξνθαιέζεη ην εληνλφηεξν ελδηαθέξνλ ηα ηειεπηαία ρξφληα είλαη 

ηα blogs. Δάλ ζθεθηεί θαλείο ηα blogs κφλν σο online  πεξηνδηθά, κπνξεί λα κελ ηνπ είλαη εκθαλέο 

πψο ζα κπνξνχζαλ λα ρξεζηκνπνηεζνχλ κε ζπλεξγαηηθφ ηξφπν. Αιιά αλ πξαγκαηηθά εμεηάζεη θαλείο 

κεξηθά blogs (φπσο InstaPundit ή Scripting News) θαηαδεηθλχεηαη πφζν δηαινγηθά κπνξνχλ λα είλαη. 

Οη ζπγγξαθείο θάλνπλ πινχζηα ρξήζε ηνπ ππεξθεηκέλνπ γηα λα ζπλδέζνπλ απηά πνπ νη άιινη έρνπλ 

γξάςεη πάλσ ζε έλα ζέκα. Οη θαηαρσξήζεηο ζηα blogs γίλεηαη κε ηε ρξήζε ελφο θνπκπηνχ, «εηζαγσγή 

ζρφιηνπ», θαη παξαθηλεί ηνπο αλαγλψζηεο λα γξάςνπλ  έλα ζρφιην, ην νπνίν θαηαγξάθεηαη, θαη έπεηηα  

ζπλδέεηαη, καδί κε ηα ππφινηπα ζρφιηα, ζην αξρηθφ θείκελν. Δλψ ηα πεξηζζφηεξα blogs 

δεκηνπξγνχληαη θαη δηαρεηξίδνληαη απφ κεκνλσκέλα άηνκα, ε δεκηνπξγία νκάδαο εξγαζίαο θαη 

δηαρείξηζεο blog είλαη επίζεο δπλαηή. Σα Blogs κπνξνχλ εχθνια λα ζπλδεζνχλ θαη λα  δηαζπλδεζνχλ 

ψζηε λα δεκηνπξγεζνχλ κεγαιχηεξεο θνηλφηεηεο.  

4.2.1 Ση είλαη Blog 

Ο Paquet (2003) αλαθέξεηαη ζηνλ φξν blog σο έλα αξρείν θαηαγξαθήο ζην δηαδίθηπν. ΢ηελ πην απιή 

ηνπ κνξθή είλαη έλαο ηζηνρψξνο κε δεκνζηεπκέλεο θαηαρσξήζεηο πνπ είλαη ρξνλνινγεκέλεο θαη 

κάιηζηα κε αληίζηξνθε ζεηξά (ε πην πξφζθαηε θαηαρψξεζε εκθαλίδεηαη σο πξψηε ζηε ζεηξά). Ο 

ηξφπνο εκθάληζεο νπζηαζηηθά επηιέγεηαη απφ ηηο ηερληθέο ξπζκίζεηο πνπ δίλεη ην θάζε blog. Οη 

άλζξσπνη πνπ δηαηεξνχλ έλα blog θαινχληαη bloggers. Ζ ξαγδαία αχμεζε ησλ blogs νθείιεηαη 

πηζαλφηαηα ζηελ απιφηεηα ηεο δεκηνπξγίαο θαη ηεο δηαηήξεζεο ελφο blog αθνχ δελ ρξεηάδνληαη 

εηδηθέο γλψζεηο. 

Ο Paquet (2003) απαξηζκεί πέληε ραξαθηεξηζηηθά γλσξίζκαηα πνπ έρεη έλαο αληηπξνζσπεπηηθφ blog :  
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 Ζ χπαξμε πξνζσπηθνχ εξγαιείνπ επεμεξγαζίαο θεηκέλνπ, γηα ζχληαμε θαη επεμεξγαζία 

ζρνιίσλ, 

 ε δνκή ησλ αλαξηεκέλσλ θεηκέλσλ (post) ,  ην πψο ζα εκθαλίδνληαη απηά θαη κε πνηα ζεηξά, 

 ζπρλέο ελεκεξψζεηο, πξνζζήθε λέσλ εξγαιείσλ ή επηινγψλ,  

 ειεχζεξε δεκφζηα πξφζβαζε ζην πεξηερφκελν κέζσ ηνπ Γηαδηθηχνπ θαη  

 αξρεηνζέηεζε ησλ θεηκέλσλ γηα ηελ δηεπθφιπλζε ζηελ αλαδήηεζε παιαηφηεξσλ 

θαηαρσξίζεσλ.  

4.2.2 Υαξαθηεξηζηηθά ζηνηρεία ελόο Blog 

Έλα weblog ή blog κπνξεί λα πεξηγξαθεί σο έλα online πεξηνδηθφ κε έλαλ ή πνιινχο ζπγγξαθείο. 

Δθηφο απφ ην θείκελν θαη ηνπο ζπλδέζκνπο ππεξθεηκέλνπ, πνιιά blogs ελζσκαηψλνπλ θαη άιιεο 

κνξθέο κέζσλ, φπσο εηθφλεο θαη βίληεν. Έλα blog απνηειείηαη ζπλήζσο απφ ηα αθφινπζα ζπζηαηηθά:  

 Post Date - Ζ εκεξνκελία θαη ρξφλνο πνπ ε ζέζε (post) δεκνζηεχζεθε  

 Ζ θαηεγνξία - θαηεγνξία φπνπ ε ζέζε (post) ηνπνζεηήζεθε  

 Σίηινο - θχξηνο ηίηινο ηεο ζέζεο (post) 

 ΢ώκα - πεξηερφκελν ηεο ζέζεο πνπ έγγξαςε ν ζπγγξαθέαο  

 Trackback - ζπλδέζεηο πίζσ απφ άιιεο πεξηνρέο  

 ΢ρόιηα - ζρφιηα πνπ πξνζηίζεληαη απφ ηνπο αλαγλψζηεο  

 Permalink - ην URL ηνπ πιήξνπο άξζξνπ  

 Τπνζεκείσζε - ζπλήζσο βξίζθεηαη ζην θαηψηαην ζεκείν ηεο ζέζεο θαη ζπρλά  παξνπζηάδεη 

ηελ εκεξνκελία θαη ην ρξφλν πνπ αλαξηήζεθε , ην ζπληάθηε,  ηε θαηεγνξία, θαη ζηαηηζηηθά 

φπσο ν αξηζκφο ησλ αηφκσλ πνπ δηάβαζαλ ην ζρφιην ή ηε ζέζε θιπ..  

Σα Blogs δηαθέξνπλ απφ ηνπο παξαδνζηαθνχο ηζηνρψξνπο θαη παξέρνπλ πνιιά πιενλεθηήκαηα πέξα 

απφ ηηο παξαδνζηαθέο πεξηνρέο, πνπ πεξηιακβάλνπλ:  

 Δχθνιε δεκηνπξγία λέσλ ζειίδσλ,  

 Φηιηξάξηζκα ηνπ πεξηερνκέλνπ,  

 Οη πεξηζζφηεξεο πιαηθφξκεο blog επηηξέπνπλ ζε ηδηνθηήηεο  blog  λα πξνζθαιέζνπλ θαη λα 

πξνζζέζνπλ άιινπο ζπληάθηεο, ησλ νπνίσλ νη άδεηεο θαη ε πξφζβαζε ξπζκίδνληαη εχθνια. 

 Γπλαηφηεηα δηαζχλδεζεο κε άιιεο θνηλφηεηεο κάζεζεο. 

 Έλα ςεθηαθφ ραξηνθπιάθην αλαζέζεσλ εξγαζηψλ θαη αζθήζεσλ ησλ ζπνπδαζηψλ.  
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4.2.3 Δθπαηδεπηηθά πιενλεθηήκαηα ησλ blogs  

Σα πηζαλά νθέιε φπσο πξνζδηνξίδνληαη απφ ηνπο Fernette θαη Brock Eide θαη αλαθέξνληαη απφ ηνλ 

Richardson (2006) ζηα Blogs, wikis, podcasts ,είλαη φηη:  

• Μπνξνχλ λα πξνσζήζνπλ ηελ θξηηηθή θαη αλαιπηηθή ζθέςε.  

• Μπνξνχλ λα πξνσζήζνπλ ηε δεκηνπξγηθή θαη δηαηζζεηηθή ζθέςε  

• Μπνξνχλ λα πξνσζήζνπλ ηελ αλαινγηθή ζθέςε.  

• Γίλνπλ ηελ δπλαηφηεηα γηα πξφζβαζε θαη έθζεζε ζε πνηνηηθέο πιεξνθνξίεο.  

• Πξνζθέξνπλ έλαλ ζπλδπαζκφ κεκνλσκέλεο θαη θνηλσληθήο αιιειεπίδξαζεο.  

Μέζα απφ ηε δνκή ελφο blog, νη καζεηέο κπνξνχλ λα επηδείμνπλ ηελ θξηηηθή ζθέςε, λα πάξνπλ 

δεκηνπξγηθά ξίζθα, θαη λα θάλνπλ πεξίπινθε ρξήζε ησλ ζηνηρείσλ ηεο γιψζζαο θαη ηνπ ζρεδίνπ. Με 

απηφ ηνλ ηξφπν, νη καζεηέο απνθηνχλ δεκηνπξγηθέο, θξηηηθέο, επηθνηλσληαθέο, θαη ζπλεξγαηηθέο 

δεμηφηεηεο.  

 

4.2.4 Σα 5 ζηάδηα ηεο δηαδηθαζίαο ησλ Blogs  

 

Δηθφλα 4.1: Σα 5 ζηάδηα αλάπηπμεο ελφο Blog 

H Bartlett-Bragg Α (2003) κειεηψληαο ηα εθπαηδεπηηθά blogs απφ ην ζηάδην ηεο πξνεηνηκαζίαο έσο 

ηελ πινπνίεζε θαηέιεμαλ φηη ε φιε δηαδηθαζία πξέπεη λα πεξλάεη κέζα απφ ηα πέληε παξαθάησ 

ζηάδηα: 
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΢ηάδην 1 – Δγθαηάζηαζε: Οη εθπαηδεπφκελνη δεκηνπξγνχλ έλα blog θαη αξρίδνπλ λα αλαθαινχλ θαη 

λα θαηαγξάθνπλ γεγνλφηα πξνο κάζεζεο δίλνληαο πξνζνρή ζηε έθθξαζε ησλ ζπλαηζζεκάησλ ηνπο. 

Γηα λα ελζαξξχλνπλ ηε ζπκκεηνρή κέζσ ησλ κηθξψλ θαη απζφξκεησλ θξάζεσλ, πνιιέο θνξέο 

παξέρνληαη δνκεκέλεο εξσηήζεηο, σο νδεγφο, γηα λα δψζνπλ ηξνθή γηα δηάινγν. Οη ηνπνζεηήζεηο 

είλαη βαζηζκέλεο ζηελ αλάκλεζε κεηά απφ έλα γεγνλφο. Δπίζεο κε ηηο εξσηήζεηο δίλεηαη βνήζεηα – 

θαζνδήγεζε ζηνπο εθπαηδεπφκελνπο λα εμνηθεησζνχλ θαη κε ηελ ηερλνινγία αιιά θαη ηε δηαδηθαζία. 

Οη θαηαρσξήζεηο ζηα εθπαηδεπηηθά blogs ζα πξέπεη λα δηαβαζηνχλ απφ ηνπο εθπαηδεπηέο θαη λα 

ζρνιηάζνπλ ηα πεξηερφκελα.  

΢ηάδην 2 – Δλδνζθόπεζε. Οη εθπαηδεπφκελνη ελζαξξχλνληαη γηα λα ζπλερίζνπλ λα θαηαγξάθνπλ 

γεγνλφηα πξνο κάζεζεο, ελψ καζαίλνπλ λα δίλνπλ πξνζνρή ζηα ζπλαηζζήκαηά ηνπο θαη λα 

αμηνινγνχλ ηελ εκπεηξία ηνπο. Γεθαπέληε ιεπηά κεηά ηελ  έλαξμε ηνπ καζήκαηνο δηαηίζεληαη κέζα 

ζηελ ηάμε γηα λα ζπδεηεζνχλ ην είδνο ησλ εξσηήζεσλ θαη ν ηξφπνο πνπ ζα δεισζνχλ. Σν κεγαιχηεξν 

κέξνο ηνπ γξαςίκαηνο είλαη ζπλνπηηθά ζρφιηα βαζηζκέλα ζηελ ππνβνιή έθζεζεο ησλ γεγνλφησλ, αλ 

θαη κεξηθνί ζπγγξαθείο κπνξνχλ λα είλαη έληνλνη θαη λα εθθξάζνπλ ηηο αξλεηηθέο ζπγθηλήζεηο ηνπο.  

΢ηάδην 3 - Αληαλαθιαζηηθνί Μνλόινγνη. Οη εθπαηδεπφκελνη αξρίδνπλ λα απαληνχλ ζηηο δνκεκέλεο 

εξσηήζεηο γηα ηελ εμέηαζε κηαο εκπεηξίαο έσο ηελ εμαγσγή κηαο έλλνηαο γηα πεξαηηέξσ αμηνιφγεζε. 

΢ην ζηάδην απηφ γίλεηαη ε αξρή ψζηε νη εθπαηδεπφκελνη λα αξρίδνπλ λα παίξλνπλ πεξηζζφηεξε επζχλε 

ζρεηηθά κε ηηο θαηαρσξήζεηο ηνπο. Δλζαξξχλνληαη επίζεο λα «πξνγξακκαηίζνπλ» ηε κειινληηθή ηνπο 

κάζεζε ε φπνηα ζα πξέπεη λα είλαη  βαζηζκέλε ζε πξνεγνχκελέο ηνπο εκπεηξίεο. Έηζη μεθηλνχλ λα 

θάλνπλ ζπρλφηεξεο θαηαρσξήζεηο ζην blog ηνπο θαη κε ην ζπρλφηεξν γξάςηκν παξαηεξείηαη πην 

έληνλα ε αιιαγή ζηελ έθθξαζε ζπλαηζζεκάησλ.  

΢ηάδην 4 - Αληαλαθιαζηηθόο δηάινγνο. Ζ πεξαηηέξσ ελζάξξπλζε πξνο κηα βαζχηεξε 

αληαλαθιαζηηθή δηαδηθαζία απαηηεί νη εθπαηδεπφκελνη λα εμεηάζνπλ ην χθνο ηεο έθθξαζήο ηνπο 

αλάινγα κε ην πξννξηδφκελν αθξναηήξην ψζηε λα δεκνζηεχζνπλ θαηάιιεια ηηο ζθέςεηο ηνπο. Πιένλ 

δελ δηαηίζεηαη ρξφλνο ζηε ηάμε αιιά θάζε νκάδα ζπδεηά ηα ζέκαηα θαη ηα δεηήκαηα πνπ ζα 

κπνξνχζαλ λα ελζσκαησζνχλ ζηα blogs ηνπο.  

΢ηάδην 5 – «Υεηξνπνίεηα» Αληηθείκελα Γλώζεο. Οη εθπαηδεπφκελνη θηλνχληαη κέζα απφ ηε  

πξνζσπηθή ηνπο γλψζεο  πξνο ηελ γλψζε πνπ καζαίλεηαη. Με  ηελ παξνρή  νδεγηψλ πξνο ηνπο 

αλαγλψζηεο, κπνξνχλ λα ρξεζηκνπνηήζνπλ απηή ηε γλψζε γηα λα εληζρχζνπλ ηελ εκπεηξία ηνπο θαη 

ηελ κάζεζε, σο «ρεηξνπνίεηα» αληηθείκελα γλψζεο. ΢ε απηή ηε θάζε νη εθπαηδεπφκελνη κπνξνχλ λα 

αξρίζνπλ λα δηαβάδνπλ ηα blogs άιισλ  θαη λα θάλνπλ ζρφιηα.  

4.2.5 Παξαδείγκαηα εθπαηδεπηηθήο εθαξκνγήο ησλ blogs 

 
Μεξηθέο ελδεηθηηθέο πεγέο απφ ηελ εθπαηδεπηηθή ρξήζε ησλ blogs: 

 http://www.quiltingweekly.blogspot.com/ 
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 http://www.information-literacy.net/ 

 http://www.theshiftedlibrarian.com/ 

 http://1laptop1student.blogspot.com/ 

 http://supportblogging.com/Links+to+School+Bloggers 

 http://mpbreflections.blogspot.com/ 

 http://ateacherswrites.wordpress.com/ 

 http://www.classroomblogging.com/ 

 http://oedb.org/library/features/top-100-education-blogs 

 http://nlpers.blogspot.com/ 

 http://www.200words-a-day.com/language-learning-blog-1.html 

 http://languageblog.net/ 

 

4.3 Wikis 

4.3.1 Δηζαγσγή 

Έλα wiki είλαη κηα νκάδα απφ ηζηνζειίδεο πνπ επηηξέπεη ζηνπο ρξήζηεο λα παξαζέηνπλ ζρφιηα,  κε 

παξφκνην ηξφπν φπσο ζε έλα θφξνπκ ζπδήηεζεο ή blog. Όκσο απηφ πνπ πξνζθέξεη παξαπάλσ είλαη 

ην φηη  επηηξέπεη ηελ κεηαβνιή ησλ πεξηερφκελσλ , θαη κάιηζηα κεξηθέο θνξέο εληειψο απζαίξεηα. 

(Arreguin, 2004). Ο φξνο Wiki έρεη πηνζεηείηαη απφ ηε Υαβαλέδηθε γιψζζα  φπνπ  ην wiki ζεκαίλεη 

`γξήγνξα'. Σα wikis δελ παξνπζηάδνληαη εμ νξηζκνχ κε αληηζηξφθσο ρξνλνινγηθή ηαμηλφκεζε  ή 

νπνηαδήπνηε άιιε πξνθαζνξηζκέλε ζεηξά. 

΢χκθσλα κε ηνπο Leuf θαη Cunningham (2001), νη δεκηνπξγνί ηεο αξρηθήο έλλνηαο wiki, «έλα wiki 

είλαη κηα ειεχζεξα επεθηάζηκε ζπιινγή ζπλδεκέλσλ ηζηνζειίδσλ, έλα ζχζηεκα ππεξθεηκέλσλ γηα 

απνζήθεπζε πιεξνθνξηψλ - κηα βάζε δεδνκέλσλ, φπνπ θάζε ζειίδα αιιάδεη εχθνια απφ 

νπνηνλδήπνηε ρξήζηε κε ηε ρξήζε ελφο Web browser (θπιινκεηεηήο)». Σν πεξηερφκελν κπνξεί λα 

ζπλδεζεί άκεζα κε απηφ πνπ βξίζθεηαη ζε άιια wikis (interwiki) θαη ζε έγγξαθα Ηζηνχ (δηαδηθηχνπ). 

Σν «Browser-based access» δειψλεη φηη ππάξρεη άκεζε πξφζβαζε κέζα απφ έλαλ θπιινκεηξεηή 

ρσξίο πξφζζεην ινγηζκηθφ θαη ρσξίο ηελ παξνπζία ηξίηνπ πξνζψπνπ π.ρ. ελφο webmaster πνπ ζα 

«αλεβάζεη» ή ζα ελεκεξψζεη ην πεξηερφκελν. Σν πεξηερφκελν ελεκεξψλεηαη ακέζσο, εμαιείθνληαο 

θηλδχλνπο κε ηε δηαλνκή θεηκέλσλ γηα κεηάδνζεο ηψλ.  

Τπάξρεη κεραληζκφο – εξγαιείν πνπ δίλεη ηε δπλαηφηεηα ζηνπο ρξήζηεο λα εηδνπνηεζνχλ γηα ηελ 

χπαξμε λένπ πεξηερφκελνπ ή απάληεζεο απηφκαηα. 

Ο Mattison (2003) δειψλεη φηη «έλα wiki κπνξεί λα είλαη έλα blog, αιιά έλα blog δελ είλαη 

απαξαίηεην λα είλαη έλα wiki.» Μάιηζηα ζρνιηάδεη ηνλ ηξφπν ζπγγξαθήο ησλ wikis, επεηδή απηά 

πηνζεηνχλ κηα απινπζηεπκέλε κνξθνπνίεζε ζήκαλζεο (αλ θαη ππάξρνπλ WYSIWYG – What You 
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See Is What You Get - wikis). Σελ απινπζηεπκέλε κνξθνπνίεζε ζήκαλζεο ηελ ζεσξεί σο έλα 

κεηνλέθηεκα θαη απηφ γηαηί δεκηνπξγεί έιιεηςε ηππνπνίεζεο ζηα δηάθνξα πξνγξάκκαηα ησλ wikis.  

4.3.2 Βαζηθά ραξαθηεξηζηηθά ησλ κεραλώλ Wiki  

Όια ηα wikis κπνξνχλ λα πηνζεηήζνπλ φια ηα ραξαθηεξηζηηθά γλσξίζκαηα πνπ βξίζθνληαη ζε άιια 

wikis, απιά κε ηελ πξφζβαζε θαη ηελ πξνζαξκνγή ηνπ πεγαίνπ θψδηθα. Δμεηάζηεθαλ δηάθνξα 

πξνγξάκκαηα θαηαζθεπήο wikis.  Οη θαηεγνξίεο ραξαθηεξηζηηθψλ γλσξηζκάησλ πεξηειάκβαλαλ: 

πεγαίν θψδηθα, δηαρείξηζε wiki, κνξθνπνίεζε ζειίδσλ, έιεγρνο πξνζπέιαζεο, επηθνηλσλίεο, 

ππνζηήξημε, θαη πξνεγκέλα ραξαθηεξηζηηθά γλσξίζκαηα. Δίλαη εχθνιν λα παξαηεξήζεη θάπνηνο φηη 

δελ ππάξρνπλ ζεκαληηθέο δηαθνξέο κεηαμχ ηνπο. Παξά ηνπ φηη έρνπλ γξαθεί ζε δηαθνξεηηθέο γιψζζεο 

πξνγξακκαηηζκνχ πρ  php , asp , Mysql ,  Microsoft SQL, ηα πεξηζζφηεξα wikis ρξεζηκνπνίεζαλ ηηο 

ίδηεο βαζηθέο ιεηηνπξγίεο κνξθνπνίεζεο ζειίδσλ (δει. έθδνζε θεηκέλσλ θαη εηζαγσγή εηθφλαο, 

πηλάθσλ, θαηαιφγσλ, ζπλδέζκσλ ππεξθεηκέλνπ θαη αξρείσλ).  

Σα εθπαηδεπηηθά ηδξχκαηα ρξεζηκνπνηνχλ πξνγξάκκαηα αλνηθηνχ θψδηθα θαη έρνπλ ηελ δπλαηφηεηα 

λα πξνζζέηνπλ θαη λα ηξνπνπνηνχλ θψδηθα.  

Πξφζζεηα εξγαιεία φπσο  ςεθνθνξία θαη επίπεδα δηαρείξηζεο , ζε αξθεηά κπνξνχλ λα πξνζηεζνχλ 

είηε έλαληη ακνηβήο είηε κε εηζαγσγή θψδηθα (εθφζνλ είλαη ειεχζεξνπ ινγηζκηθνχ).  

Οη δηαθνξέο είλαη εκθαλείο ζην έιεγρν πξνζπέιαζεο. Αξθεηά wikis παξέρνπλ αζθάιεηα κε ηε 

δπλαηφηεηα εηζαγσγήο φλνκα ρξήζηε θαη θσδηθφ πξφζβαζεο γηα λα πξνζηαηεπζνχλ νη ζειίδεο, λα 

πεξηνξηζηνχλ νη ρξήζηεο, θαη λα παξαζρεζεί δηαθνξεηηθφ επίπεδν δηαρεηξηζηηθνχ ειέγρνπ. Πνιχ ιίγα 

απφ ηα wikis πνπ εμεηάζηεθαλ είραλ επηπιένλ ραξαθηεξηζηηθά γλσξίζκαηα φπσο, ςεθνθνξία,  

εκεξνιφγηα, θαη  ρξήζε RSS. Οη Leuf θαη Cunningham (2001) έρνπλ πξνηείλεη ζε έξεπλα πνπ έθαλαλ 

φηη έλα wiki ζα πξέπεη λα έρεη επηπιένλ ιεηηνπξγίεο ψζηε λα ηείλνπλ λα ηθαλνπνηήζνπλ ηηο αλάγθεο 

ελφο αξθεηά κεγάινπ αθξναηεξίνπ. 

4.3.3 Κξηηήξηα επηινγήο Wiki. 

Ο παξαθάησ ζπλνπηηθφο θαηάινγνο πεξηγξάθεη θξηηήξηα πξνο εμέηαζε θαηά ηελ επηινγή ελφο wiki 

γηα εθπαηδεπηηθή ρξήζε Grant (2006) θαη University of Delaware (2008):  

1) Κφζηνο:   

a) Λνγηζκηθφ αλνηρηνχ θψδηθα ή αγνξά πξνγξάκκαηνο 

b) Άδεηα ρξήζεο  

c) Τπνζηεξηδφκελε  γιψζζα πξνγξακκαηηζκνχ. 

2) Πνιππινθφηεηα:   

a) online ηερληθή ππνζηήξημε (ηεθκεξίσζε, εγρεηξίδην,  FAQs) 
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b) βνήζεηα κε ειεθηξνληθφ ηαρπδξνκείν/ ηειέθσλν/ fax / online θφξνπκ )  

c) δπλαηφηεηα πξνζζήθεο ή αληαιιαγήο θψδηθα ή κπινθ θψδηθα κε ηε κνξθή plug-in 

d) χπαξμε θνηλφηεηαο ρξεζηψλ  

e) Υψξνο θηινμελίαο θαη δπλαηφηεηεο ππνζηήξημεο. 

3) Έιεγρνο:   

a) εγγξαθή ρξεζηψλ  

b) πξνζηαζία θσδηθνχ πξφζβαζεο ησλ ζειίδσλ πνπ πεξηέρνπλ θψδηθα   

c) επίπεδα δηθαησκάησλ ρξεζηψλ 

d) θαηάινγνο ελεξγψλ ρξεζηψλ    

e) θαηάινγνο ζεκαηηθψλ ελνηήησλ – θαηεγνξηψλ 

f) εχθνινο λα απνθαηαζηήζεη ηηο ραιαζκέλεο ή δηαγξακκέλεο ζειίδεο.  

4) ΢αθήλεηα:   

a) Πίλαθαο πεξηερνκέλσλ , ράξηεο ηζηνρψξνπ 

b) Interwiki - έλα ζρήκα πνπ δηεπθνιχλεη πεξηερφκελν ζχλδεζεο κεηαμχ δηαθνξεηηθψλ 

wikis   

c) Πίζσ-ζχλδεζε 

d) Ηεξάξρεζε ζειίδσλ  

e) Ηζηνξία φισλ ησλ εθδφζεσλ  

f) Γεκηνπξγία λέσλ ζειίδσλ   

g) Αξρεηνζέηεζε φισλ ησλ ζειίδσλ   

h) Πξνζδηνξηζηηθφ λένπ ζέκαηνο (νπηηθφο ζπκβνιηζκφο)   

i) Αλαθνίλσζε κε ρξήζε ειεθηξνληθνχ ηαρπδξνκείνπ ησλ αιιαγψλ.  

5) Να κπνξνχλ λα παξέρνπλ:   

a) Δλεκέξσζε απφ θπιινκεηξεηέο  

b) ππνζηήξημε HTML  

c) ππνζηήξημε WYSIWYG  

d) εηζαγσγή θεηκέλνπ (πιάγηνπο ραξαθηήξεο, κέγεζνο γξακκάησλ, ρξψκα)  

e) εηζαγσγή πηλάθσλ 
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f) εηζαγσγή εηθφλσλ  

g) εηζαγσγή ζπλδέζκσλ ππεξθεηκέλνπ  

h) εηζαγσγή κέζσλ (ήρνπ / βίληεν)  

i) δεκηνπξγία ιίζηαο κε αξηζκνχο , θνπθθίδεο ή εηθφλεο 

j) εηθνλίδηα ζπλαηζζεκάησλ  emoticons 

k) αλαδήηεζε  

l) ζπληαθηηθφο έιεγρνο  

m) εξγαιεία  ειέγρνπ ζπλδέζεσλ  

n) blogging 

o) RSS  

p) εκεξνιφγην  

q) ςεθνθνξία  

r) ζπληάθηεο εμηζψζεσλ  

s) ζρεδηαζηηθά εξγαιεία 

 

4.3.4 Δθπαηδεπηηθή ρξήζε ησλ Wiki 

Δίλαη δχζθνιν λα ππνινγηζηεί ν αξηζκφο ησλ wikis πνπ ρξεζηκνπνηνχληαη απηήλ ηελ πεξίνδν γηα 

εθπαηδεπηηθφ ζθνπφ, θαη ην εχξνο ρξήζεο απηψλ. Σα wikis είλαη έλα θπζηθφ εξγαιείν γηα ηελ εμ 

απνζηάζεσο εθπαίδεπζεο. Σα wikis επηηξέπνπλ ζηνπο εθπαηδεπηηθνχο λα δεκηνπξγήζνπλ δηαινγηθέο 

δξαζηεξηφηεηεο γηα ηνπο εθπαηδεπφκελνχο ηνπο, λα παξνπζηάζνπλ  εθπαηδεπηηθέο πιεξνθνξίεο, 

ςεθηαθέο ζεηξέο καζεκάησλ κε ηε κνξθή πφξσλ, εμσηεξηθνχο ζπλδέζκνπο (link)  θαη ηέινο έρνληαο 

κηα επηπιένλ θαηεγνξία γηα βνήζεηα: ηηο απαληήζεη ζε ζπρλέο εξσηήζεηο (FAQs).  

Οη εθπαηδεπηηθνί έρνπλ ηε δπλαηφηεηα λα ειέγμνπλ ηηο ζπδεηήζεηο ζηα wiki , λα θαζνξίζνπλ ηνπο 

πξνβιεκαηηζκνχο ελφο ζέκαηνο θαη λα θαζνδεγήζνπλ ηνπο εθπαηδεπφκελνπο. Σα παλεπηζηεκηαθά 

wikis ρξεζηκνπνηνχληαη ζπλήζσο σο απνζήθεο γλψζεο.  

Οη εθπαηδεπηηθέο ρξήζεηο ελφο wiki είλαη :  

 Οη εθπαηδεπφκελνη κπνξνχλ λα ρξεζηκνπνηήζνπλ έλα wiki γηα λα αλαπηχμνπλ ηα εξεπλεηηθά 

πξνγξάκκαηα, ρξεζηκνπνηψληαο ην wiki σο ηξέρνπζα ηεθκεξίσζε ηεο εξγαζίαο ηνπο.  

 Σα Wikis κπνξνχλ λα ρξεζηκνπνηεζνχλ απφ ηνπο εθπαηδεπφκελνπο γηα λα λα ρηίζνπλ  κηα 

ζπλεξγαηηθή ζρνιηαζκέλε βηβιηνγξαθία. 
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 ΢ε πεξηβάιινληα απφ απφζηαζεο εθπαίδεπζε, ν εθπαηδεπηήο κπνξεί λα δεκνζηεχζεη ηνπο 

πφξνπο κηαο ζεηξάο καζεκάησλ φπσο ε δηδαθηέα χιε θαη νη ζεκεηψζεηο, θαη νη 

εθπαηδεπφκελνη λα κπνξνχλ λα ηα ηξνπνπνηήζνπλ θαη λα ηα ζρνιηάζνπλ άκεζα . 

 Σα Wikis κπνξνχλ λα ρξεζηκνπνηεζνχλ σο βάζε γλψζεσλ θαη γηα ηνπο εθπαηδεπηέο, 

επηηξέπνληάο ηνπο λα κνηξαζηνχλ απφςεηο θαη ζθέςεηο ζρεηηθά κε  δηδαθηηθέο πξαθηηθέο 

δίλνληαο ηε δπλαηφηεηα γηα ζρφιηα θαη πξνζζήθεο. 

 Σα Wikis κπνξνχλ λα ρξεζηκνπνηεζνχλ γηα εξκελεία ελλνηψλ: είλαη ρξήζηκα γηα ην 

"brainstorming" ζε έλα δεδνκέλν ζέκα. Έλα wiki κπνξεί λα ρξεζηκνπνηεζεί γηα λα 

δηεπθνιχλεη κηα παξνπζίαζε αληί ηνπ ζπκβαηηθνχ ινγηζκηθνχ, φπσο ην PowerPoint, θαη  νη 

εθπαηδεπφκελνη είλαη ζε ζέζε λα ζρνιηάζνπλ άκεζα θαη λα αλαζεσξήζνπλ ηελ παξνπζίαζε 

ελψ πξαγκαηνπνηείηαη. 

 Σα Wikis ρξεζηκνπνηνχληαη γηα ηελ αμηνιφγεζε ζεηξάο καζεκάησλ: νη εθπαηδεπφκελνη 

γξάθνπλ ζε ζπλεξγαζία ηηο αλαθνξέο ηνπο γηα ηηο ζεηξέο ησλ καζεκάησλ πνπ έρνπλ 

παξαθνινπζήζεη. 

 

4.3.5 Δθπαηδεπηηθά πιενλεθηήκαηα ησλ wikis  

΢ηελ νπζία ηα wikis πξνζθέξνπλ έλαλ online δηαζέζηκν ρψξν γηα ην ζπλεξγαηηθφ γξάςηκν. Δίλαη 

δηαζέζηκν πξνο φινπο ηνπο ρξήζηεο ηνπ ηζηνχ ή γηα ηα κέιε ζπγθεθξηκέλσλ θνηλνηήησλ, θαη 

πεξηιακβάλνπλ εξγαιεία ειέγρνπ  πνπ επηηξέπεη ζηνπο ζπληάθηεο  λα παξαθνινπζήζνπλ ηελ ηζηνξία 

ζπγθεθξηκέλσλ ζειίδσλ, θαη ηελ ηζηνξία ησλ πξνζσπηθψλ ηνπο θαηαρσξίζεσλ. Έλα wiki πξνζθέξεη  

ηε δπλαηφηεηα γηα αιιειεπίδξαζε πάλσ ζε έλα εμειηζζφκελν έγγξαθν κε ηελ πάξνδν ηνπ ρξφλνπ. 

Δπηηξέπεη ζηνπο εθπαηδεπηέο θαη ηνπο εθπαηδεπφκελνπο  λα δνπλ ηελ εμέιημε ελφο γξαπηνχ ζηφρνπ, 

θαη  λα ζρνιηάδνπλ ζπλερψο ζε φιε ηε δηαδηθαζία θαη φρη κφλν ζην ηέινο. Δίλαη ηδαληθφ γηα νκαδηθέο 

εξγαζίεο αθνχ φπσο είπακε θαη πξνεγνπκέλσο ζρφιηα,  πξνζζήθεο θαη δηνξζψζεηο  κπνξνχλ λα 

γίλνληαη ζπλέρεηα θαη κάιηζηα ζε πξαγκαηηθφ ρξφλν.  

4.3.6 Παξαδείγκαηα εθπαηδεπηηθήο εθαξκνγήο ησλ wikis  

Σν Wikipedia ζα κπνξνχζε λα ραξαθηεξηζηεί σο ε κεγαιχηεξε εθπαηδεπηηθή εθαξκνγή πνπ ππάξρεη 

απηή ηε ζηηγκή ζην δηαδίθηπν. Γέρεηαη επηζθέςεηο απ’ φιεο ηηο ειηθίεο θαη κέρξη ηα ηέιε ηνπ 2007 είρε 

πεξηζζφηεξεο απφ 2.1 εθαηνκκχξηα αλαθνξέο ζηα αγγιηθά πνπ είραλ ελζσκαησζεί ζε απηφ. Οη 

αλαθνξέο είλαη γξακκέλεο απφ επηζθέπηεο θαη πνιιέο θνξέο ακθηζβεηείηαη ε εγθπξφηεηα ηεο 

πιεξνθνξίαο, πξφζθαην παξάδεηγκα είλαη νη «πιεξνθνξίεο» πνπ ππήξραλ γηα ηνλ Έιιελα πνιηηηθφ 

Δπάγγειν Βεληδέιν.  

Μεξηθέο ελδεηθηηθέο πεγέο γηα ρξήζε ησλ wikis ζηελ εθπαίδεπζε : 

 http://scienceinquirer.wikispaces.com/freestuff 
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 http://fiestawiki.pbwiki.com/1-14-08+Online+Lesson+Los+Feriados 

 http://www.sdst.org/shs/library/jvles.html 

 http://www.classroom20.com/forum/topic/show?id=649749%3ATopic%3A73697 

 http://en.wikibooks.org/wiki/Chinese 

4.4 Webquest 

4.4.1 Δηζαγσγή 

Έλα πξφβιεκα πνπ ζπλαληά θαλείο ζηηο αλαδεηήζεηο πιεξνθνξηψλ ζην δηαδίθηπν είλαη φηη δελ 

βξίζθεη πάληα απηφ ην νπνίν αλαδεηά. Ζ πιεξνθνξία πνπ «απνθηά» δελ εμππεξεηεί πάληα 

εθπαηδεπηηθνχο ζθνπνχο. Έλα θιαζηθφ παξάδεηγκα είλαη ε αλαδήηεζε πιεξνθνξηψλ γηα θάπνην 

φξγαλν ηνπ αλζξψπηλνπ ζψκαηνο. Αλ θάπνηνο «ηνικήζεη» λα δψζεη ηελ ιέμε «΢ηήζνο» ζην google  

ζα πάξεη σο απνηέιεζκα 492.000 πεγέο (28/8/2008). Σν εξψηεκα πνπ ηίζεηαη είλαη πφζεο απφ απηέο 

κπνξνχλ λα αμηνπνηεζνχλ γηα έλα κάζεκα φπσο απηφ ηηο αλζξσπνινγίαο. Άξα ηίζεηαη ην εξψηεκα 

πσο κπνξνχκε λα νξγαλψζνπκε ηελ αλαδήηεζε έηζη ψζηε λα έρνπκε ην επηζπκεηφ απνηέιεζκα. 

΢χκθσλα κε ηνπο Dodge (1999) &  WebQuest (2005)  απάληεζε ζην πξφβιεκα δίλεη κία λεά 

πξνζέγγηζε νξγάλσζεο καζεκάησλ πνπ νλνκάδεηαη WebQuest.  Σν WebQuest απνηειεί κία 

θαηεπζπλφκελε έξεπλα - αλαδήηεζε (Ακπξάδε, 2005) ζηελ νπνία νη εθπαηδεπφκελνη θαινχληαη λα 

επηιχζνπλ θάπνην πξφβιεκα αμηνπνηψληαο ην δηαδίθηπν σο ηε βαζηθή πεγή πιεξνθνξίαο αιιά φρη θαη 

κνλαδηθή. Οπζηαζηηθά ην Webquest είλαη κηα ζηξαηεγηθή γηα ην ζπλδπαζκφ ηεο ηθαλφηεηαο ζπιινγήο 

πιεξνθνξηψλ απφ ην δηαδηθηχνπ κε έλαλ ζηφρν, πνπ επηηξέπεη ζηνπο ζπκκεηέρνληεο  λα 

επεμεξγαζηνχλ θαη λα κεηαζρεκαηίζνπλ ηελ πιεξνθνξία (Laureate Education, Inc., 2003). 

Ζ νξγάλσζε ελφο ηέηνηνπ καζήκαηνο δίλεη ηνλ πξψην ιφγν ζηελ πιεξνθνξία. Μέζα απφ ηελ 

δηαδηθαζία ν εθπαηδεπφκελνο θαιείηαη λα επεμεξγαζηεί ηελ πιεξνθνξία θαη λα νηθνδνκήζεη ηελ λέα 

γλψζε. Ο ζρεδηαζκφο ησλ WebQuests γίλεηαη κε ηέηνην ηξφπν ψζηε λα ηίζεηαη έλα φξην ζηελ 

δξαζηεξηφηεηα ησλ καζεηψλ. Χζνχλ ηνπο εθπαηδεπφκελνπο ζην λα αλαπηχμνπλ θαη λα  

θαιιηεξγήζνπλ ηελ αλαιπηηθή θαη ζπλζεηηθή ηνπο ζθέςε θαη ηελ θξηηηθή ηνπο ηθαλφηεηα (Dodge, 

1999; Brown Yoder, 1999).  

4.4.2 Σν webquest ζηελ εθπαίδεπζε 

Όπσο είδακε θαη παξαπάλσ νη εθπαηδεπφκελνη θαινχληαη λα αμηνπνηήζνπλ ην δηαδίθηπν σο πεγή 

πιεξνθνξηψλ. Δπεηδή φκσο ππάξρεη ν «πεξηνξηζκφο» ζην ηη είδνπο πιεξνθνξίεο ζα ζπιιέμνπλ, ε 

αλαδήηεζε πιεξνθνξηψλ πεξηνξίδεηαη αξρηθά ζε ζπγθεθξηκέλεο πεγέο φπσο δηθηπαθνχο ηφπνπο πνπ 

έρνπλ εληνπηζηεί θαη αμηνινγεζεί απφ πξηλ απφ ηνλ εθπαηδεπηηθφ, θαη ζηε ζπλέρεηα αλάινγα κε ηηο 

ηθαλφηεηεο ηνπ εθπαηδεπφκελνπ θαη ηνπο ζηφρνπο ηεο δξαζηεξηφηεηαο, ε αλαδήηεζε λα επεθηείλεηαη 

ζε άιιεο πεγέο ζην δηαδίθηπν. Όπσο ζα δνχκε θαη ζην παξάδεηγκά καο νη εθπαηδεπφκελνη θαινχληαη 

λα αλαιάβνπλ ηελ επζχλε γηα λα: αλαδεηήζνπλ ηελ πιεξνθνξία, λα ηελ επηιέμνπλ αθνχ ηελ 
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αμηνινγήζνπλ πξψηα  θαη ηέινο λα ηελ αμηνπνηήζνπλ κε βάζε ηνπο ζηφρνπο ηεο δξαζηεξηφηεηάο ηνπο. 

Ο ξφινο ηνπ εθπαηδεπηηθνχ είλαη βαζηθφο αθνχ απηφο επηιέγεη ην ζέκα ηνπ καζήκαηνο, ζρεδηάδεη 

θαηάιιειεο δξαζηεξηφηεηεο, επηιέγεη ηηο πεγέο αθνχ ηηο έρεη ειέγμεη πξψηα, ζηε δηάξθεηα ηνπ 

καζήκαηνο παξέρεη βνήζεηα θαη θαζνδήγεζε φηαλ ρξεηαζηεί θαη ππνζηεξίδεη ηνπο ζπκκεηέρνληεο 

ζηελ πξνζπάζεηά ηνπο δηακνξθψλνληαο έλα θιίκα ζπλεξγαζίαο (Βνζληάδνπ, 2001). 

Ζ δνκή ελφο WebQuest είλαη θαηάιιεια δηακνξθσκέλε έηζη ψζηε λα εηζάγεη ηνλ εθπαηδεπφκελν 

βήκα – βήκα ζην ζέκα ηεο δξαζηεξηφηεηαο, λα ηνλ πιεξνθνξεί γηα ην ξφιν πνπ ζα έρεη θαη ηέινο λα 

νξηνζεηεί θαη έκκεζα λα θαηεπζχλεη ηελ εξγαζία ηνπ. ΢ηνλ ζρεδηαζκφ ηίζεηαη απφ ηνλ εθπαηδεπηηθφ ν 

ζθνπφο θαη ηα πξνζδνθψκελα απνηειέζκαηα ηνπ καζήκαηνο.  

Έλα WebQuest απνηειείηαη απφ ηα παξαθάησ κέξε:  

 Δηζαγσγή: Ο εθπαηδεπηηθφο θεληξίδεη ην ελδηαθέξνλ ηνπ εθπαηδεπφκελνπ ζρεηηθά κε ην ζέκα 

ηνπ καζήκαηνο θαη ηηο δξαζηεξηφηεηεο πνπ ζα ιάβνπλ ρψξα. 

 Δξγαζία: Γίλεηαη θαηαλνκή ησλ ξφισλ θαη αλάζεζε ησλ εξγαζηψλ ζηνπο εθπαηδεπφκελνπο. 

 Γηαδηθαζία: ΢ην κέξνο απηφ γίλεηαη αλαιπηηθή πεξηγξαθή ηνπ ηη ζα πξέπεη νη εθπαηδεπφκελνη 

λα θάλνπλ , ηα βήκαηα, νη πεγέο πνπ ζα αλαδεηεζνχλ νη πιεξνθνξίεο θιπ. 

 Αμηνιόγεζε: Γίλεηαη αλαθνξά ζηνλ ηξφπν πνπ ζα γίλεη ε αμηνιφγεζε ησλ ζηφρσλ ηνπ 

καζήκαηνο θαη ηίζεληαη  ηα θξηηήξηα αμηνιφγεζεο. 

 ΢πκπέξαζκα: φπσο ζε θάζε κάζεκα ή δξαζηεξηφηεηα πνπ νινθιεξψλεηαη γίλεηαη αλαθνξά 

ζε απηά πνπ πέηπραλ ή έκαζαλ νη εθπαηδεπφκελνη θαηά ηελ δηάξθεηα ηεο  δξαζηεξηφηεηαο. 

 Ζ ζειίδα ηνπ καζήκαηνο: Δδψ πξνζθέξνληαη πιεξνθνξίεο θαη νδεγίεο ζρεηηθά κε ηνλ ηξφπν 

πινπνίεζεο ηνπ καζήκαηνο. 

Θα πξέπεη λα δψζνπκε πεξηζζφηεξε πξνζνρή ζηνλ ηξφπν αλεχξεζεο ησλ πξνηεηλφκελσλ πεγψλ, απφ 

ηνπ εθπαηδεπφκελνπο, ζηηο νπνίεο ζα βαζηζηεί ην κάζεκα. Απηφο ζα πξέπεη γίλεηαη έρνληαο θαηά λνπ 

ηα παξαθάησ:  

 φζν αθνξά ην πεξηερφκελφ ηνπο, ην πιηθφ  απηφ ζα πξέπεη λα είλαη ζρεηηθφ κε ην ζέκα, λα 

θαιχπηεη ην επίπεδν ησλ εθπαηδεπφκελσλ, λα είλαη θαηαλνεηά απηά ηα νπνία αλαθέξνληαη θαη 

λα παξνπζηάδνληαη κε ειθπζηηθφ ηξφπν. 

 ε δηεπηθάλεηα (ζρεδηαζκφο site), λα είλαη απιή θαη πξνζηηή θαη λα θαιχπηεη ηηο δεμηφηεηεο 

πινήγεζεο ησλ εθπαηδεπνκέλσλ. 

 

4.4.3 Παξάδεηγκα εθπαηδεπηηθήο εθαξκνγήο ησλ Webquest  

Παξαθάησ ζα εμεηάζνπκε έλα παξάδεηγκα ρξήζεο  WebQuest κε ηελ νλνκαζία «Αθξαία θαηξηθά 

θαηλφκελα». 
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Απηφ ην WebQuest έγηλε γηα δηδαθηηθνχο ζθνπνχο ζε κάζεκα γηα ηελ  ειεθηξηθή ελέξγεηα χζηεξα απφ 

ζεηξά καζεκάησλ επάλσ ζηελ αζθάιεηα ειεθηξηθήο ελέξγεηαο. Ζ εζηίαζε ζηελ αζθάιεηα ηεο 

ειεθηξηθήο ελέξγεηαο ζα γίλεη κε ηελ κειέηε αθξαίσλ θαηξηθψλ θαηλνκέλσλ. Σν κάζεκα ζα θιείζεη κε 

ηελ δεκηνπξγία απφ πιεπξάο εθπαηδεπνκέλσλ ελφο βηβιίνπ νδεγηψλ γηα πξνζηαζία απφ αθξαία 

θαηξηθά θαηλφκελα. Σν ζηάδην απηφ δεκηνπξγεί θίλεηξν θαη κεγαιχηεξν ελδηαθέξνλ ψζηε λα ππάξρεη 

κεγαιχηεξε ζπκκεηνρή απφ πιεπξάο ηνπο. 

Δξγαζία « Μειέηε θαηξηθώλ θαηλνκέλσλ» 

Γηα λα νινθιεξψζνπλ απηφ ην WebQuest, νη εθπαηδεπφκελνη αλακέλνληαη λα εξεπλήζνπλ ηελ 

θαηαζηξεπηηθή δχλακε ελφο απφ ηνπο ηέζζεξηο ηχπνπο ζπειιψλ: θαηαηγίδεο, ρηνλνζχειιεο, πιεκκχξεο 

ή αλεκνζηξφβηινπο. Θα εξεπλήζνπλ επίζεο ηηο πξνθπιάμεηο – θαηάιιειεο ελέξγεηεο αζθάιεηαο πνπ 

πξέπεη λα παξζνχλ θαηά ηε δηάξθεηα ηνπ επηιεγκέλνπ ηχπνπ θαηξνχ . Ο ζηφρνο απηήο ηεο εξγαζίαο 

είλαη νη εθπαηδεπφκελνη λα κάζνπλ θαη λα εμεγνχλ ηηο θαηάιιειεο πξνθπιάμεηο αζθάιεηαο θαηά ηε 

δηάξθεηα ησλ θαηλνκέλσλ πνπ κειεηνχλ. (ππνπξγείν Παηδείαο ηνπ Μίζηγθαλ, 2003). 

Ζ εξγαζία απηή είλαη εχθνιε ζηελ πξαγκαηνπνίεζή ηεο αθνχ ππάξρνπλ πνιινί ηζηνρψξνη πνπ  

πεξηέρνπλ ρξήζηκεο πιεξνθνξίεο. Δπηπιένλ, νη εθπαηδεπφκελνη βξίζθνπλ ηηο πεξηζζφηεξεο θνξέο ην 

ζέκα ηεο αζθάιεηαο απφ θαηξηθά θαηλφκελα πνιχ ελδηαθέξνλ θαη είλαη θάηη πνπ «έρεη λφεκα» γηα 

απηνχο.  

Ζ εξγαζία απηή απαηηεί ηελ θαηαλφεζε θαη φρη ηελ παπαγαιία ηνπ ζέκαηνο πνπ αζρνινχληαη. Οη 

εθπαηδεπφκελνη αξρηθά πξέπεη κάζνπλ ηα ζηνηρεία θαη ηηο ιεπηνκέξεηεο γηα ην θαηξηθφ θαηλφκελν πνπ 

επέιεμαλ. Καηφπηλ καζαίλνπλ γηα απηά πνηεο είλαη νη θαηάιιειεο πξνθπιάμεηο πνπ κπνξνχλ λα 

πάξνπλ γηα ηελ αζθάιεηάο ηνπο. Σέινο, δεκηνπξγνχλ έλα θείκελν κε νδεγίεο πνπ πξέπεη λα 

αθνινπζεζνχλ αιιά θαη ηη ζα ζπκβεί αλ δελ αθνινπζεζνχλ νη νδεγίεο απηέο. Σν θείκελν απαηηεί ηε 

θαληαζία ησλ εθπαηδεπνκέλσλ . Γηα ηηο επηζθαιείο πξαθηηθέο, γίλεηαη έλα ζεαηξηθφ θαη πεξλνχλ ζην 

αθξναηήξην ηνπο ιφγνπο πνπ νη ραξαθηήξεο ελέξγεζαλ θαηά ηξφπν επηζθαιή.  

Πεγέο 

Οη πιεξνθνξίεο πνπ ρξεζηκνπνηνχληαη γηα απηφλ ηνλ ζηφρν ήηαλ νη παξαθάησ: 

 Γεκηνπξγία ελφο WebQuest κε ηίηιν «Καηξηθά Φαηλφκελα» 

 Γεκνζηεχζεηο θαη ζηνηρεία απφ ην National Oceanic and Atmospheric Administration 

(NOAA)  

 “Playtime for Kids”  απφ ηνλ ηζηνρψξν ηα ηνπ NOAA (Playtime for kids, 2005).   

Οη εθπαηδεπφκελνη δελ ζα ρξεηαζηεί λα βξνπλ πξφζζεηεο πεγέο ή λα δηαβάζνπλ βηβιία γηαηί νη 

πξνζθεξφκελεο ηζηνζειίδεο πεξηέρνπλ φιεο ηηο πιεξνθνξίεο πνπ ηπρφλ ζα ρξεηαζηνχλ. 

Γνπιεύνληαο κε έλα  WebQuest 
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Οη εθπαηδεπφκελνη ζα εξγαζηνχλ ζε νκάδεο ηεζζάξσλ αηφκσλ γηα λα νινθιεξψζνπλ απηήλ ηελ 

εξγαζία. Καηά ηε δηάξθεηα απηνχ ηνπ ζηφρνπ, νη εθπαηδεπφκελνη:  

1. Θα δηακνξθψζνπλ ηηο νκάδεο θαη ζα επηιέμνπλ ηνλ ηχπν ηνπ θαηξηθνχ θαηλνκέλνπ γηα ηελ 

έξεπλα ηνπο  

2. Θα απαξηζκήζνπλ ηη μέξνπλ ήδε, ή ηη ζθέθηνληαη  ζρεηηθά κε ηηο θαηάιιειεο πξνθπιάμεηο 

αζθάιεηαο θαηά ηε δηάξθεηα ηνπ θαηξηθνχ θαηλνκέλνπ  

3. Θα θάλνπλ έξεπλα γηα ην θαηξηθνχ θαηλνκέλνπ ζηνπο ηζηνρψξνπο  

4. Θα θαηαγξάςνπλ ηηο ζρεηηθέο πιεξνθνξίεο   

5. Με ηηο πιεξνθνξίεο πνπ ζα ηνπο δνζνχλ ζα γξάςνπλ ην θείκελν – ηζηνξία. 

6. Θα παίμνπλ ηελ ηζηνξία ζηελ ηάμε  

7. Θα νινθιεξψζνπλ κε ηελ αθήγεζε ηνπ ηη ζα έπξεπε λα γίλεη ψζηε νη πξσηαγσληζηέο λα είραλ 

παξακείλεη αζθαιήο κε ηελ αθνινπζία θαηάιιεισλ πξνθπιάμεσλ αζθάιεηαο 

8. Θα δεκηνπξγήζνπλ έλαλ νδεγφ «Δγρεηξίδην επηβίσζεο γηα ηε ρεηξφηεξε πεξίπησζε θαηξηθνχ 

θαηλνκέλνπο» ζην νπνίν ν θάζε ζπνπδαζηήο ζα ζθεθζεί ζρεηηθά θαη ζα γξάςεη ηη ζα θάλεη ζε 

πεξίπησζε ηέηνησλ θαηλνκέλσλ.  

 

Αμηνιόγεζε ηνπ WebQuest 

 Οη εθπαηδεπφκελνη ζα αμηνινγεζνχλ κε ηα παξαθάησ θξηηήξηα: 

 Απφ ην ζχλνιν ησλ πιεξνθνξηψλ πνπ έρνπλ ζπιιέμεη ζρεηηθά κε ηηο θαηάιιειεο πξνθπιάμεηο 

αζθάιεηαο θαηά ηε δηάξθεηα ηνπ επηιεγκέλνπ θαηξηθνχ θαηλνκέλνπ 

 Απφ ηελ θαηαλφεζε ησλ πιεξνθνξηψλ αζθαιείαο πνπ ζπγθέληξσζαλ θαη ησλ ζπλεπεηψλ πνπ 

ππάξρνπλ ζε πεξίπησζε πνπ δελ ηηο ηεξήζνπλ 

 Απφ ηελ θαληαζία πνπ ζα επηδείμνπλ θαηά ηε ζπγγξαθή ηνπ θεηκέλνπ –ηζηνξία πνπ ζα 

παξνπζηάζνπλ. 

΢πκπεξάζκαηα από ην WebQuest 

Ζ φιε πξνζπάζεηα βξίζθεηαη ζην έξγν πνπ θαινχληαη νη εθπαηδεπφκελνη λα «παίμνπλ», ζην ζελάξην 

θαη ζηα ζπκπεξάζκαηα πνπ ζα βγάινπλ. Σν πψο αληηδξνχκε ζε θαηαζηάζεηο θαη ηη ζα έπξεπε λα 

θάλνπκε ψζηε λα παξακείλνπκε αζθαιήο. Όιν απηφ ην παηρλίδη εληζρχεη ηε κάζεζε θαη ηε δηάζεζε 

ησλ εθπαηδεπνκέλσλ γηα πεξαηηέξσ έξεπλα ζε ζέκαηα αζθάιεηαο. 

4.4.4 Παξαδείγκαηα εθπαηδεπηηθήο εθαξκνγήο ησλ Webquest  
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Μεξηθέο ελδεηθηηθέο πεγέο γηα ρξήζε ηνπ γηα εθπαηδεπηηθή ρξήζε: 

 http://www.vickiblackwell.com/bones.html 

 http://www.lakemunmor-p.schools.nsw.edu.au/onlineworksheets/stage%203/r ainforests.htm 

 http://webquest.sdsu.edu/webquestrubric.html 

 http://bestwebquests.com/bwq/listarea.asp?wqcatid=7&edid= 

 http://bestwebquests.com/ 

 http://www.dedham.k12.ma.us/webquest/nc/EllisIslandQuest.html 

 http://btc.montana.edu/ceres/html/EdActivities.html 

 http://www.education.umd.edu/Depts/EDCI/edci385/webquests3/Webquest3/studentpage.html
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5 ΣΔΥΝΖΣΖ ΝΟΖΜΟ΢ΤΝΖ 

 

5.1 Δηζαγσγή 

Οη ππνινγηζηέο ρξεζηκνπνηνχληαη πάλσ απφ κία 20-εηία  ζηελ εθπαίδεπζε θαη ηε δηδαθηηθή. Οη 

πξψηεο πξνζπάζεηεο γηα ηελ δηδαθηηθή ηνπο ρξήζε ήηαλ ε θαηάξηηζε βαζηζκέλε ζηνπο Ζ/Τ (CBT-

Computer Base System) θαη ε κάζεζε κε ηε βνήζεηα Ζ/Τ (CAI-Computer Assisted Instruction). ΢ε 

απηά ηα είδε ζπζηεκάησλ, ε νδεγία - βνήζεηα δελ ήηαλ εμαηνκηθεπκέλε ζηηο αλάγθεο ηνπ καζεηή. Ζ 

κέζνδνο πνπ αθνινπζνχζαλ απηά ηα ζπζηήκαηα ζηεξίδνληαλ ζηηο  απαληήζεηο πνπ έδηλε πνπ έδηλε ν 

εθπαηδεπφκελνο δειαδή αλ ήηαλ ζσζηή  ηνλ κεηέθεξε ζηελ εξψηεζε X, δηαθνξεηηθά ηνλ νδεγνχζε ζε 

Y. ΢ηηο πξνζπάζεηεο απηέο νη γλψζεηο θαη νη δπλαηφηεηεο ηνπ αξραξίνπ είραλ κείλεη εθηφο 

ζρεδηαζκνχ.  

Σα CBT θαη CAI κπνξνχζαλ λα πξνζθέξνπλ αξθεηή βνήζεηα ζηελ δηδαζθαιία ησλ καζεηψλ, αιιά 

δελ παξείραλ ην ίδην είδνο εμαηνκηθεπκέλεο πξνζνρήο πνπ έλαο καζεηήο ζα ιάκβαλε απφ έλαλ 

«θπζηθφ  δάζθαιν (Bloom,1984). Γηα λα κπνξεί έλα εθπαηδεπηηθφ ζχζηεκα βαζηζκέλν ζε ππνινγηζηή 

λα παξέρεη ηέηνηα ππεξεζία ζα πξέπεη λα εζηηάζεη ζην πεξηερφκελν αιιά θαη ζην 

ρξήζηε(εθπαηδεπφκελν, θνηηεηή, καζεηή θιπ.). Έηζη ε έξεπλα κεηαηνπίζηεθε ζηνλ ηνκέα ηεο 

ηερλεηήο λνεκνζχλεο θαη ζηε δεκηνπξγία επθπψλ ζπζηεκάησλ παξάδνζεο ηδηαίηεξσλ καζεκάησλ 

(Έκπεηξα δηδαθηηθά ζπζηήκαηα) (ITSs). Απηά δίλνπλ ηδηαίηεξε επειημία ζηελ παξνπζίαζε ηνπ πιηθνχ 

θαη παξέρνπλ κεγαιχηεξε δπλαηφηεηα αληαπφθξηζεο ζηηο αλάγθεο ησλ καζεηψλ, θνηηεηψλ θιπ. Απηά 

ηα ζπζηήκαηα επηηπγράλνπλ «κε ηε λνεκνζχλε ηνπο»  ηελ αληηπξνζψπεπζε  παηδαγσγηθψλ 

απνθάζεσλ γηα ην πψο ζα δηδάμνπλ θαζψο επίζεο θαη ηη πιεξνθνξίεο ζα δψζνπλ ζηνλ καζεηή. Με 

απηφλ ηνλ ηξφπν πεηπραίλεηαη επίζεο θαη κεγαιχηεξε αιιειεπίδξαζε κεηαμχ ζπζηήκαηνο θαη 

εθπαηδεπφκελνπ. 

Σα λέα δηδαθηηθά πξνγξάκκαηα πξνζεγγίδνπλ ην γλσζηηθφ κνληέιν κάζεζεο (teaching and learning) 

ζεσξψληαο ηνπο ππνινγηζηέο φρη πιένλ σο εξγαιεία αιιά σο κέζα πνπ αληηιακβάλνληαη ηνλ ρξήζηε 

σο έλα άηνκν πνπ ζθέθηεηαη, θαηαλνεί θαη ζπκκεηέρεη. Ο λένο φξνο πνπ θαζηεξψζεθε γηα ηα ελ ιφγσ 

πξνγξάκκαηα ζηελ αξρηθή ηνπ απφδνζε ήηαλ Ννήκνλα ΢πζηήκαηα  Γηδαζθαιίαο Τπνβνεζνχκελα 

απφ Τπνινγηζηή. 

5.2 Ο όξνο Σερλεηή Ννεκνζύλε 

Ο φξνο Σερλεηή Ννεκνζύλε (ΣΝ) ή Artificial Intelligence (AI) (Wikipedia, 2008) απνδίδεηαη ζηνλ 

Σδνλ Μαθάξζη ν νπνίνο φξηζε ηνλ ηνκέα απηφ σο «ε επηζηήκε θαη ε κεζνδνινγία ηεο δεκηνπξγίαο 

λννχλησλ κεραλψλ».  

Γελ ήηαλ ιίγνη νη επηζηήκνλεο πνπ κειέηεζαλ ηελ λνεκνζχλε πξψηα ζε έλα ιεηηνπξγηθφ επίπεδν θαη 

χζηεξα λα απνδείμνπλ φηη πξνγξάκκαηα πνπ ζρεηίδνληαη ή ζηεξίδνληαη ζηελ ΣΝ ζα πξέπεη λα 
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επηηξέπνπλ ελαιιαθηηθνχο ηξφπνπο γηα ηελ πξνζέγγηζε θαη ηε ιχζε ελφο πξνβιήκαηνο. 

Πξνζπάζεζαλ λα θηηάμνπλ κηα ζθεπηφκελε κεραλή κε ηελ έλλνηα ηεο αλαπαξαγσγήο ηεο γλσζηηθήο 

ζπκπεξηθνξάο. Πξηλ απφ ιίγα ρξφληα ε πξνζπάζεηα επίηεπμεο κηαο ηέηνηαο κεραλήο ήηαλ ν Deep Blue 

ηεο IBM θαη θξηηήξην επίηεπμεο …κηα παξηίδα ζθάθη κε ηνλ παγθφζκην πξσηαζιεηή Kasparov. 

Παξά ηηο πξνζπάζεηεο ππάξρνπλ ζεκαληηθέο δηαθνξέο αλάκεζα ζηνλ αλζξψπηλν λνπ θαη ηνλ 

ειεθηξνληθφ ππνινγηζηή, νη νπνίεο είλαη: 

1) Ζ αλζξψπηλε γλσζηηθή ιεηηνπξγία βαζίδεηαη ζε δχν παξάγνληεο : ζην γλσζηηθφ θαη ζην βηνινγηθφ 

ζχζηεκα, ελψ ε ηερλεηή λνεκνζχλε βαζίδεηαη κφλν ζην γλσζηηθφ ζχζηεκα. 

2) Οη άλζξσπνη έρνπλ ζπλαίζζεζε ηεο γλσζηηθήο ιεηηνπξγίαο ηνπο, ζηελ επεμεξγαζία ησλ 

πιεξνθνξηψλ, ελψ νη ειεθηξνληθνί ππνινγηζηέο δελ έρνπλ. 

5.3 Καηεγνξηνπνίεζε  Σερλεηή Ννεκνζύλε 

Ζ ηερλεηή λνεκνζχλε (Wikipedia, 2008) δηαθξίλεηαη ζε: 

 Έκπεηξα ζπζηήκαηα (Expert systems), πνπ εθαξκφδνπλ πξνγξακκαηηζκέλεο ξνπηίλεο 

ινγηθήο, γηα κία ζπγθεθξηκέλε εξγαζία, πξνθεηκέλνπ λα εμαρζεί θάπνην ζπκπέξαζκα.  

 Λνγηθή θαηά πεξίπησζε (Case based reasoning). Ζ επίιπζε πξνβιεκάησλ πξνυπνζέηεη ηελ 

επίιπζε παξφκνησλ πξνβιεκάησλ ζην παξειζφλ.  

 Μπαϋεζηαλά δίθηπα (Bayesian networks). Βαζίδνληαη ζηε ζηαηηζηηθή αλάιπζε γηα ηε ιήςε 

απνθάζεσλ.  

 ΢πκπεξηθνξηζηηθή ηερλεηή λνεκνζύλε (Behavior based AI). Μέζνδνο ηεκαρηζκνχ ηεο 

ινγηθήο δηαδηθαζίαο θαη ζηε ζπλέρεηα ρεηξνθίλεηεο νηθνδφκεζεο ηνπ απνηειέζκαηνο. 

 Ζ ππνινγηζηηθή ηερλεηή λνεκνζύλε βαζίδεηαη ζηε κάζεζε κέζσ επαλαιεπηηθψλ 

δηαδηθαζηψλ (ξχζκηζε παξακέηξσλ). Ζ κάζεζε βαζίδεηαη ζε εκπεηξηθά δεδνκέλα θαη ζε κε-

ζπκβνιηθέο κεζφδνπο.  

 Σέινο, ππάξρνπλ ηα πβξηδηθά ζπζηήκαηα ηερλεηήο λνεκνζύλεο (hybrid intelligent systems) 

πνπ ζπλδπάδνπλ κεηαμχ ηνπο ηηο δχν αλσηέξσ θαηεγνξίεο. 

 

5.4 Σερλεηή Ννεκνζύλε θαη εθπαίδεπζε 

Σα έκπεηξα δηδαθηηθά ζπζηήκαηα απνηεινχλ ηηο πην πξφζθαηεο εθαξκνγέο ηεο ηερλεηήο λνεκνζχλεο 

ζηελ εθπαίδεπζε. ΢ε παιαηφηεξε έξεπλα (Woolf, 1992) ν Woolf έρεη πξνζδηνξίζεη ηέζζεξηο 

ζεκαληηθέο ελφηεηεο γηα ην πιαίζην ελφο επθπνχο ζπζηήκαηνο: ην κνληέιν ηνπ 

εθπαηδεπφκελνπ(πιεξνθνξίεο γηα ην πξνθίι ηνπ) φπνπ ηα ρξεζηκνπνηνχκελα κνληέια είλαη ηα overlay 

models θαη ηα Bayesian networks, ηελ παηδαγσγηθή ελφηεηα, ηελ  ελφηεηα γλσζηηθνχ πεξηερνκέλνπ-
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εθπαηδεπηηθφ πιηθφ, θαη ηελ ελφηεηα επηθνηλσλίαο ελψ ζε πξφζθαηε έξεπλα νη (Beck θαη ζπλεξγάηεο, 

2004) έρνπλ πξνζδηνξίζεη θαη κηα πέκπηε ελφηεηα, ην πξφηππν ηνπ έκπεηξνπ κνληέινπ.  Σν έκπεηξν 

κνληέιν(expert model) κνηάδεη κε ην ηελ ελφηεηα γλσζηηθνχ πεξηερνκέλνπ(domain) αθνχ πεξηέρεη ηε 

πιεξνθνξία πνπ δηδάζθεηαη ζηνλ εθπαηδεπφκελν αιιά επηπξφζζεηα παξέρεη θαη ηε πιεξνθνξία 

ζρεηηθά κε ηελ αλαπαξάζηαζε ηεο γλψζεο απφ ηνλ εθπαηδεπφκελνο . Με ηε ρξήζε ηνπ expert model, 

ν εθπαηδεπηήο   κπνξεί λα ζπγθξίλεη ηε ιχζε πνπ πξνηείλεη ν εθπαηδεπφκελνο κε απηή ηνπ έκπεηξνπ 

ζπζηήκαηνο(δειαδή ηεο ιχζεο πνπ πξνηείλεη ν εηδηθφο). Σν ζρήκα 5.1 παξέρεη κηα άπνςε ησλ 

αιιειεπηδξάζεσλ κεηαμχ ησλ ελνηήησλ. 

 

Δηθφλα 5.1: Δπηθνηλσλία ηκεκάησλ ελφο ITS 

5.5 Έκπεηξα Γηδαθηηθά ΢πζηήκαηα 

Σα Έκπεηξα Γηδαθηηθά ΢πζηήκαηα (Δ.Γ.΢) πξνζνκνηψλνπλ ηνλ δάζθαιν ζε κηα εθπαηδεπηηθή 

δηαδηθαζία. Με ιίγα ιφγηα γλσξίδνπλ ην ηη ζα δηδάμνπλ (πεξηνρή ηεο γλψζεο), ην  πσο  (ζηξαηεγηθέο 

θαζνδήγεζεο), θαη καζαίλνπλ φιεο ηηο απαξαίηεηεο πιεξνθνξίεο πνπ έρνπλ ζρέζε κε ην καζεηή πνπ 

ζπκκεηέρεη ζηελ εθπαηδεπηηθή δηαδηθαζία. Απηφ απαηηεί ηελ χπαξμε ηξηψλ ινγηθψλ πεξηνρψλ: 

 κηαο εμεηδηθεπκέλεο πεξηνρήο γλψζεσλ (Μνληέιν Δηδηθνχ - Expert Model) 

 γλψζεο θαζνδήγεζεο (Μνληέιν Καζνδήγεζεο - Instructional Model) 

 πιεξνθνξηψλ γηα ηνλ καζεηή (Μνληέιν Μαζεηή - Student Model) 

5.5.1 Σκήκαηα ελόο Έκπεηξνπ Γηδαθηηθνύ ΢πζηήκαηνο 

Σα ηκήκαηα πνπ είλαη ζεκαληηθά γηα ηελ χπαξμε ελφο Έκπεηξνπ Γηδαθηηθνχ ΢πζηήκαηνο είλαη :  

 ην Μνληέιν Δηδηθνχ (Expert Model),  

 ην Μνληέιν Μαζεηή (Student Model)  

 ην Μνληέιν Καζνδήγεζεο (Instruction Model).  

΢χκθσλα φκσο κε ηελ εξγαζία ησλ J. Beck θαη άιισλ (2004), ηα ηκήκαηα ελφο Δ.Γ.΢. είλαη πέληε:  

 Μνληέιν Μαζεηή  

 Παηδαγσγηθφ Μνληέιν  

 Μνληέιν Δηδηθνχ,  
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 Πεξηνρή Γλψζεο,  

 θαη ην Μνληέιν Δπηθνηλσλίαο. 

5.5.1.1 Μνληέιν Μαζεηή (Student Model) 

Σν Μνληέιν Μαζεηή απνζεθεχεη  πιεξνθνξίεο πνπ είλαη ζπγθεθξηκέλεο γηα θάζε μερσξηζηφ καζεηή. 

Κηίδεη κηα πεγή δεδνκέλσλ πνπ ζα ρξεηαζηεί αξγφηεξα ην παηδαγσγηθφ κνληέιν. Έλα ηέηνην πξφηππν 

παξαθνινπζεί ην πφζν θαιά απνδίδεη, ζην πιηθφ πνπ δηδάζθεηαη ,ν ζπγθεθξηκέλνο καζεηήο. ΢θνπφο 

ηνπ Μνληέινπ Μαζεηή είλαη λα δίλεη ζηνηρεία ζηελ παηδαγσγηθή ελφηεηα ηνπ ζπζηήκαηνο θαη φιεο νη 

πιεξνθνξίεο πνπ ζπγθεληξψλνληαη λα είλαη ζε ζέζε λα ρξεζηκνπνηεζνχλ απφ ηνλ εθπαηδεπηή. Μηα 

πηζαλή πξνζζήθε είλαη λα αλαθέξεη ηηο ιαλζαζκέλεο αληηιήςεηο ηνπ εθπαηδεπφκελνπ. 

5.5.1.2 Πεξηνρή Γλώζεο 

Απηφ ην ηκήκα πεξηέρεη πιεξνθνξίεο γηα ηηο ελφηεηεο ηνπ γλσζηηθνχ αληηθεηκέλνπ πνπ δηδάζθεηαη  

θαη ζα πξέπεη λα είλαη θαηαζθεπαζκέλν κε ηέηνην ηξφπν ψζηε λα είλαη δπλαηή ε πξφζβαζε απφ ηα 

άιια ηκήκαηα ηνπ ζπζηήκαηνο. Έλα ζρεηηθφ εξεπλεηηθφ δήηεκα είλαη ν ηξφπνο αλαπαξάζηαζεο ηνπ 

πιηθνχ ζην ηκήκα απηφ (Beck  θ.α. 2004) .  

5.5.1.3 Μνληέιν Καζνδήγεζεο (ή Παηδαγσγηθό Μνληέιν) 

Απηή ε ελφηεηα παξέρεη έλα κνληέιν γηα ηε καζεζηαθή-δηδαθηηθή αθνινπζία. Σν κνληέιν ηνπ καζεηή 

ρξεζηκνπνηείηαη σο είζνδνο ζε απηφ ην ηκήκα κε απνηέιεζκα νη «παηδαγσγηθέο απνθάζεηο» λα είλαη 

ζπλάξηεζε ησλ δηαθνξεηηθψλ αλαγθψλ θάζε ρξήζηε. Γπν ραξαθηεξηζηηθέο ηερληθέο είλαη ε 

ζπεηξνεηδήο κέζνδνο θαη ε ζσθξαηηθή κέζνδνο. Σν ηκήκα απηφ παξέρεη πιεξνθνξίεο γηα ην πφηε 

πξέπεη λα εηζαγάγεη κηα   έλλνηα, πφηε πξέπεη  λα παξνπζηάζεη έλα λέν ζέκα θιπ. Σν ζέκα ειέγρεηαη 

απφ ηελ παηδαγσγηθή ελφηεηα.   

Καζνξηζκόο πεξηερνκέλνπ κάζεζεο 

Ο δάζθαινο(εθπαηδεπηήο) είλαη απηφο πνπ ζα απνθαζίζεη γηα είδνο θαη ηελ έθηαζε ησλ πιεξνθνξηψλ 

πνπ ζα παξνπζηαζηνχλ ζην καζεηή(εθπαηδεπφκελν). Ο εθπαηδεπηήο ζα πξέπεη λα πάξεη απνθάζεηο 

ζρεηηθά κε ην ζέκα, ην πξφβιεκα πνπ ζα θιεζεί λα ιχζεη ν καζεηήο , θαη ην είδνο θαη ηε έθηαζε ηεο 

αλαηξνθνδφηεζεο πνπ ζα δνζεί ζηνλ καζεηή. 

 Δπηινγή ζέκαηνο.  Δδψ ν δάζθαινο πξέπεη λα κειεηήζεη ην κνληέιν καζεηή γηα λα θαζνξίζεη 

πνηεο είλαη νη αλάγθεο ηνπ καζεηή θαη αλάινγα λα επηιέμεη πνην ζέκα ζα ηνπ αλαζέζεη.  

 Παξαγσγή πξνβιήκαηνο: Αθνχ έρεη θαηαιήμεη ζην ζέκα πνπ ζα αλαζέζεη ζηνλ καζεηή ζα 

πξέπεη λα δεκηνπξγήζεη – «θαηαζθεπάζεη» έλα πξφβιεκα ην νπνίν ζα ιπζεί απφ ηνλ καζεηή. 

Σν επίπεδν δπζθνιίαο ηνπ πξνβιήκαηνο ζα πξέπεη λα ζπκθσλεί κε ην επίπεδν γλσζηηθήο 

ηθαλφηεηαο ηνπ καζεηή.  

 Καζνδεγεηηθή Αλάδξαζε (Feedback): Όζν ν καζεηήο δελ αληηκεησπίδεη πξνβιήκαηα ε 

«βνήζεηα» βξίζθεηαη ζε αλακνλή. Όηαλ ν καζεηήο βξεζεί κπξνζηά ζε θάπνηα δπζθνιία, ζα 

πξέπεη ν θαζνδεγεηήο λα ηνπ δψζεη θαηάιιειε βνήζεηα ψζηε λα μεπεξαζηεί ην πξφβιεκα. 
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Απηφο απνθαζίδεη ην είδνο θαη ηνλ βαζκφ θαη ην πεξηερφκελν αλάδξαζεο πνπ ζα παξαζρεζεί 

ζην καζεηή.  

5.5.1.4 Μνληέιν εηδηθνύ 

 

Σν κνληέιν εηδηθνχ είλαη φκνην κε ηελ πεξηνρή ηεο γλψζεο κε ηελ έλλνηα φηη πξέπεη λα παξέρεη ηελ 

πιεξνθνξία πνπ πξφθεηηαη λα δηδαρζεί. Χζηφζν ην κνληέιν εηδηθνχ είλαη έλα κνληέιν γηα ην πψο 

θάπνηνο εηδηθφο ζε έλαλ ζπγθεθξηκέλν ηνκέα αλαπαξηζηά ηε γλψζε (Γξακηηηλφο & Ραμελίδεο, 1999),  

γηα παξάδεηγκα κπνξεί λα αλαπαξηζηά ηελ ηθαλφηεηα επίιπζεο πξνβιεκάησλ ζε έλαλ ζπγθεθξηκέλν 

ηνκέα (Clancey & Letsinger, 1981). Με ηε ρξεζηκνπνίεζε ελφο εηδηθνχ κνληέινπ, ν δάζθαινο κπνξεί 

λα ζπγθξίλεη ηε ιχζε ηνπ καζεηή κε ηε ιχζε ησλ εηδηθψλ, επηζεκαίλνληαο ηηο ζέζεηο φπνπ ν καζεηήο 

είρε ηηο δπζθνιίεο. 

Θα επηκείλσ ιίγν ζην Παηδαγσγηθφ Μνληέιν θαη απηφ γηαηί απηφ ρξεζηκνπνηεί ηηο πιεξνθνξίεο απφ 

ην πξφηππν καζεηή γηα λα θαζνξίζεη πνηεο  πηπρέο ηεο γλψζεο ζεκαηηθψλ  πεξηνρψλ πξέπεη λα 

παξνπζηαζηνχλ ζηνλ καζεηή. Μηα παηδαγσγηθή αλεζπρία είλαη ν ηξφπνο επηινγήο (meta-strategy) ηεο 

ζηξαηεγηθήο  γηα ηελ δηδαζθαιία ηεο ζεκαηηθή πεξηνρήο. Μφιηο επηιερηεί ε ζηξαηεγηθή, ηα ρακεινχ 

επηπέδνπ δεηήκαηα, φπσο ην αθξηβέο παξάδεηγκα ζηε ρξήζε, πξέπεη λα απνθαζηζηνχλ.  

 

5.5.1.5 Μνληέιν Δπηθνηλσλίαο 

Σν κνληέιν απηφ αζρνιείηαη κε ζέκαηα πνπ ζρεηίδνληαη κε ηελ επηθνηλσλία  ηνπ καζεηή κε ην 

ζχζηεκα. Έρεη λα θάλεη κε ηελ αιιειεπίδξαζε (interaction) ηνπ καζεηή κε ην ζχζηεκα θαζψο θαη ην 

ζρεδηαζκφ ηεο δηεπηθάλεηαο ρξήζεο ηνπ ζπζηήκαηνο. Σα ζπζηήκαηα ζρεδηάδνληαη θαη 

επαλαζρεδηάδνληαη ψζηε λα είλαη θηιηθά πξνο ην ρξήζηε.  

5.6 ΢πλεξγαηηθή κάζεζε θαη Σερλεηή Ννεκνζύλε 

Ζ ζπλεξγαηηθή κάζεζε αλαθέξεηαη ζηνπο καζεηέο πνπ εξγάδνληαη θαηά νκάδεο γηα λα ιχζνπλ έλα 

πξφβιεκα. Απηά ηα πεξηβάιινληα έρνπλ απνδεηρζεί φηη επλννχλ ηε γλψζε θαη ηελ αιιειεπίδξαζε 

(Webb, 1982). Με ηελ επηινγή απηήο ηεο κεζφδνπ ε αιιειεπίδξαζε δελ πεξηνξίδεηαη κφλν κεηαμχ 

ηνπ δαζθάινπ θαη ησλ καζεηψλ αιιά θαη κεηαμχ καζεηή κε άιινλ ή άιινπο καζεηέο δεδνκέλνπ φηη 

νη καζεηέο κπνξνχλ λα δηδάμνπλ ν έλαο ηνλ άιινλ ρσξίο ηελ παξεκβνιή ηνπ δαζθάινπ. ΢ηελ 

πεξίπησζε πνπ κειεηνχκε αλαθεξφκαζηε ζηνπο καζεηέο πνπ εξγάδνληαη καδί, κε ηελ βνήζεηα ηνπ 

ΔΓ΢ κέζσ ελφο δηθηχνπ ππνινγηζηψλ. Δπεηδή θαη άιινη καζεηέο πεξηιακβάλνληαη ζηελ δηδαζθαιία, ε 

ινγηθή ηνπ ΔΓ΢ πξέπεη λα είλαη απιή έηζη ψζηε εάλ ε νδεγία δελ είλαη ηέιεηα θαη βξεζεί έλαο 

ζπνπδαζηήο λα έρεη απνξίεο λα κπνξεί έλαο άιινο ζπνπδαζηήο λα βνεζήζεη ρσξίο ηε κεζνιάβεζε 

βνήζεηαο απφ ην ΔΓ΢. 
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5.7 Δπθπήο πξάθηνξεο 

Έλαο πξάθηνξαο ραξαθηεξίδεηαη σο επθπήο αλ κπνξεί λα θαηαιαβαίλεη ηη γίλεηαη ζην πεξηβάιινλ ηνπ 

κε ηε βνήζεηα εηδηθψλ αηζζεηήξσλ θαη λα ελεξγεί θαηάιιεια ζε απηφ. Γηα παξάδεηγκα έλαο 

αηζζεηήξαο βξνρήο είλαη έλαο πξάθηνξαο πνπ εθηειεί ζπγθεθξηκέλε εξγαζία, αληρλεχεη ηελ χπαξμε 

πγξαζίαο ζε κεηαιιηθέο πιάθεο (αηζζεηήξα) θαη κφιηο ε πγξαζία πεξάζεη έλα ζπγθεθξηκέλν θαηψθιη 

ελεξγνπνηεί έλα 2
ν
 θχθισκα πνπ ελεκεξψλεη γηα ηελ χπαξμε βξνρήο – πγξαζίαο ζην ρψξν πνπ 

επηηεξεί.  Αληίζηνηρα έλαο πξάθηνξαο ινγηζκηθνχ έρεη σο αηζζεηήξεο θαη σο ελέξγεηεο κηα ζεηξά 

εληνιψλ. Έλα παξάδεηγκα ινγηζκηθνχ πξάθηνξα κπνξεί λα ζεσξεζεί ε δηεξγαζία πνπ ηξέρεη ζηνπο 

ππνινγηζηέο γηα ηελ πξνζηαζία ηνπ κεραλήκαηνο απφ ηνπο ηνχο. Σξέρνληαο ζπγθεθξηκέλν θψδηθα 

παξαθνινπζεί ην ζχζηεκα θαη αλ νη «αηζζεηήξεο ηνπ» αληηιεθζνχλ θάπνηα παξάμελε ζπκπεξηθνξά 

ελεκεξψλνπλ ηνλ ρξήζηε ή δξνπλ κφλε ηνπο κε νδεγφ κηα βάζε δεδνκέλσλ πνπ θαζνδεγεί ηε δξάζε 

αλάινγα κε ηελ πεξίπησζε ηεο εηζβνιήο. 

5.8 Ο ξόινο ησλ κνληέισλ ζηελ Σ.Ν. θαη ηελ εθπαίδεπζε 

 

Τπάξρνπλ ηξεηο θχξηνη ξφινη γηα ηα πξφηππα ησλ εθπαηδεπηηθψλ δηαδηθαζηψλ ζηελ έξεπλα AIED 

(Artificial Intelligence in Education) , φπσο παξνπζηάδεηαη ζηεο εηθφλα 5.2.  

Οη ηξεηο ξφινη ησλ πξνηχπσλ είλαη νη αθφινπζνη: 

1. Πξόηππν σο επηζηεκνληθό εξγαιείν. Έλα πξφηππν - ππνινγηζηηθφ ή άιιν ρξεζηκνπνηείηαη σο 

κέζν θαηαλφεζεο κηαο εθπαηδεπηηθήο θαηάζηαζεο. Παξαδείγκαηνο ράξηλ, ε πξνζνκνίσζε ελφο 

θπζηθνχ θαηλνκέλνπ.  

2. Πξόηππν σο ζπζηαηηθό. Έλα ππνινγηζηηθφ πξφηππν, πνπ αληηζηνηρεί ζε θάπνην ζέκα πνπ πξέπεη 

λα δηδαρηεί ή λα ζπκβάιεη ζηελ κάζεζεο κηαο δηαδηθαζίαο, ρξεζηκνπνηείηαη σο ζπζηαηηθφ ελφο 

εθπαηδεπηηθνχ αληηθεηκέλνπ. Γηα ην παξάδεηγκα, έλα ππνινγηζηηθφ/γλσζηηθφ πξφηππν γηα ηελ 

επίιπζε πξνβιεκάησλ απφ ηνπο  ζπνπδαζηέο , ην νπνίν είλαη ελζσκαησκέλν ζε έλα καζεζηαθφ 

πεξηβάιινλ γηα ππνινγηζηή σο πξφηππν καζεηψλ (Student model). Απηφ επηηξέπεη ην ζχζηεκα λα 

πξνζαξκνζηεί ηηο δηδαθηηθέο δηαδηθαζίεο ηνπ εθπαηδεπφκελνπ αλάινγα κε ηε  γλψζε θαη 

δεμηφηεηεο ηνπ.  

3. Πξόηππν σο βάζε γηα ζρεδηαζκό. Έλα πξφηππν εθπαηδεπηηθψλ δηαδηθαζηψλ, κε ηε ζπλνδεπηηθή 

ζεσξία ηνπ, απνηειεί ηε βάζε γηα ην ζρεδηαζκφ ελφο εξγαιείνπ ησλ ππνινγηζηψλ  γηα ηελ 

εθπαίδεπζε. Παξαδείγκαηνο ράξηλ, ην πξφηππν ηνπ πξνζαλαηνιηζκέλνπ δηαιφγνπ γηα εξγαζία 

(chat room εξγαζίαο) απνηειεί ηε βάζε ζρεδίνπ θαη ηελ εθαξκνγή εξγαιείσλ γηα ηε κέζσ 

ππνινγηζηή επηθνηλσλία κεηαμχ ζπνπδαζηψλ θαη δαζθάισλ κέζα ζε έλα ζπλεξγαηηθφ καζεζηαθφ 

πεξηβάιινλ (π.ρ. Baker & Lund, 1999).  
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Δηθφλα 5.2: Οη 3 ξφινη ησλ κνληέισλ ζην AIED 

 
As is well known, one of the golden rules of such diagrams in (AI)ED research is that the meaning of the arrows 

must be clearly specified. The precise meaning of the arrows in the above diagram is in fact the principal subject 

of the rest of this paper. Briefly, and for the present, their meaning is as follows: (a) mutual adjustment between 

theory and model ; theory elaboration gives rise to model extension and vice-versa; (b) validation of a model 

with respect to an experimental field often leads to modification of the model ; (c) an educational system is 

'based on' a theory/model (see § 5 below) ; evaluation of the system may lead to theory/model revision ; (d) 

incorporation of a computational model as a component of a computer-based educational system ; system 

evaluation leads to model extension. 

 

 

5.8.1 Σύπνη ησλ e-learning ζπζηεκάησλ αλάινγα κε ηνλ ξόιν ηνπ 

«δαζθάινπ» 

Σα ζχγρξνλα ζπζηήκαηα e-learning αιιάδνπλ ην ξφιν ελφο δαζθάινπ απφ έλα πξφζσπν πνπ δίλεη 

δηαιέμεηο , κε κηα δηδαθηηθή κνξθή ,νηθνδηδάζθαιν, θαζνδεγεηή,  πνπ ππνζηεξίδεη ηνπο καζεηέο ζηε 

δηαδηθαζία κάζεζήο ηνπο (αζχγρξνλεο θαη ζχγρξνλεο αιιειεπηδξάζεηο κεηαμχ ελφο δαζθάινπ θαη ησλ 

καζεηψλ). Δίλαη δπλαηφ λα δηαθξηζνχλ δχν είδε  «δαζθάινπ» ζηα e-learning  ζπζηήκαηα:  

 αλζξψπηλνο δάζθαινο θαη 

 δάζθαινο ππνινγηζηήο. 
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5.8.1.1 E-learning ζύζηεκα κε αλζξώπηλν θαζνδεγεηή ( human tutor) 

Ο αλζξψπηλνο θαζνδεγεηήο (tutor) ππνζηεξίδεη ηνπο εθπαηδεπφκελνπο ζηε δηαδηθαζία κάζεζεο κε 

αιιειεπίδξαζε ρξεζηκνπνηψληαο ζχγρξνλνπο θαη αζχγρξνλνπο ηξφπνπο. Ζ πεξηνρή γλψζεσλ ηνπ 

αληηθεηκέλνπ θαζψο θαη  ε γλψζε ηεο ηερλνινγίαο είλαη ζεκαληηθέο γηα ηνλ αλζξψπηλν θαζνδεγεηή 

ψζηε λα δηεπθνιχλεη ηε δηαδηθαζία κάζεζεο. Ο θαζνδεγεηήο  ρξεζηκνπνηεί ηα αζχγρξνλα θαη 

ζχγρξνλα εξγαιεία γηα λα επηθνηλσλεί κε ηνπο εθπαηδεπφκελνπο. Σα ζχγρξνλα εξγαιεία επηηξέπνπλ 

άκεζε αλαηξνθνδφηεζε. Σα αζχγρξνλα εξγαιεία είλαη πνιχ θαιά γηα εμαηνκηθεπκέλε κάζεζε εηδηθά 

φηαλ ππάξρνπλ θαη δηαθνξέο ζηελ ψξαο θαη επηηξέπνπλ αλαηξνθνδφηεζε.  

5.8.1.2 ΢ύζηεκα πνπ ρξεζηκνπνηεί «ξνκπόη» γλώζεο (knowbots) 

Οη επαλαιακβαλφκελεο εηζεγήζεηο ησλ αλζξψπηλσλ βνεζψλ κπνξνχλ λα απηνκαηνπνηεζνχλ κε ηελ 

ρξήζε ησλ επθπψλ ηερληθψλ πξαθηφξσλ. Σν Knowbots (ξνκπφη γλψζεο) είλαη επθπείο πξάθηνξεο 

ινγηζκηθνχ πνπ ρξεζηκνπνηνχληαη ζηηο online ζεηξέο καζεκάησλ θαη κηκνχληαη ηελ αλζξψπηλε ζρέζε. 

Σα Knowbots ρξεζηκνπνηνχλ ηερληθέο επθπψλ πξαθηφξσλ. Σνπνζεηνχληαη κεηαμχ ηνπ 

εθπαηδεπφκελνπ θαη ηνπ δαζθάινπ/βνεζνχ, θαη επηηξέπνπλ  ηελ αιιειεπίδξαζε. 

5.8.1.3 Τβξηδηθά ζπζηήκαηα 

Δίλαη ζπλδπαζκφο e-learning κε θαζνδεγεηέο αλζξψπνπο θαη knowbots. Υξεζηκνπνηνχλ knowbots  

γηα ηελ απηνκαηνπνίεζε ησλ επαλαιακβαλφκελσλ εξγαζηψλ  πνπ εθηεινχληαη απφ ηνπο αλζξψπηλνπο 

βνεζνχο, κε ηελ ρξήζε ησλ επθπψλ πξαθηφξσλ. Ο αλζξψπηλνο δάζθαινο κπνξεί λα επηθνηλσλήζεη κε 

ηνπο εθπαηδεπφκελνπο κε ηελ ρξήζε ησλ αζχγρξνλσλ θαη ζχγρξνλσλ εξγαιείσλ επηθνηλσλίαο. 

5.8.1.4 Δπθπήο ΢πζηήκαηα Γηδαζθαιίαο 

Έλα επθπέο ζχζηεκα δηδαζθαιίαο  πνπ ρξεζηκνπνηεί ηερλεηή λνεκνζχλε, δηεπθνιχλεη ηε δηαδηθαζία 

κάζεζεο κε ηε ζπλερή πξνζαξκνγή ηνπ ζηηο ηδηαίηεξεο αλάγθεο θαη ηα ελδηαθέξνληα ησλ 

εθπαηδεπφκελσλ θαηά ηε δηάξθεηα ηεο δηαδηθαζίαο ηεο κάζεζεο. Ζ λνεκνζχλε ελφο ηέηνηνπ 

ζπζηήκαηνο πεξηιακβάλεη  παηδαγσγηθέο απνθάζεηο ηεο, πψο θαη ηη λα δηδάμεη, θαη  πιεξνθνξίεο γηα 

ηνπο εθπαηδεπφκελνπο. Ζ εηθφλα 5.3 παξνπζηάδεη ηελ έλλνηα ελφο ηέηνηνπ ζπζηήκαηνο ζχκθσλα κε 

IEEE LTSC ηα πξφηππα. 
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Δηθφλα 5.3: ITS (Intelligent Teaching System) 

 

5.9 Υξήζε ηεο Σ. Ν. ζηηο Φπζηθέο επηζηήκεο  

΢ην δηαδίθηπν ππάξρεη πιεζψξα πεγψλ γηα ηελ ρξήζε ηεο ηερλεηήο λνεκνζχλεο ζηελ εθπαίδεπζε. Σν 

ελδηαθέξνλ καο ζα εζηηαζηεί ζηελ ρξήζε ηεο ηερλεηήο λνεκνζχλεο ζηηο θπζηθέο επηζηήκεο θαη ζηελ 

ππνινγηζηηθή θπζηθή. 

Θα παξαζέζσ ελδεηθηηθά κεξηθέο απφ ηηο πεγέο πνπ βξήθα ζην δηαδίθηπν ηφζν γηα ηελ ρξήζε ηεο ΣΝ 

ζηελ εθπαίδεπζε φζν θαη ζηηο θπζηθέο επηζηήκεο:   

 http://ai.usask.ca/ARIES_Publications 

 http://citeseerx.ist.psu.edu/viewdoc/summary?doi=10.1.1.55.8705 

 http://www.springerlink.com/content/553kfp693n6tmpde/ 

 http://aied.inf.ed.ac.uk/abstract/Vol_15/VanLehn05.html 

 http://ieeexplore.ieee.org/Xplore/login.jsp?url=/iel4/6005/16054/00744857.pdf?isnumber=160

54&prod=CNF&arnumber=744857&arSt=296&ared=301&arAuthor=Hsu%2C+J.Y.-

J.%3B+Chien-Jung+Ting 

 http://nr.stpi.org.tw/ejournal/proceedingD/v10n3/126-136.pdf 

 http://www.iop.org/EJ/abstract/0143-0807/7/1/005 
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6 ΔΠΗΛΤ΢Ζ ΠΡΟΒΛΖΜΑΣΧΝ ΣΧΝ ΦΤ΢ΗΚΧΝ 

ΔΠΗ΢ΣΖΜΧΝ ΜΔ ΥΡΖ΢Ζ Ζ/Τ (κε ηε βνήζεηα ηεο 

ππνινγηζηηθήο θπζηθήο) 

6.1 Δηζαγσγή 

Ζ ππνινγηζηηθή επηζηήκε εξεπλά κνληέια πνπ θαηαιαβαίλεη, απφ ην θπζηθφ θαη ηνλ ηερλεηφ θφζκν, 

κε ζθνπφ ηελ εθ βάζνπο θαηαλφεζή ηνπο. Δίλαη έλαο ζχγρξνλνο ηνκέαο ζηνλ νπνίν νη ππνινγηζηέο 

ρξεζηκνπνηνχληαη γηα λα επηιχζνπλ πξνβιήκαηα ησλ νπνίσλ ε δπζθνιία ή ε πνιππινθφηεηα ηα 

ηνπνζεηεί πέξα απφ ηελ αλαιπηηθή ιχζε ή ηελ αλζξψπηλε αληνρή. Άιιεο θνξέο ν ππνινγηζηήο 

ρξεζηκεχεη σο κηα κεραλή ππέξ-ππνινγηζκνχ, άιιεο θνξέο σο εξγαζηήξην γηα αξηζκεηηθέο 

πξνζνκνηψζεηο πνιπζχλζεησλ ζπζηεκάησλ θαη άιιεο θφξεο ζπλδπάδνληαο ηηο δχν παξαπάλσ 

ρξήζεηο.  

Έλαο «ππνινγηζηηθφο» επηζηήκνλαο πξέπεη λα έρεη πνιχπιεπξε γλψζε γηα λα είλαη επηηπρεκέλνο, θαη 

επεηδή  ηα ίδηα εξγαιεία ρξεζηκνπνηνχληαη γηα πνιιά πξνβιήκαηα θαη ζε δηαθνξεηηθνχο ηνκείο δελ ζα 

πξέπεη λα πεξηνξίδεηαη ζε κηα κφλν πεξηνρή εηδίθεπζεο.  

Παξαδνζηαθά, ε θπζηθή δηαηξείηαη ζε πεηξακαηηθέο θαη ζεσξεηηθέο πξνζεγγίζεηο. Ζ ππνινγηζηηθή 

θπζηθή απαηηεί δεμηφηεηεο θαη απφ ηηο δχν θαη ζπλεηζθέξεη θαη ζηηο δχν. Ο κεηαζρεκαηηζκφο κηαο 

ζεσξίαο ζε έλαλ αιγφξηζκν απαηηεί ζεκαληηθή ζεσξεηηθή δηνξαηηθφηεηα, ιεπηνκεξή θπζηθή θαη 

καζεκαηηθή θαηαλφεζε, θαη θπξίσο ηελ ηερληθή ηνπ πξνγξακκαηηζκνχ. Ζ απνζθαικάησζε, ε δνθηκή, 

θαη νξγάλσζε ησλ επηζηεκνληθψλ πξνγξακκάησλ είλαη ζαλ κηα «θπζηθή» εθηέιεζε πεηξάκαηνο. 

Οη πξνζνκνηψζεηο ηεο θπζηθήο κε πξνγξάκκαηα νλνκάδνληαη «εηθνληθά πεηξάκαηα» θαη 

πξαγκαηνπνηνχληαη ζε «εηθνληθά εξγαζηήξηα». Καζ’ φιε ηε δηαδηθαζία, ε ζχλζεζε ησλ αξηζκψλ, νη 

γεληθεχζεηο, νη πξνβιέςεηο, θαη ηα ζπκπεξάζκαηα απαηηνχλ ηε δηνξαηηθφηεηα θαη ηε δηαίζζεζε ηφζν 

ηεο πεηξακαηηθήο φζν θαη ηεο ζεσξεηηθήο επηζηήκεο.  

6.2 Ο Ρόινο ηεο ππνινγηζηηθή επηζηήκεο 

Έλαο ππνινγηζηηθφο επηζηήκνλαο  δηαηππψλεη θαη πξνγξακκαηίδεη ηε ιχζε ελφο πξνβιήκαηνο 

ρξεζηκνπνηψληαο ηνλ ππνινγηζηή θαη ηηο βηβιηνζήθεο θάπνηνπ πξνγξάκκαηνο  ζαλ λα πξφθεηηαη γηα 

εξγαζία κε πξαγκαηηθνχο ζπλεξγάηεο.  Ζ εξγαζία απνηειείηαη απφ  αλαιπηηθέο θαη αξηζκεηηθέο 

πξνφδνπο πνπ έγηλαλ θαηά ην παξειζφλ, πεξηιακβάλεη φια ηα ζηάδηα ηεο πξνεγνχκελεο εξγαζίαο, θαη 

εηζέξρνληαη ζε απηήλ λέεο αλαιπηηθέο θαη αξηζκεηηθέο κειέηεο.  

΢ε κηα δηαθνξεηηθή, αιιά επίζεο θιαζηθή επηζηεκνληθή πξνζέγγηζε, νη ππνινγηζηέο δηαδξακαηίδνπλ 

ηνλ βαζηθφηεξν ξφιν ζηελ πξνζνκνίσζε  ησλ λφκσλ ηεο θχζεο. ΢ε απηέο ηηο πξνζνκνηψζεηο, ν 

ππνινγηζηήο απνθξίλεηαη ζηα δεδνκέλα εηζφδνπ σο έλα θπζηθφ ζχζηεκα θάησ απφ δηαθνξεηηθέο 

ζπλζήθεο θάζε θνξά πνπ ηνπ δεηείηαη. Έλα παξαδείγκαηα είλαη ε αλίρλεπζε απφ πιεπξάο ππνινγηζηή 
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ησλ θπκάησλ κέζσ νπηηθνχ ζπζηήκαηνο θαη ε αξηζκεηηθή παξαγσγή ηπραίσλ αξηζκψλ γηα κίκεζε ηεο 

ξαδηελεξγνχο απνζχλζεζε ησλ ππξήλσλ.  

Μηα άιιε ζχγρξνλε ρξήζε ησλ ππνινγηζηψλ είλαη ε δεκηνπξγία θαηάιιεινπ πεξηβάιινληνο επίιπζεο 

πξνβιήκαηνο, φπσο Mathematica, Macsyma, θαη ην Matlab, ηα νπνία «θξχβνπλ» ηηο  πεξηζζφηεξεο 

ιεπηνκέξεηεο απφ ην ρξήζηε, θαη ρξεζηκνπνηνχλ ζπρλά ζπκβνιηθνχο ρεηξηζκνχο ζαλ λα είρε γίλεη 

αλαιπηηθά ε δηαδηθαζία.  

Μηα απφ ηηο πην ζεκαληηθέο ρξήζεηο ησλ ππνινγηζηψλ είλαη ε απεηθφληζε – νπηηθνπνίεζε ησλ 

απνηειεζκάησλ ησλ ππνινγηζκψλ κε δηζδηάζηαηα θαη ηξηζδηάζηαηα ζρεδηαγξάκκαηα , γξαθήκαηα ή 

εηθφλεο θαη κεξηθέο θνξέο κε ρξσκαηηθή ζθίαζε θαη θηλνχκελε εηθφλα. Απηφ βνεζά ηε δηαδηθαζία 

απνζθαικάησζεο , αλάπηπμε ηεο θπζηθήο θαη καζεκαηηθήο δηαίζζεζεο, θαη ηέινο ζηελ απφιαπζε ηεο 

εξγαζία.  

6.2.1 Πεξηβάιινλ Τπνινγηζηή 

Πάληα πξέπεη λα ιακβάλνπκε ππφςε φηη νη ππνινγηζηέο θάλνπλ αθξηβψο φηη ηνπο «πνχκε ». Απηφ 

ζεκαίλεη φηη πξέπεη λα ηνπο πνχκε αθξηβψο φια φζα πξέπεη λα θάλνπλ. Φπζηθά, ηα πξνγξάκκαηα πνπ 

γξάθνπκε κπνξνχλ λα πεξηπιερηνχλ έηζη ψζηε λα ππάξρνπλ πνιιέο ινγηθέο ελαιιαθηηθέο πνξείεο. 

 Πξνηνχ πνχκε ζηνλ ππνινγηζηή ηη πξέπεη λα θάλεη  πξέπεη λα θαηαλνήζνπκε φηη ε «δσή» θαη γηα ηνπο 

ππνινγηζηέο δελ είλαη απιή. Οη νδεγίεο πνπ θαηαιαβαίλνπλ είλαη ζε γιψζζα κεραλήο θαη απηέο  

θαζνδεγνχλ ην πιηθφ λα θάλεη θάπνηα πξάγκαηα φπσο ηελ κεηαθνξά ελφο αξηζκνχ, απφ κία ζέζε 

κλήκεο πνπ είλαη απνζεθεπκέλνο ζε κηα άιιε ζέζε, ή λα θάλνπλ θάπνηα απιή δπαδηθή πξάμε. Καηά 

ην γξάςηκν θαη ηελ εθηέιεζε ησλ πξνγξακκάησλ, κηιάκε ζπλήζσο ζηνλ ππνινγηζηή κέζσ ηνπ 

θειχθνπο ηνπ ή κέζσ πςεινχ επηπέδνπ γισζζψλ.  Οη εληνιέο ζε απηήλ ηελ πεξίπησζε βξίζθνληαη 

πην θνληά ζηελ αλζξψπηλε ινγηθή θαη γιψζζα. Ο ππνινγηζηήο απφ κεξηάο ηνπ γηα ηηο θαηαιάβεη ηηο 

κεηαθξάδεη ζε γιψζζα κεραλήο. Φπζηθά ηα απνηειέζκαηα πνπ βγάδεη είλαη θαη απηά ζε γιψζζα 

κεραλήο ηα νπνία κεηαηξέπνληαη ζε ζχκβνια – γιψζζα θαηαλνεηή γηα ηνλ εξεπλεηή. 

Σν ίδην ην ιεηηνπξγηθφ ζχζηεκα είλαη κηα νκάδα πξνγξακκάησλ πνπ ιέεη ζηνλ ππνινγηζηή ηη λα θάλεη 

κε έλαλ ζηνηρεηψδε ηξφπν. «Βιέπεη» ην ρξήζηε, ηηο πεξηθεξεηαθέο ζπζθεπέο θαη ηα πξνγξάκκαηα σο 

δεδνκέλα εηζφδνπ γηα επεμεξγαζία. ΢ηα πξνγξάκκαηα ζπγθαηαιέγνληαη θαη νη γιψζζεο 

πξνγξακκαηηζκνχ. Με απηέο κπνξνχκε λα «θαζνδεγνχκε» ηνλ ππνινγηζηή πρ. λα ηνπ ιέκε ηη πξέπεη 

λα θάλεη κε ηα δεδνκέλα πνπ ηνπ εηζάγνπκε θαη πσο ζα εκθαλίδεη ηα απνηειέζκαηα θαη πνπ ζα ηα 

απνζεθεχεη. 

6.2.2 Γιώζζεο πξνγξακκαηηζκνύ 

Γχζθνια κπνξνχλ λα θαηεγνξηνπνηεζνχλ νη γιψζζεο πξνγξακκαηηζκνχ θαη απηφ γηαηί έρνπλ 

επηξξνέο ε κία απφ ηελ άιιε. ΢πλήζσο φηαλ δεκηνπξγείηαη κία λέα γιψζζα θξαηά φια ηα ζεηηθά 
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ζηνηρεία πνπ έρεη θάπνηα πξνεγνχκελε θαη πξνζζέηνληαη λέα γηα παξάδεηγκα C θαη C++ ή C++ θαη 

Java.  

Έηζη έλαο ηξφπνο δεκηνπξγίαο θαηεγνξηψλ ζηηο γισζζψλ πξνγξακκαηηζκνχ είλαη :  

 κε βάζε ηνλ ηξφπν νξγάλσζεο ηνπ πξνγξάκκαηνο, εδψ αλήθνπλ νη δηαδηθαζηηθέο γιώζζεο 

(procedural) φπνπ ην πξφγξακκα είλαη δνκεκέλν πάλσ ζε δηαδηθαζίεο (C, Pascal), νη 

αληηθεηκελνζηξαθείο γιώζζεο (object-oriented) φπνπ ην πξφγξακκα είλαη δνκεκέλν πάλσ 

ζε αληηθείκελα πνπ αιιειεπηδξνχλ κεηαμχ ηνπο (C++,Java) θαη νη νη ζπλαξηεζηαθέο 

γιώζζεο (functional) φπνπ εδψ νη ππνινγηζκνί εθθξάδνληαη σο εθαξκνγέο καζεκαηηθψλ 

ζπλαξηήζεσλ (Lisp). 

 κε βάζε ηνλ ζηφρν πνπ έρεη ε γιψζζα, εδψ αλήθνπλ νη αληηθεηκελνζηξαθείο γιώζζεο 

(object-oriented) φπνπ εδψ αλήθνπλ νη γιώζζεο εηδηθώλ εθαξκνγώλ φπσο ην Matlab πoπ 

είλαη ζρεδηαζκέλε γηα ηελ επεμεξγαζία πηλάθσλ απφ αξηζκεηηθά δεδνκέλα, νη παξάιιειεο ή 

θαηαλεκεκέλεο γιώζζεο πνπ δίλνπλ ηελ δπλαηφηεηα αλάπηπμεο παξάιιεισλ πξνγξακκάησλ 

(θαη ζε απηή ηε θαηεγνξία αλήθεη ε Java) 

 κε βάζε ηνλ ηξφπν πνπ πεξηγξάθνπλ ην δεηνχκελν απνηέιεζκα , εδψ αλήθνπλ νη 

πξνζηαθηηθέο θαη νη δεισηηθέο γιψζζεο πξνγξακκαηηζκνχ. Γιψζζεο πνπ πεξηγξάθνπλ ην 

δεηνχκελν κέζα απφ ζεηξά εληνιψλ (C++,Java) ή πεξηγξάθνπλ ην επηζπκεηφ απνηέιεζκα κε 

ρξήζε ησλ ηδηνηήησλ θαη φρη ηνπ ππνινγηζκνχ (SQL ,Prolog).  

Μία γιψζζα πξνγξακκαηηζκνχ απνηειείηαη απφ : 

 ηνλ Μεηαγισηηηζηή( Compiler ) 

o Δδψ ν κεηαγισηηηζηήο δέρεηαη ζηελ είζνδφ ηνπ ηνλ πεγαίν θψδηθα  (source program ) 

ηεο γιψζζαο πξνγξακκαηηζκνχ θαη αθνχ ειέγμεη γηα ζπληαθηηθά ή ινγηθά ιάζε 

παξάγεη θψδηθα ηζνδχλακν αιιά ζε γιψζζα κεραλήο.  

 Πεγαίν πξόγξακκα (Source program) 

o Δίλαη γξακκέο θψδηθα πνπ πεξηέρεη εληνιέο, αξρηθνπνηήζεηο ησλ κεηαβιεηψλ,  

θιάζεηο, κεζφδνπο θαη δηαδηθαζίεο. Γξάθεηαη κε ηελ βνήζεηα ελφο ζπληάθηε 

πξνγξάκκαηνο (editor)  

 Αληηθείκελν πξόγξακκα (object program) 

o Δίλαη ην πξφγξακκα, πνπ παξάγεηαη κεηά ηε κεηαγιψηηηζε ηνπ πεγαίνπ θψδηθα. 

Πεξηέρεη ηηο απαξαίηεηεο βηβιηνζήθεο γηα ηελ εθηέιεζε ηνπ πξνγξάκκαηνο αιιά παξά 

ηνπ φηη είλαη ζε θαηαλνεηή κνξθή γηα ηνλ ππνινγηζηή δελ βξίζθεηαη αθφκε ζε 

εθηειέζηκε κνξθή. Υξεηάδεηαη ν linker – ζπλδέηεο πνπ εηζάγεη ηηο βηβιηνζήθεο 

εθηέιεζεο ηνπ πξνγξάκκαηνο 
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 Δθηειέζηκν (Executable program) 

o Δίλαη ε ηειηθή «κνξθή» ηνπ πξνγξάκκαηνο ην νπνίν εθηειείηαη απφ ηνλ ππνινγηζηή. 

 Γηεξκελεπηήο  (Interpreter ) 

o ΢ε φπνηα γιψζζα ππάξρεη , δηαβάδεη ηηο εληνιέο κηα πξνο κία ειέγρεη ηελ ζχληαμή ηεο 

ηελ κεηαθξάδεη ζε εληνιέο γιψζζαο κεραλήο θαη ηηο «ηξέρεη».  

Σα ζπληαθηηθά ιάζε δηαπηζηψλνληαη ζην ζηάδην ηεο κεηαγιψηηηζεο ελψ ηα ινγηθά ιάζε ζην ζηάδην 

ηεο εθηέιεζε. Σα ινγηθά ιάζε είλαη ηα πην ζεκαληηθά ιάζε θαη ηα πην δχζθνια θαηά ηελ δηφξζσζε. 

Σα ζπληαθηηθά ζπλήζσο νθείινληαη ζε νξζνγξαθηθά ιάζε ή παξαιήςεηο αιιά νη ζχγρξνλνη editors 

θαηά ηελ πιεθηξνιφγεζε ηνπ θψδηθα καξθάξνπλ ηηο ιάζνο εληνιέο ή θαηά ηελ  κεηαγιψηηηζε 

ελεκεξψλνπλ ζε πηα γξακκή ππάξρεη ιάζνο γξακκέλε κεηαβιεηή. 

Οη γιψζζεο πξνγξακκαηηζκνχ πνπ ρξεζηκνπνηήζεθαλ ζηελ δηπισκαηηθή εξγαζία θαη είλαη γηα 

επηζηεκνληθή ρξήζε είλαη νη παξαθάησ: 

FORTRAN (Formula Translation) :Ηδαληθή ε ρξήζε ηεο γηα επίιπζε καζεκαηηθψλ ή επηζηεκνληθψλ 

πξνβιεκάησλ.  

C, C++: Αληηθεηκελνζηξαθείο γιψζζεο. Καηάιιειεο γηα ηελ αλάπηπμε δνκεκέλσλ εθαξκνγψλ θαη κε 

δπλαηφηεηεο γιψζζαο ρακεινχ επηπέδνπ.  

JAVA: Αληηθεηκελνζηξαθήο γιψζζα. Δίλαη θαηάιιειε γηα εθαξκνγέο πνπ εθηεινχληαη ζε 

θαηαλεκεκέλα πεξηβάιινληα φπσο δίθηπα ή ππνινγηζηέο πνπ ρξεζηκνπνηνχλ δηαθνξεηηθφ ιεηηνπξγηθφ 

ζχζηεκα θαη γηα ην Γηαδίθηπν. 
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6.3 Παξαδείγκαηα ππνινγηζηηθήο επηζηήκεο ζηηο Φ.Δ. 
Σκήκαηα απφ ηνπο θψδηθεο είλαη απφ ηα βηβιία ησλ Hjorth-Jensen  θαη Landau (βιέπε βηβιηνγξαθία) 

6.3.1 Σν πξόβιεκα : A RANDOM WALK 

Τπάξρνπλ πνιιέο θπζηθέο δηαδηθαζίεο, φπσο ε θίλεζε ηνπ BROWN θαη ε κεηαθνξά ειεθηξνλίσλ 

κέζσ ησλ κεηάιισλ, ζηα νπνία έλα κφξην εκθαλίδεηαη λα θηλείηαη ηπραία. Παξαδείγκαηνο ράξηλ, 

εμεηάζηε έλα άηνκν αξψκαηνο πνπ απειεπζεξψλεηαη ζηε κέζε κηαο ηάμεο. ΢πγθξνχεηαη ηπραία κε 

άιια άηνκα ζηνλ αέξα θαη θζάλεη ηειηθά ζηε κχηε ηνπ εθπαηδεπηηθνχ. Σν πξφβιεκα είλαη λα 

θαζνξηζηεί πφζεο ζπγθξνχζεηο, θαηά κέζνλ φξν, ην άηνκν πξέπεη λα θάλεη γηα λα ηαμηδέςεη - δηαλχζεη 

κηα αθηηλσηή απφζηαζε αθηίλαο R. Ζ ζρεκαηηθή αλαπαξάζηαζε ηνπ παξαπάλσ είλαη : 

 

Δηθφλα 6.1 : Random Walk  

 

MODEL: RANDOM WALK SIMULATION 

Ζ αθηηλσηή απφζηαζε απφ ηελ αθεηεξία έσο Ν βήκαηα «ηαμηδηνχ» δίλεηαη απφ ηνλ παξαθάησ ηχπν : 

 
Καη ηζρχεη γηα νπνηαδήπνηε δηαδξνκή.  

 
Δηθφλα 6.2:  Random Walk, (Αξηζηεξά) Πξνζνκνίσζε ππνινγηζηψλ Α ελφο ηπραίνπ πεξηπάηνπ. (Γεμηά) ε 

απφζηαζε πνπ θαιχπηεηαη ζε έλαλ πξνζνκνησκέλν ηπραίν πεξίπαην ησλ βεκάησλ Ν έλαληη ηεο ζεσξεηηθήο 

πξφβιεςεο 

 
Ζ ζεσξεηηθή πξφβιεςε δίλεηαη απφ ηνλ παξαθάησ ηχπν 
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Τινπνίεζε ηνπ Random Walk ζε C++  
#include <stdio.h> 

#include <stdlib.h> 

#include <math.h> 

 

# define drand48 1.0/RAND_MAX*rand 

# define srand48 srand 

#define SQRT2 1.4142135623730950488E0 

#define max 10000 

#define seed 68111 

int main() 

{ 

      int i,j; 

      double x,y,r[max+1]; 

      FILE *output; 

      output = fopen("random_walk.dat","w"); 

      srand48(seed); 

      for (i=0; i<=max; i++) r[i]=0.0; 

      for (j=1; j<=100; j++) 

      { 

          x=y=0; 

          for (i=1;i<=max;i++) 

          { 

              x +=(drand48()-0.5)*2*SQRT2; 

              y +=(drand48()-0.5)*2*SQRT2; 

              r[i] += sqrt(x*x+y*y); 

          } 

      } 

      for (i=1;i<=max;i++) 

      { 

          fprintf(output, "%f\t%f\n", sqrt(i), r[i]/100.); 

      } 

      printf("Apothikeysi dedomenwn sto random_walk.dat.\n"); 

      fclose(output); 

 

Τινπνίεζε ηνπ Random Walk fortran : 
Program random_walk 

Implicit none 

 

 Real*8 root2,x,y,r(1:10000) 

 Integer i,j,max,seed 

 

 max=10000 

 seed=11168 

 root2=1.4142135623730950488E0 

 

 Open(6, FILE= 'random_walk.dat',Status='Unknown') 

 Do 1 j=1, max 

     r(j)=0 

1 Continue 

 

 Do 20 I = 1 , max 

 x=x+(rand(seed)-0.5)*2.0*root2 

 y=y+(rand(seed)-0.5)*2.0*root2 
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 r(i) = r(i) + Sqrt(x*x + y*y) 

20  continue 

10 continue 

30  continue 

 Close(6) 

Stop 'dedomena apothikeftika sto random_walk.dat' 

End 

 

Τινπνίεζε ηνπ Random Walk ζε Java : 
// RandNum.java : random numbers via java . u t i l .Random. class 

import java.io.* ; // Location of PrintWriter 

import java.util.* ; // Location of Random 

public class Walk2 { 

public static void main (String[] argv ) throws IOException , FileNotFoundException { 

PrintWriter q = new PrintWriter (new FileOutputStream ("RandNum.DAT") , true ) ; 

long seed = 11168; // Initialize 48 bit generator 

Random randnum = new Random(seed) ; 

double x,y; 

int i,j;  

int max=1000; /* number of steps */ 

 

double r[]= new double [max+1]; 

for (i=0; i<=max ; i++) {     /* clear array */ 

 r[i]=0.0; 

} 

// generate random numbers and store in data f i l e : 

for (j=1; j<=100; j++) /* average over 100 trials */ 

      { 

          x=y=0; /* starting point */ 

           

 for (i=0; i<=max ; i++ )               //q.println (randnum.nextDouble()) ; 

  { 

      x += ( randnum.nextDouble()- 0.5); 

      y += ( randnum.nextDouble() - 0.5); 

      r[i]+= Math.sqrt (x*x + y*y); 

      } 

      } 

 

System.out.println(" ") ; 

for (i=0; i<=max ; i++ )q.println (Math.sqrt(i) + "\t\t " + r[i]/100) ; 

 

System.out.println ("RandNum Program Complete .") ; 

System.out.println ("Data stored in RandNum.DAT") ; 

 

} 

} // End of class 
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Δηθφλα 6.3 : Γξαθηθή παξάζηαζε Random Walk πξνζνκνίσζεο 

 

C++ θαηά Hjorth (1 δηάζηαζε) 

/* 

    A walker makes several trials steps with 

  a given number of walks per trial 

*/ 

#include <cmath> 

#include <iostream> 

#include <fstream> 

#include <iomanip> 

#include "lib.h" 

using namespace  std; 

 

// Function to read in data from screen, note call by reference 

void initialise(int&, int&, double&) ; 

// The Mc sampling for random walks 

void  mc_sampling(int, int, double, int *, int *, int *); 

// prints to screen the results of the calculations  

void  output(int, int, int *, int *, int *); 

 

int main() 

{ 

  int max_trials, number_walks;  

  double move_probability; 

  // Read in data  

  initialise(max_trials, number_walks, move_probability) ; 

  int *walk_cumulative = new int [number_walks+1]; 

  int *walk2_cumulative = new int [number_walks+1]; 

  int *probability = new int [2*(number_walks+1)]; 

  for (int walks = 1; walks <= number_walks; walks++){    

    walk_cumulative[walks] = walk2_cumulative[walks] = 0; 

  } 

  for (int walks = 0; walks <= 2*number_walks; walks++){    

    probability[walks] = 0; 
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  } // end initialization of vectors 

  // Do the mc sampling   

  mc_sampling(max_trials, number_walks, move_probability,  

              walk_cumulative, walk2_cumulative, probability); 

  // Print out results  

  output(max_trials, number_walks, walk_cumulative,  

         walk2_cumulative, probability); 

  delete [] walk_cumulative; // free memory 

  delete [] walk2_cumulative; delete [] probability; 

  return 0;  

} // end main function 

 

// note call by reference, differs from C++ 

void initialise(int& max_trials, int& number_walks, double& move_probability)  

{ 

  cout << "Number of Monte Carlo trials =";  

  cin >> max_trials; 

  cout << "Number of attempted walks="; 

  cin >> number_walks; 

  cout << "Move probability="; 

  cin >> move_probability; 

}  // end of function initialise    

 

 

void output(int max_trials, int number_walks,  

            int *walk_cumulative, int *walk2_cumulative, int * probability) 

{ 

  ofstream ofile("testwalkers.dat"); 

  ofstream probfile("probability.dat"); 

  for( int  i = 1; i <=  number_walks; i++){ 

    double xaverage = walk_cumulative[i]/((double) max_trials); 

    double x2average = walk2_cumulative[i]/((double) max_trials); 

    double variance = x2average - xaverage*xaverage; 

    ofile << setiosflags(ios::showpoint | ios::uppercase); 

    ofile << setw(6) << i; 

    ofile << setw(15) << setprecision(8) << xaverage; 

    ofile << setw(15) << setprecision(8) << variance << endl; 

  } 

  ofile.close(); 

  // find norm of probability 

  double norm = 0.; 

  for( int  i = -number_walks; i <=  number_walks; i++){ 

    norm += (double) probability[i+number_walks]; 

  } 

  // write probability 

  for( int  i = -number_walks; i <=  number_walks; i++){ 

    double histogram = probability[i+number_walks]/norm; 

    probfile << setiosflags(ios::showpoint | ios::uppercase); 

    probfile << setw(6) << i; 

    probfile << setw(15) << setprecision(8) << histogram << endl; 

  } 

  probfile.close(); 

 

}  // end of function output  

 

 

#define IA 16807 

#define IM 2147483647 

#define AM (1.0/IM) 

#define IQ 127773 
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#define IR 2836 

#define MASK 123459876 

#define AMG 2132007001 

 

double ran0(long *idum) 

{ 

   long     k, bb; 

   double   ans; 

 

   *idum ^= MASK; 

   k = (*idum)/IQ; 

bb=AMG; 

   *idum = IA*(*idum - k*IQ) - IR*k; 

   if(*idum < 0) *idum += IM; 

   ans=AM*(*idum); 

   *idum ^= MASK; 

   return ans; 

} 

void mc_sampling(int max_trials, int number_walks,  

                 double move_probability, int *walk_cumulative,  

                 int *walk2_cumulative, int *probability) 

{ 

  long idum; 

  idum=clock();  // initialise random number generator 

  for (int trial=1; trial <= max_trials; trial++){ 

    int position = 0; 

    for (int walks = 1; walks <= number_walks; walks++){    

      if (ran0(&idum) <= move_probability) { 

 position += 1; 

      }  

      else { 

 position -= 1; 

      } 

      walk_cumulative[walks] += position; 

      walk2_cumulative[walks] += position*position; 

      probability[position+number_walks] += 1; 

    }  // end of loop over walks 

  } // end of loop over trials 

}   // end mc_sampling function   

 

 

 

 

 
Δηθφλα 6.4: Γξαθηθή παξάζηαζε ζ2 γηα 1000000 δείγκαηα Monte Carlo.  
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6.3.2 H κέζνδνο DECAY SIMULATION (To παξάδεηγκα ηεο ξαδηελεξγνύ 

δηάζπαζεο) 

 

Ζ ξαδηελεξγφο δηάζπαζε είλαη κηα θπζηθή δηαδηθαζία θαηά ηελ νπνία έλα ζσκαηίδην κε απζφξκεην 

ηξφπν δηαζπάηαη ζε άιια ζσκαηίδηα. Ζ πηζαλφηεηα δηάζπαζεο θάζε ζσκαηηδίνπ  αλά κνλάδα ρξφλνπ 

είλαη ζηαζεξή(εμαξηάηαη κφλν απφ ην ζπγθεθξηκέλν ζσκαηίδην) αιιά ην πόηε ζα ζπκβεί ε δηάζπαζε 

είλαη ηπραίν γεγνλόο. 

Με ηε πάξνδν ηνπ ρξφλνπ , ν νιηθφο αξηζκφο ησλ ζσκαηηδίσλ κεηψλεηαη  φπσο θαη ν αξηζκφο ησλ 

δηαζπάζεσλ , αιιά ε πηζαλφηεηα δηάζπαζεο θάζε ζσκαηηδίνπ παξακέλεη ζηαζεξή(αξθεί ην ζσκάηην 

λα είλαη δσληαλφ!). 

Ο αιγφξηζκφο είλαη : 

N = 0 

END 

START 

false true 

false true 

true 

print nold 

random number 

0 < r < 1 

false 

r < ι 

input nold, ι 

while nold > 0 

nold = nleft 

while N < nold 

N = N + 1 

nleft = nleft – 1 

nleft = nold 

1. έζησ ε ηηκή ηεο ζηαζεξάο δηάζπαζεο  1 . Με ηε ηηκή ηεο ι ζέηνπκε θαη ηε θιίκαθα ησλ ρξφλσλ 

θαη νπζηαζηηθά ε επαλαιεπηηθή δνκή αληηζηνηρεί ζε επηπξφζζεηα Γt.  

2. Ξεθηλάκε κε έλαλ αξρηθφ αξηζκφ Nucleus  πνπ αληηπξνζσπεχεη ηε ηηκή ησλ ππξήλσλ ηε ρξνληθή 

ζηηγκή t=0. 

3. Γεκηνπξγνχκε έλαλ ηπραίν αξηζκφ  0 1ir  (κε ηελ ξνπηίλα rand(seed) γηα θάζε ππξήλα πνπ δελ 

έρεη αθφκα δηαζπαζζεί 

4. Υξεζηκνπνηνχκε, γηα θάζε ππξήλα ηε ζπλζήθε δηάζπαζεο. 

Αλ r  , ηφηε ν ππξήλαο δηαζπάηαη θαη   the nucleus decays and Nucleus = Nucleus -1 , εηδάιισο ν 

ππξήλαο ζεσξείηαη αδηάζπαζηνο. 

5. Δπαλαιακβάλνπκε ηε δηαδηθαζία γηα φινπο ηνπο ππξήλεο. 
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Δηθφλα 6.5 : Γηάγξακκα αλάπηπμεο θψδηθα decay 

 

 
Σν πξφγξακκα είλαη γξακκέλν ζε fortran , C++ θαη Java : 

 
Fortran 90: 
 

PROGRAM decay2 

      IMPLICIT none 

 

      REAL*8 r,  lambda 

      INTEGER i, h, nleft, Nucleus, seed, start 

 

      lambda=0.01 

      start=1000  

      seed=11168  

    

      h = 1 

Nucleus = start 

      nleft = start 

      call rand(seed)   

 

      OPEN(6, FILE='decayf.txt') 

 

      DO 20 WHILE (nleft .NE. 0)  

         DO 10 i = 1, nleft 

            r = rand() 

            IF (r .LE. lambda) THEN 

               Nucleus = Nucleus -1 

            ENDIF 

 10      CONTINUE 
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nleft = Nucleus      

    WRITE (6,*) h, ' ', REAL(nleft)/start 

         h = h + 1 

 20   END DO 

      STOP  

      END 

 

 

 

C++  απιή κνξθή: 

 

#include <stdio.h> 

#include <stdlib.h> 

#define drand48 1.0/RAND_MAX*rand 

#define srand48 srand 

#define lamda 0.01 

#define max 1000 

#define time_max 500 

#define seed 11168 

int main() { 

    int atom,time,number,nloop; 

    double decay; 

    FILE *output; 

    output=fopen("decay_c.txt" , "w"); 

    number=nloop=max; 

    srand48(seed); 

    for (time=0; time<=time_max; time++) 

    { 

        for(atom=1; atom<=number; atom++) 

        { 

            decay=drand48(); 

            if (decay<lamda) nloop-- ; 

            } 

            number=nloop; 

            fprintf(output, "%d\t%f\n",time, (double)number/max); 

            } 

        printf("data stored in decay_c.txt \n"); 

        fclose(output); 

        } 

             

Java : 

 

// Decay . java : Spontaneous decay simulation 

import java.io.* ; 

import java.util.* ; 

public class Decay { 

static double lambda = 0.01 ; // Decay constant 

static int max = 1000 , time_max = 500 , seed = 68111; // Params 

public static void main(String[] argv ) throws IOException , FileNotFoundException { 

int atom , time , number , nloop ; 

double decay ; 

PrintWriter w = new PrintWriter ( new FileOutputStream ("decay_"+max+".txt") , true ) ; 

number = nloop = max ; //Initial value 

Random r = new Random( seed ) ; // Seed number generator 

for ( time = 0 ; time <= time_max ; time++ ) { // Time loop 

for ( atom = 1 ; atom <= number ; atom++ ) { // Decay loop 

decay = r.nextDouble() ; 

if (decay<lambda) nloop-- ; // A decay 

} 

number = nloop ; 
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w.println ( " " + time + " " + (double )number/max) ; 

} 

System.out.println ("data stored in decay_"+max+".txt") ; 

} } 

 

 
Δηθφλα 6.6: Γξαθηθή παξάζηαζε απφ ηελ εθηέιεζε ηνπ θψδηθα ζε γιψζζα πξνγξακκαηηζκνχ Java γηα 

δηάζπαζε ππξήλα (δηαθνξεηηθνχ N) ζε ζρέζε κε ην ρξφλν 
 

C++ αλαιπηηθή κνξθή : 
// Radioactive decay of nuclei 

#include <iostream> 

#include <fstream> 

#include <iomanip> 

#include "lib.h" 

using namespace std ; 

ofstream ofile ; 

// Function to read in data from screen 

void initialise(int *, int *, int *, double *) ; 

// The Mc sampling for nuclear decay 

void mc_sampling(int,int,int,double,int*) ; 

// prints to screen the results of the calculations 

void output(int,int,int*) ; 

int main(int argc , char* argv[] ) 

{ 

char *outfilename ; 

int initial_n_particles, max_time , number_cycles ; 

double decay_probability ; 

int *ncumulative ; 

// Read in output file , abort if the reare too few command..line arguments 

if (argc <= 1 ) { 

cout << "bad usage" << argv [0] <<  

     "read also output file on same line" << endl ; 

exit(1) ; 

} 

else { 

outfilename=argv[1] ; 
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} 

ofile.open(outfilename ) ; 

// Read in data 

initialise(&initial_n_particles, &max_time, &number_cycles,  

               &decay_probability) ; 

ncumulative = new int [max_time + 1 ] ; 

// Do the mc sampling 

mc_sampling (initial_n_particles , max_time , number_cycles ,decay_probability, ncumulative) ; 

// Print out results 

output(max_time,number_cycles , ncumulative ) ; 

delete [] ncumulative ; 

return 0 ; 

} // end of main function 

 

 

#define IA 16807 

#define IM 2147483647 

#define AM (1.0/IM) 

#define IQ 127773 

#define IR 2836 

#define MASK 123459876 

 

double ran0(long *idum) 

{ 

   long     k; 

   double   ans; 

 

   *idum ^= MASK; 

   k = (*idum)/IQ; 

   *idum = IA*(*idum - k*IQ) - IR*k; 

   if(*idum < 0) *idum += IM; 

   ans=AM*(*idum); 

   *idum ^= MASK; 

   return ans; 

} 

void mc_sampling(int initial_n_particles,int max_time,int number_cycles,double decay_probability,int 

*ncumulative) 

{ 

int cycles , time , np , n_unstable , particle_limit  ; 

long idum ; 

idum = -1; // initialise random number generator 

// loop ov e r monte c a r l o c y c l e s 

// One monte carlo loop is one sample 

for (cycles = 1 ; cycles <= number_cycles ; cycles ++) { 

n_unstable = initial_n_particles ; 

// accumulate the number of particles per time step pertrial 

ncumulative[0] += initial_n_particles ; 

// loop over each time step 

for (time =1; time <= max_time ; time ++) { 

// for each time step , we check each particle 

particle_limit = n_unstable ; 

for ( np = 1 ; np <= particle_limit ; np ++) { 

if (ran0(&idum) <= decay_probability ) { 

n_unstable= n_unstable-1; 

} 

} // end of loop over particles 

ncumulative[time] += n_unstable ; 

} // end of loop over time steps 

} // end of loop over MC trials 

} // end mc_sampling function 
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6.3.3 Κίλεζε ελόο κνξίνπ, ζε κηα δηάζηαζε, θάησ από κηα ειαζηηθή 

δύλακε. 

 
Θα ρξεζηκνπνηήζνπκε έλαλ αιγφξηζκν γηα πξνζνκνίσζε ελφο κνξίνπ πνπ θηλείηαη θαηά κήθνο ηνπ 

άμνλα Υ, σο παξάδεηγκα ηεο θίλεζε ελφο κνξίνπ, ζε κηα δηάζηαζε, θάησ απφ κηα ειαζηηθή δχλακε. Ο 

αιγφξηζκφο πινπνηείηαη απφ έλα πξφγξακκα ζε Java. Γηα απιφηεηα, ε δχλακε ιακβάλεηαη λα είλαη κηα 

ειαζηηθή δχλακε θ (X) = −kx, φπνπ ην Κ είλαη ε ειαζηηθή ζηαζεξά. Θα ρξεζηκνπνηήζνπκε επίζεο κ 

= Κ = 1 γηα ηελ επθνιία. Σν αθφινπζν πξφγξακκα ηεο Java είλαη κηα εθαξκνγή ελφο αιγνξίζκνπ πνπ 

βγαίλεη απφ ηηο παξαθάησ καζεκαηηθέο εμηζψζεηο :  

 

Σν παξαθάησ ζρήκα 6.7 είλαη ε γξαθηθή αλαπαξάζηαζε ηεο «πινθήο». Σν αξηζκεηηθφ απνηέιεζκα 

πνπ παξάγεηαη απφ ην πξφγξακκα ζπκθσλεί κε ην αλαιπηηθφ απνηέιεζκα. Δπεηδή ν αιγφξηζκνο πνπ 

έρνπκε ρξεζηκνπνηήζεη εδψ είλαη πνιχ απιφο, πξέπεη λα ρξεζηκνπνηήζνπκε πνιχ κηθξφ ρξνληθφ 

δηάζηεκα πξνθεηκέλνπ λα επηηεπρζεί απνηέιεζκα κε κηα ινγηθή αθξίβεηα. 

 
 

 
 

Δηθφλα 6.7: Πξνζνκνίσζε θίλεζεο κνξίνπ 

 

Ο θψδηθαο ηνπ πξνγξάκκαηνο : 

 

 // An example of studying the motion of a particle in 
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// one dimension under an elastic force. 

import java.lang.*; 

public class Motion { 

static final int n = 100000, j = 500; 

public static void main(String argv[]) { 

double x[] = new double[n+1]; 

double v[] = new double[n+1]; 

// Assign time step and initial position and velocity 

double dt = 2*Math.PI/n; 

x[0] = 0; 

v[0] = 1; 

// Calculate other position and velocity recursively 

for (int i=0; i<n; ++i) { 

x[i+1] = x[i]+v[i]*dt; 

v[i+1] = v[i]-x[i]*dt; 

} 

// Output the result in every j time steps 

double t = 0; 

double jdt = j*dt; 

for (int i=0; i<=n; i+=j) { 

 System.out.println(t +" " + x[i] + " " + v[i]); 

//System.out.println(t); 

//System.out.println(x[i]); 

//System.out.println(v[i]); 

t += jdt; 

} 

} 

} 
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6.3.4 Τπνινγηζκόο απόζηαζεο θνκήηε Halley από ηνλ Ήιην (αιγόξηζκνο 

Verlet) . 

 
Πξνζνκνίσζε ηεο πεξηνδηθήο θίλεζεο ηνπ θνκήηε Halley ζε ζρέζε κε ηελ απφζηαζε απφ ηνλ ήιην. 

 

Δηθφλα 6.8: Πξνζνκνίσζε απφζηαζεο θνκήηε Halley απφ ηνλ Ήιην 

 

Ο θψδηθαο ηνπ πξνγξάκκαηνο: 

 

// An example to study the time-dependent position and 

// velocity of Halley's comet via the Verlet algorithm. 

import java.lang.*; 

public class Comet { 

static final int n = 20000, m = 200; 

public static void main(String argv[]) { 

double t[] = new double [n]; 

double x[] = new double [n]; 

double y[] = new double [n]; 

double r[] = new double [n]; 

double vx[] = new double [n]; 

double vy[] = new double [n]; 

double gx[] = new double [n]; 

double gy[] = new double [n]; 

double h = 2.0/(n-1), h2 = h*h/2, k = 39.478428; 

// Initialization of the problem 

t[0] = 0; 

x[0] = 1.966843; 

y[0] = 0; 

r[0] = x[0]; 

vx[0] = 0; 

vy[0] = 0.815795; 

gx[0] = -k/(r[0]*r[0]); 

gy[0] = 0; 
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// Verlet algorithm for the position and velocity 

for (int i=0; i<n-1; ++i) { 

t[i+1] = h*(i+1); 

x[i+1] = x[i]+h*vx[i]+h2*gx[i]; 

y[i+1] = y[i]+h*vy[i]+h2*gy[i]; 

double r2 = x[i+1]*x[i+1]+y[i+1]*y[i+1]; 

r[i+1] = Math.sqrt(r2); 

double r3 = r2*r[i+1]; 

gx[i+1] = -k*x[i+1]/r3; 

gy[i+1] = -k*y[i+1]/r3; 

vx[i+1]= vx[i]+h*(gx[i+1]+gx[i])/2; 

vy[i+1]= vy[i]+h*(gy[i+1]+gy[i])/2; 

} 

for (int i=0; i<n-m; i+=m) { 

System.out.println(t[i]); 

//System.out.println(r[i]); 

//System.out.println(); 

} 

} 

} 

 

Χο αξρή ηνπ γηα ηνλ ππνινγηζκφ ηεο απφζηαζεο έρνπκε πάξεη ην πην απνκαθξπζκέλν ζεκείν ηεο 

ηξνρηάο ηνπ θνκήηε. 
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6.3.5 Σπραίνο αξηζκόο κε ρξήζε Monte Carlo 

Παξαγσγή ηπραίσλ αξηζκψλ ρξεζηκνπνηψληαο ηελ κέζνδν Monte Carlo 

 
// An example of integration with direct Monte Carlo 

// scheme with integrand f(x) = x*x. 

import java.lang.*; 

import java.util.Random; 

public class Monte { 

public static void main(String argv[]) { 

Random r = new Random(); 

int n = 1000000; 

double s0 = 0; 

double ds = 0; 

for (int i=0; i<n; ++i) { 

double x = r.nextDouble(); 

double f = x*x; 

s0 += f; 

ds += f*f; 

} 

s0 /= n; 

ds /= n; 

ds = Math.sqrt(Math.abs(ds-s0*s0)/n); 

System.out.println("S = " + s0 + " +- " + ds); 

} 

} 

 

Απνηειέζκαηα απφ δηαδνρηθέο εθηειέζεηο ηνπ πξνγξάκκαηνο: 

 

S = 0.3333800497946395 +- 2.981910359536872E-4 

S = 0.3334601003067521 +- 2.9820175658893175E-4 

S = 0.33348761614095257 +- 2.982946982187852E-4 

S = 0.3329032913626938 +- 2.980347252201492E-4 
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6.3.6 Πξνζνκνίσζε Monte Carlo κε ρξήζε Metropolis f(x) = x*x 

 

// παξάδεηγκα ρξήζεο Monte Carlo  

// Δμίζσζε Metropolis f(x) = x*x. 

import java.lang.*; 

import java.util.Random; 

public class Carlo { 

static final int nsize = 10000; 

static final int nskip = 15; 

static final int ntotal = nsize*nskip; 

static final int neq = 10000; 

static int iaccept = 0; 

static double x, w, h = 0.4, z = 0.46265167; 

static Random r = new Random(); 

public static void main(String argv[]) { 

x = r.nextDouble(); 

w = weight(); 

for (int i=0; i<neq; ++i) metropolis(); 

double s0 = 0; 

double ds = 0; 

iaccept = 0; 

for (int i=0; i<ntotal; ++i) { 

metropolis(); 

if (i%nskip == 0) { 

double f = g(x); 

s0 += f; 

ds += f*f; 

} 

} 

s0 /= nsize; 

ds /= nsize; 

ds = Math.sqrt(Math.abs(ds-s0*s0)/nsize); 

s0 *= z; 

ds *= z; 

double accept = 100.0*iaccept/(ntotal); 

System.out.println("S = " + s0 + " +- " + ds); 

System.out.println("Accept rate = " + accept + "%"); 

} 

public static void metropolis() { 

double xold = x; 

x = x + 2*h*(r.nextDouble()-0.5); 

if ((x<0) || (x>1)) x = xold; 

else { 

double wnew = weight(); 

if (wnew > w*r.nextDouble()) { 

w = wnew; 

++iaccept; 

} 

else x = xold; 

} 

} 

public static double weight() { 

return Math.exp(x*x) - 1; 

} 

public static double g(double y) { 

return y*y/(Math.exp(y*y)-1); 

} 
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} 

Γείγκα απνηειεζκάησλ πνπ δίλεη ν παξαπάλσ θψδηθαο : 

S = 0.3330116061589402 +- 4.749158539191888E-4 

Accept rate = 49.684666666666665% 

S = 0.33291770918855806 +- 4.7620949517758243E-4 

Accept rate = 49.764% 

S = 0.3323379383517912 +- 4.784328194785027E-4 

Accept rate = 49.465333333333334% 

 

Σν αξηζκεηηθφ απνηέιεζκα πνπ επηηπγράλεηαη κε ην αλσηέξσ πξφγξακκα είλαη 0.3334 ± 0.0005. Σν 

κέγεζνο βεκάησλ είλαη δηεπζεηήζηκν, θαη πξέπεη λα πξνζπαζήζνπκε λα ην θξαηήζνπκε έηζη ψζηε ην 

πνζνζηφ απνδνρήο ησλ λέσλ δηακνξθψζεσλ λα  είλαη ιηγφηεξν απφ ή πεξίπνπ 50%. 
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6.3.7 Μνξηαθή Γπλακηθή – Αιγόξηζκνη Verlet θαη Velocity-Verlet 

 
΢ηελ ππνινγηζηηθή θάζε ρξεζηκνπνηείηαη γηα ηε ιχζε ν αιγφξηζκνο Verlet. Αιγφξηζκνη ηέηνηνπ ηχπνπ 

πξέπεη ηνπιάρηζηνλ κηα θνξά λα ρξεζηκνπνηεζνχλ απφ εθπαηδεπφκελνπο πνπ αζρνινχληαη κε 

πξνζνκνηψζεηο γηαηί αλαδεηθλχνπλ ηε ρξνληθή εμέιημε ησλ νληνηήησλ ηνπ ζπζηήκαηνο κέζσ ησλ 

αιιειεπηδξάζεσλ ηνπο. 

Ο εθπαηδεπφκελνο ζα πξέπεη λα κπνξεί λα γξάςεη ην θψδηθα θαη επίζεο λα : απνδίδεη ηαρχηεηεο ζηα 

ζσκαηίδηα  ζχκθσλα κε ηε θαηαλνκή Maxwell-Boltzmann, λα κπνξεί λα ρξεζηκνπνηεί πεξηνδηθέο 

ζπλζήθεο φηαλ ρξεζηκνπνηεί ηα ζσκαηίδηα –εηθφλεο, λα ππνινγίδεη κέζεο ηηκέο πνζνηήησλ, λα 

ζπγθξίλεη ηε ηειηθή κε ηελ αξρηθή ζεξκνθξαζία θιπ.    

Ο θψδηθαο είλαη ζε γιψζζα Java:   

/* From: "A SURVEY OF COMPUTATIONAL PHYSICS"  

   by RH Landau, MJ Paez, and CC BORDEIANU  

      */ 

// MD.java, Molecular Dyanmics via Lennard-Jones potential, velocity Verlet algorithm 

import java.io.*; 

import java.util.*; 

 

public class MD_1 {  

  static  int L, Natom = 8, Nmax = 513;                            // Class variables 

  static double x[] = new double[Nmax], fx[][] = new double[Nmax][2]; 

   

  public static void main(String[] argv) throws IOException, FileNotFoundException { 

    int t1, t2, i, Itemp, t, Nstep=5000, Nprint=100, Ndim=1; 

    double h = 0.0004, hover2, PE, KE, T, Tinit = 10.0, vx[] = new double[Nmax];  

    L = (int)Math.pow(1.*Natom, 1./Ndim);  

    Natom =  (int)Math.pow(L, Ndim); 

    System.out.println("Natom = "+Natom+" L= "+L+""); 

    i = -1; 

    for ( int ix = 0; ix <= L-1; ix++ ) {                 // Set up lattice of side L 

      i = i+1; 

      x[i] = ix;                                                // Initial velocities 

      vx[i] =(Math.random()+Math.random()+Math.random()+Math.random()+Math.random() 

              +Math.random()+Math.random()+Math.random()+Math.random()+ 

                   Math.random()+Math.random()+Math.random())/12.-0.5;  

      vx[i] = vx[i]*Math.sqrt(Tinit);                     // Scale v with temperature 

      System.out.println("init vx = "+vx[i]); 

    }  

    t1 = 0;    t2 = 1;                                              // t, t+h indices 

    hover2 = h/2.; 

    t = 0; 

    KE = 0.0;  PE = 0.0;                                         // initial KE & PE v 

    PE = Forces(t1, PE); 

    for ( i = 0; i <= Natom-1; i++ )    KE=KE+(vx[i]*vx[i])/2; 

    System.out.println(t+" PE= "+PE+" KE = "+KE+" PE+KE = "+(PE+KE)); 

    for( t = 1; t < Nstep; t++ ) { 

      for( i = 0; i <= Natom-1; i++ )  {                                 // Main loop 

        PE = Forces(t1, PE);                                       // Velocity Verlet 

        x[i] = x[i] + h*(vx[i] + hover2*fx[i][t1]); 

        if (x[i] <= 0.) x[i] = x[i] + L;                                       // PBC 

        if (x[i] >= L)  x[i] = x[i] - L; 

      } 

    PE = Forces(t2, PE); 
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    KE = 0.;  

    for( i = 0; i <= Natom-1; i++)  {  

      vx[i] = vx[i] + hover2*(fx[i][t1] + fx[i][t2]); 

      KE = KE + (vx[i]*vx[i])/2;  

    } 

    T = 2.*KE / (3.*Natom);  

    if (t%Nprint==0)System.out.println(t+" PE ="+PE+" KE = "+KE+" PE+KE = "+(PE+KE)); 

    Itemp = t1;                                                     // Time t and t+h 

    t1 = t2;         t2 = Itemp; 

    } 

   } 

                                                            // Force = class variable 

  public static double Forces(int t, double PE) {  

    int i, j; 

    double fijx, r2, invr2=0, dx, r2cut = 9.; 

    PE = 0.;                                                            // Initialize 

    for (i=0; i<= Natom-1; i++)   {fx[i][t] = 0.; }  

    for(i = 0; i<= Natom-2; i++)  {  

      for(j = i+1; j<=Natom-1; j++) {  

        dx = x[i]-x[j]; 

        if (Math.abs(dx) > 0.50*L) {dx = dx - sign(L,dx);}                     // PBC 

        r2 =  dx*dx ; 

        if (r2 < r2cut)  {                                                 // Cut off 

          if ( r2 == 0.) r2 = 0.0001; 

          invr2 = 1./r2;    

          fijx =  48.*(Math.pow(invr2,3)-0.5)*Math.pow(invr2,3);     

          fijx = fijx*invr2*dx; 

          fx[i][t] = fx[i][t] + fijx; 

          fx[j][t] = fx[j][t] - fijx; 

          PE = PE + 4*Math.pow(invr2,3)*( Math.pow(invr2,3) - 1.); 

        } 

      }  

    } 

  return PE;     

  } 

   

  public static double  sign(double a,double b)  

    {if (b >= 0.) return Math.abs(a);  else  return -Math.abs(a); }       

}   

 
Απνηειέζκαηα : 

 
Natom = 8 L= 8 

init vx = -0.2637444310598956 

init vx = 0.2571384874929832 

init vx = 0.6819679095830891 

init vx = 0.40372553516343757 

init vx = -0.21855584843265083 

init vx = 0.27233399944412173 

init vx = -0.22941374326132444 

init vx = -0.059351642607502614 

0 PE= -0.4921875 KE = 0.4709208066620739 PE+KE = -0.02126669333792608 

100 PE =-0.24233546315817742 KE = 0.19047562961867212 PE+KE = -0.051859833539505296 

200 PE =-0.2727041428544336 KE = 0.2187689215572075 PE+KE = -0.05393522129722611 

300 PE =-0.21965049201255632 KE = 0.17418494354907027 PE+KE = -0.04546554846348605 

400 PE =-0.32721761235979996 KE = 0.2791045702962209 PE+KE = -0.04811304206357908 

500 PE =-0.45531610414632295 KE = 0.3943704156346706 PE+KE = -0.06094568851165233 

600 PE =-0.2964633879780502 KE = 0.23718117133947134 PE+KE = -0.05928221663857888 

700 PE =-0.18686803029903737 KE = 0.12102108243502654 PE+KE = -0.06584694786401082 

800 PE =-0.29355244857459445 KE = 0.22521062494044192 PE+KE = -0.06834182363415253 
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900 PE =-0.33962871837063735 KE = 0.2804129524949834 PE+KE = -0.05921576587565397 

1000 PE =-0.4379347796670656 KE = 0.37026151246664085 PE+KE = -0.06767326720042477 

1100 PE =-0.3099338563051583 KE = 0.23448497079119 PE+KE = -0.0754488855139683 

1200 PE =-0.18054689002204555 KE = 0.10290474632523756 PE+KE = -0.07764214369680798 

1300 PE =-0.30611024497109973 KE = 0.2316449642815939 PE+KE = -0.07446528068950584 

1400 PE =-0.38706348084457987 KE = 0.3157131040669552 PE+KE = -0.07135037677762468 

1500 PE =-0.40361090830686785 KE = 0.32425553650246525 PE+KE = -0.07935537180440261 

1600 PE =-0.31165645652131235 KE = 0.22513040913881943 PE+KE = -0.08652604738249292 

1700 PE =-0.16732075219847775 KE = 0.07875342049399327 PE+KE = -0.08856733170448448 

1800 PE =-0.34716282679504606 KE = 0.25692779634118024 PE+KE = -0.09023503045386583 

1900 PE =-0.3999688056017654 KE = 0.318222188441314 PE+KE = -0.0817466171604514 

2000 PE =-0.4005396116929397 KE = 0.31629435125209704 PE+KE = -0.08424526044084268 

2100 PE =-0.2575598839806854 KE = 0.171661428715325 PE+KE = -0.08589845526536041 

2200 PE =-0.23654015547909968 KE = 0.13803178142171316 PE+KE = -0.09850837405738652 

2300 PE =-0.2840447550758549 KE = 0.18442462518618197 PE+KE = -0.09962012988967295 

2400 PE =-0.47708465929578225 KE = 0.38627517403872746 PE+KE = -0.09080948525705479 

2500 PE =-0.32690732568454317 KE = 0.23405472326698856 PE+KE = -0.09285260241755461 

2600 PE =-0.30228349381245745 KE = 0.2077237543278226 PE+KE = -0.09455973948463484 

2700 PE =-0.2385231198106672 KE = 0.13147023398285348 PE+KE = -0.10705288582781372 

2800 PE =-0.32698452264900435 KE = 0.2233437941681478 PE+KE = -0.10364072848085654 

2900 PE =-0.45478456592147587 KE = 0.3546016358539697 PE+KE = -0.10018293006750617 

3000 PE =-0.33834067953118624 KE = 0.2295781685837874 PE+KE = -0.10876251094739883 

3100 PE =-0.2618822564557982 KE = 0.15744529266808838 PE+KE = -0.10443696378770984 

3200 PE =-0.2904412437648318 KE = 0.17803893883112093 PE+KE = -0.1124023049337109 

3300 PE =-0.3423228501088778 KE = 0.22345479472784774 PE+KE = -0.11886805538103007 

3400 PE =-0.44884859626340695 KE = 0.3334344813833094 PE+KE = -0.11541411488009756 

3500 PE =-0.3304760861363299 KE = 0.2179568904651214 PE+KE = -0.1125191956712085 

3600 PE =-0.23642181950376556 KE = 0.12193348123715719 PE+KE = -0.11448833826660837 

3700 PE =-0.35720214184168636 KE = 0.22925244419225485 PE+KE = -0.1279496976494315 

3800 PE =-0.354306098552413 KE = 0.22488186086066977 PE+KE = -0.12942423769174324 

3900 PE =-0.43940578497939287 KE = 0.30839350271933913 PE+KE = -0.13101228226005374 

4000 PE =-0.32265594580770074 KE = 0.2001216457826571 PE+KE = -0.12253430002504365 

4100 PE =-0.21152909880141377 KE = 0.08807005970963672 PE+KE = -0.12345903909177705 

4200 PE =-0.41519575932241437 KE = 0.27872612866628144 PE+KE = -0.13646963065613293 

4300 PE =-0.35005753654860594 KE = 0.21106093917018348 PE+KE = -0.13899659737842246 

4400 PE =-0.4454451309400682 KE = 0.30544919066451803 PE+KE = -0.13999594027555018 

4500 PE =-0.29339815580112044 KE = 0.15753134101173588 PE+KE = -0.13586681478938456 

4600 PE =-0.2482570700683413 KE = 0.11647879987501311 PE+KE = -0.1317782701933282 

4700 PE =-0.39094882433499245 KE = 0.25767632195180307 PE+KE = -0.13327250238318938 

4800 PE =-0.40951965384618105 KE = 0.268063402577468 PE+KE = -0.14145625126871303 

4900 PE =-0.35824763268951754 KE = 0.2099895599700996 PE+KE = -0.14825807271941793 
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6.3.8 Πξόγξακκα πξνζνκνίσζεο θίλεζεο Μνξίσλ . 
 

Σν παξαθάησ πξφγξακκα ζε Java πξνζνκνηψλεη θαη απνδίδεη γξαθηθά ηελ θίλεζε κνξίσλ. ΢ην 

παξάδεηγκα απηφ γίλεηαη εθαξκνγή ησλ ςεθηαθψλ αληηθεηκέλσλ (δεκηνπξγία, θίλεζε, απνζηάζε, 

ζέζε κνξίσλ θιπ). 

 

 
Δηθφλα 6.9 : Πξφγξακκα πξνζνκνίσζεο ζχγθξνπζεο κνξίσλ 

 

 Ο θψδηθαο ζε Java : 

// Apo to www.physics.buffalo.edu/gonsalves/ComPhys_1998/Java/MDSimulation.java 

// ComPhys File: MDSimulation.java 

// Chapter 8: A Molecular Dynamics Program 

 

import java.awt.*; 

import java.awt.event.*; 

import java.applet.*; 

import java.io.*; 

  

public class MDSimulation extends Applet implements ActionListener, ItemListener, Runnable { 

 

    double[] x = new double[36]; 

    double[] y = new double[36]; 

    double[] vx = new double[36]; 

    double[] vy = new double[36]; 

    double[] ax = new double[36]; 
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    double[] ay = new double[36]; 

 

    int N = 16; 

    double Lx = 6.0; 

    double Ly = 6.0; 

    double dt = 0.01; 

    double dt2; 

    double E; 

    int ncum; 

 

    double[] x_initial = {1.09,3.12,0.08,0.54,2.52,3.03,4.25,0.89, 

                          2.76,3.14,0.23,1.91,4.77,5.10,4.97,3.90}; 

    double[] y_initial = {0.98,5.25,2.38,4.08,4.39,2.94,3.01,3.11, 

                          0.31,1.91,5.71,2.46,0.96,4.63,5.88,0.20}; 

    double[] vx_initial = {-0.33,0.12,-0.08,-1.94,0.75,1.70,0.84,-1.04, 

                           1.64,0.38,-1.58,-1.55,-0.23,-0.31,1.18,0.46}; 

    double[] vy_initial = {-0.78,-1.19,-0.10,-0.56,0.34,-1.08,0.47,0.06, 

                           1.36,-1.24,0.55,-0.16,-0.83,0.65,1.48,-0.51}; 

 

    // variables set by initial() 

    double t; 

    double ke; 

    double kecum; 

    double pecum; 

    double vcum; 

    double area; 

 

    void initial () { 

 

        dt2 = dt * dt; 

 

        for (int i = 0; i < N; ++i) { 

            x[i] = x_initial[i]; 

            y[i] = y_initial[i]; 

            vx[i] = vx_initial[i]; 

            vy[i] = vy_initial[i]; 

        } 

 

        ke = 0; 

        for (int i = 0; i < N; ++i) 

            ke += vx[i] * vx[i] + vy[i] * vy[i]; 

        ke *= 0.5; 

        area = Lx * Ly; 

        t = 0; 

        kecum = 0; 

        pecum = 0; 

        vcum = 0; 

 

        accel(); 

        E = ke + pe; 

        ncum = 0; 

 

        show_output(); 

        show_positions(); 

         

    } 

 

    // variables set by accel() 

    double pe; 

    double virial; 
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    // variables used by accel() and set by force() 

    double fx; 

    double fy; 

    double pot; 

 

    void accel () { 

 

        for (int i = 0; i < N; ++i) { 

            ax[i] = 0; 

            ay[i] = 0; 

        } 

 

        pe = 0; 

        virial = 0; 

 

        for (int i = 0; i < N - 1; ++i) { 

            for (int j = i + 1; j < N; ++j) { 

 

                double dx = separation(x[i] - x[j], Lx); 

                double dy = separation(y[i] - y[j], Ly); 

 

                force(dx, dy); 

 

                ax[i] += fx; 

                ay[i] += fy; 

                ax[j] -= fx; 

                ay[j] -= fy; 

                pe += pot; 

                virial += dx * fx + dy * fy; 

                 

            } 

        } 

 

    } 

 

    double separation (double ds, double L) { 

 

        if (ds > 0.5 * L) 

            ds -= L; 

        if (ds < - 0.5 * L) 

            ds += L; 

 

        return ds; 

 

    } 

 

    void force (double dx, double dy) { 

 

        double r2 = dx * dx + dy * dy; 

        double rm2 = 1 / r2; 

        double rm6 = rm2 * rm2 * rm2; 

        double f_over_r = 24 * rm6 * (2 * rm6 - 1) * rm2; 

        fx = f_over_r * dx; 

        fy = f_over_r * dy; 

        pot = 4 * (rm6 * rm6 - rm6); 

 

    } 

 

    void Verlet () { 
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        for (int i = 0; i < N; ++i) { 

 

            double xnew = x[i] + vx[i] * dt + 0.5 * ax[i] * dt2; 

            double ynew = y[i] + vy[i] * dt + 0.5 * ay[i] * dt2; 

 

            vx[i] += 0.5 * ax[i] * dt; 

            vy[i] += 0.5 * ay[i] * dt; 

 

            x[i] = pbc(xnew, Lx); 

            y[i] = pbc(ynew, Ly); 

 

        } 

 

        accel(); 

 

        ke = 0; 

        for (int i = 0; i < N; ++i) { 

 

            vx[i] += 0.5 * ax[i] * dt; 

            vy[i] += 0.5 * ay[i] * dt; 

            ke += vx[i] * vx[i] + vy[i] * vy[i]; 

 

        } 

 

        ke *= 0.5; 

        t += dt; 

 

    } 

 

    double pbc (double pos, double L) { 

 

        if (pos < 0) 

            pos = pos + L; 

        if (pos > L) 

            pos = pos - L; 

 

        return pos; 

 

    } 

 

    Label numberLabel, densityLabel, ncumLabel, tLabel, ELabel, TLabel, pLabel; 

 

    String format (double d, int decimalPlaces) { 

 

        for (int i = 0; i < decimalPlaces; ++i) 

            d *= 10; 

        d = Math.round(d); 

        for (int i = 0; i < decimalPlaces; ++i) 

            d /= 10; 

        String str = new String("" + d); 

        int len = Math.min(str.length(), 

                           str.indexOf('.') + decimalPlaces + 1);  

        return str.substring(0, len); 

                                          

    } 

 

    double T; 

 

    void show_output () { 
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        ++ncum; 

        ncumLabel.setText("" + ncum); 

        tLabel.setText(format(t, 2)); 

        E = ke + pe; 

        ELabel.setText(format(E, 3)); 

        kecum += ke; 

        vcum += virial; 

        double mean_ke = kecum / ncum; 

        T = mean_ke / N; 

        TLabel.setText(format(T, 3)); 

        double p = mean_ke + 0.5 * vcum / ncum; 

        p /= area; 

        pLabel.setText(format(p, 3)); 

         

    } 

 

    void show_positions () { 

 

        mdPicture.clearPicture = true; 

        mdPicture.repaint(); 

 

    } 

 

    void save_config () { 

 

        Frame frame = new Frame("Save Configuration"); 

        FileDialog fileDialog = new FileDialog(frame); 

        fileDialog.show(); 

        String fileName = fileDialog.getFile(); 

        frame.dispose(); 

 

        if (fileName == null) 

            return; 

 

        try { 

 

            PrintWriter pw = new PrintWriter(new FileWriter(fileName)); 

            pw.println(N); 

            pw.println(Lx); 

            pw.println(Ly); 

 

            for (int n = 0; n < N; ++n) 

                pw.println(x[n] + "\t" + y[n] + "\t" + vx[n] + "\t" + vy[n]); 

 

            pw.close(); 

 

        } catch (IOException ioe) { 

 

            System.err.println("Error writing file: " + fileName); 

 

        } 

 

    } 

 

    String str;     // set by load_config() and reset by next_double() 

 

    double next_double () throws NumberFormatException { 

 

        // extract next double from str and convert to double 
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        str = str.trim(); 

        int len = str.length(); 

        char c; 

        int ind = 0; 

        while ( (c = str.charAt(ind)) != ' ' 

                && c != '\t' && ind < len - 1 ) 

            ++ind; 

        String s = str.substring(0, ind); 

        str = str.substring(ind); 

        double d = new Double(s).doubleValue(); 

        return d; 

 

    } 

 

    void load_config () { 

 

        Frame frame = new Frame("Load Configuration"); 

        FileDialog fileDialog = new FileDialog(frame); 

        fileDialog.show(); 

        String fileName = fileDialog.getFile(); 

        frame.dispose(); 

 

        if (fileName == null) 

            return; 

 

        try { 

 

            BufferedReader br = new BufferedReader(new FileReader(fileName)); 

            str = br.readLine().trim(); 

            N = Integer.parseInt(str); 

            str = br.readLine().trim(); 

            Lx = new Double(str).doubleValue(); 

            str = br.readLine().trim(); 

            Ly = new Double(str).doubleValue(); 

 

            if (N > 0) { 

 

                x_initial = new double[N]; 

                y_initial = new double[N]; 

                vx_initial = new double[N]; 

                vy_initial = new double[N]; 

 

            } 

 

            for (int n = 0; n < N; ++n) { 

 

                str = br.readLine().trim(); 

 

                x_initial[n] = next_double(); 

                y_initial[n] = next_double(); 

                vx_initial[n] = next_double(); 

                vy_initial[n] = next_double(); 

 

            } 

 

            br.close(); 

 

        } catch (IOException ioe) { 
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            System.err.println("Error reading file: " + fileName); 

 

        } 

 

        numberLabel.setText("N Particles = " + N); 

        densityLabel.setText("Density = " + format(N / Lx / Ly, 3)); 

        show_positions(); 

 

    } 

 

    MDPicture mdPicture;        // to draw molecule paths 

                                // class MDPicture defined at end of file 

    Button runButton;           // to start and stop motion 

    Button resetButton;         // to reset initial conditions 

    Button saveButton;          // to save configuration in file 

    Button loadButton;          // to load configuration from file 

    Checkbox checkbox;          // to show or hide molecules 

    TextField dtTextField;      // to change time step 

    int stepsToSkip;            // time steps to skip when drawing 

    TextField skipTextField;    // to enter stepsToSkip 

    TextField newTTextField;    // to enter new T 

    Thread runThread;           // animation in a separate thread 

    boolean running;            // animation running or not 

 

    // Applet initialization 

    public void init () { 

 

        add(mdPicture = new MDPicture(this, 400, 400)); 

 

        Panel p = new Panel(); 

        p.setLayout(new GridLayout(12, 2)); 

                     

        p.add(numberLabel = new Label("N Particles = " + N)); 

        p.add(densityLabel = new Label("Density = " + format(N / Lx / Ly, 3))); 

 

        p.add(new Label("Time Steps = ")); 

        p.add(ncumLabel = new Label("      ")); 

 

        p.add(new Label("Time t = ")); 

        p.add(tLabel = new Label("      ")); 

 

        p.add(new Label("Energy E = ")); 

        p.add(ELabel = new Label("      ")); 

 

        p.add(new Label("Temperature <T> = ")); 

        p.add(TLabel = new Label("      ")); 

 

        p.add(new Label("Enter new T:")); 

        p.add(newTTextField = new TextField("")); 

        newTTextField.addActionListener(this); 

 

        p.add(new Label("Pressure <P> = ")); 

        p.add(pLabel = new Label("      ")); 

 

        p.add(new Label("Click in Pic to Clear")); 

               

        p.add(checkbox = new Checkbox("Show Molecules")); 

        checkbox.addItemListener(this); 

 

        p.add(new Label("Enter time step dt:")); 
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        p.add(dtTextField = new TextField("" + dt)); 

        dtTextField.addActionListener(this); 

         

        p.add(new Label("Enter Steps to skip:")); 

         

        p.add(skipTextField = new TextField("0")); 

        skipTextField.addActionListener(this); 

         

        runButton = new Button("Start"); 

        p.add(runButton); 

        runButton.addActionListener(this); 

 

        p.add(resetButton = new Button("Reset")); 

        resetButton.addActionListener(this); 

 

        p.add(saveButton = new Button("Save Config")); 

        saveButton.addActionListener(this); 

 

        p.add(loadButton = new Button("Load Config")); 

        loadButton.addActionListener(this); 

 

        add(p); 

 

        initial();              // simulation initialization 

 

    } 

 

    // must define this to implement ActionListener interface 

    public void actionPerformed (ActionEvent event) { 

 

        String arg = event.getActionCommand(); 

 

        if (arg.equals("Reset")) { 

 

            running = false; 

            try { Thread.sleep(100); } catch (InterruptedException e) { } 

            initial(); 

 

        } else if (arg.equals("Save Config")) { 

 

            running = false; 

            try { Thread.sleep(100); } catch (InterruptedException e) { } 

            save_config(); 

 

        } else if (arg.equals("Load Config")) { 

 

            running = false; 

            try { Thread.sleep(100); } catch (InterruptedException e) { } 

            load_config(); 

            initial(); 

 

        } else if (arg.equals("Start") || arg.equals("Stop")) { 

 

            if (!running) { 

                 

                running = true; 

                runButton.setLabel("Stop"); 

                runThread = new Thread(this); 

                runThread.start(); 
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            } else { 

 

                running = false; 

 

            } 

 

        } else { 

 

            // check text fields for changed values 

             

            if ( event.getSource() == dtTextField ) { 

 

                try { 

 

                    dt = new Double(arg).doubleValue(); 

 

                } catch (NumberFormatException nfe) { 

 

                    dtTextField.setText(format(dt, 3)); 

                     

                } 

 

            } else if ( event.getSource() == skipTextField ) { 

 

                int skip = stepsToSkip; 

                try { 

                     

                    skip = Integer.parseInt(arg); 

                    stepsToSkip = skip; 

             

                } catch (NumberFormatException nfe) { 

                     

                    skipTextField.setText("" + stepsToSkip); 

 

                } 

             

            } else if ( event.getSource() == newTTextField ) { 

 

                double newT = T; 

                try { 

 

                    newT = new Double(arg).doubleValue(); 

 

                } catch (NumberFormatException nfe) { 

 

                    newTTextField.setText(format(T, 3)); 

                     

                } 

 

                double scale = Math.sqrt(newT / T); 

                for (int n = 0; n < N; ++n) { 

 

                    vx[n] *= scale; 

                    vy[n] *= scale; 

 

                } 

 

            } 
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        } 

 

        if (!running) 

            runButton.setLabel("Start"); 

 

    } 

 

    // must define this to implement ItemListener interface 

    public void itemStateChanged (ItemEvent evt) { 

 

        mdPicture.showMolecules = checkbox.getState(); 

        show_positions(); 

 

    } 

 

    // must define this to implement Runnable interface 

    public void run () { 

 

        while (running) { 

 

            runThread.setPriority(Thread.MIN_PRIORITY); 

 

            // skip output for stepsToSkip to make program run faster 

            for (int step = 0; step < stepsToSkip; ++step) { 

                Verlet(); 

                ++ncum; 

                E += ke + pe; 

                kecum += ke; 

                vcum += virial; 

            } 

            Verlet(); 

            mdPicture.repaint(); 

            show_output(); 

 

            try { 

                Thread.sleep(30); 

            } catch (InterruptedException e) { } 

 

        } 

 

    } 

 

    public void paint (Graphics g) { 

 

        mdPicture.repaint(); 

 

    } 

 

    public static void main (String[] args) { 

 

        MDSimulation md = new MDSimulation(); 

  

        Frame aFrame = new Frame("Molecular Dynamics Simulation"); 

  

        // anonymous inner class to destroy window 

        aFrame.addWindowListener(new WindowAdapter () { 

            public void windowClosing(WindowEvent e) { 

                System.exit(0); 

            } 

        }); 
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        aFrame.add(md); 

        md.init(); 

        aFrame.setSize(700, 450); 

        aFrame.setLocation(100, 100); 

        aFrame.setVisible(true); 

  

    } 

 

} 

 

class MDPicture extends Canvas implements MouseListener { 

 

    int xSize, ySize; 

    Color bgColor = new Color(255, 250, 240); 

    MDSimulation md;            // simulation to which this picture belongs 

 

    MDPicture (MDSimulation mds, int dx, int dy) { 

 

        md = mds; 

        xSize = dx; 

        ySize = dy; 

        setSize(xSize, ySize); 

        setBackground(bgColor); 

        addMouseListener(this); 

 

    } 

 

    boolean clearPicture = true; 

 

    // must define the following fucntions to implement MouseListener 

    public void mouseClicked (MouseEvent me) { 

 

        clearPicture = true; 

        repaint(); 

 

    } 

 

    public void mouseEntered (MouseEvent me) { } 

    public void mouseExited (MouseEvent me) { } 

    public void mousePressed (MouseEvent me) { } 

    public void mouseReleased (MouseEvent me) { } 

 

    public void paint (Graphics g) { 

 

        update(g); 

 

    } 

 

    boolean showMolecules;      // draw circles at molecule positions 

    Image offScreen;            // for double buffering to show molecules 

 

    public void update (Graphics g) { 

 

        double xScale = xSize / md.Lx; 

        double yScale = ySize / md.Ly; 

        int scale = (int) Math.round(Math.min(xScale, yScale)); 

        int xMax = (int) Math.round(md.Lx * scale); 

        int yMax = (int) Math.round(md.Ly * scale); 
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        if (offScreen == null) 

            offScreen = createImage(xSize, ySize); 

         

        Graphics gr = offScreen.getGraphics(); 

 

        if (showMolecules) { 

 

            gr.clearRect(0, 0, xSize, ySize); 

            int r = scale / 2; 

            gr.setColor(Color.red); 

            for (int n = 0; n < md.N; ++n) { 

 

                int ix = (int) (md.x[n] * scale); 

                int iy = (int) (md.y[n] * scale); 

                gr.fillOval(ix - r, iy - r, 2 * r, 2 * r); 

 

                // draw periodic images if partly visible on picture 

                if (ix < r) 

                    gr.fillOval(ix + xMax - r, iy - r, 2 * r, 2 * r); 

                if (iy < r) 

                    gr.fillOval(ix - r, iy + yMax - r, 2 * r, 2 * r); 

                if (ix > xMax - r) 

                    gr.fillOval(ix - xMax - r, iy - r, 2 * r, 2 * r); 

                if (iy > yMax - r) 

                    gr.fillOval(ix - r, iy - yMax - r, 2 * r, 2 * r); 

                if (ix < r && iy < r) 

                    gr.fillOval(ix + xMax - r, iy + yMax - r, 2 * r, 2 * r); 

                if (ix < r && iy > yMax - r) 

                    gr.fillOval(ix + xMax - r, iy - yMax - r, 2 * r, 2 * r); 

                if (ix > xMax - r && iy < r) 

                    gr.fillOval(ix - xMax - r, iy + yMax - r, 2 * r, 2 * r); 

                if (ix > xMax - r && iy > yMax - r) 

                    gr.fillOval(ix - xMax - r, iy - yMax - r, 2 * r, 2 * r); 

 

            } 

 

        } else { 

 

            if (clearPicture) { 

 

                gr.clearRect(0, 0, xSize, ySize); 

 

                gr.setColor(Color.lightGray); 

                for (int ix = scale; ix < xMax; ix += scale) 

                    gr.drawLine(ix, 0, ix, yMax); 

                for (int iy = scale; iy < yMax; iy += scale) 

                    gr.drawLine(0, iy, xMax, iy); 

 

                clearPicture = false; 

 

            } 

 

            gr.setColor(Color.red); 

            for (int n = 0; n < md.N; ++n) { 

 

                int ix = (int) (md.x[n] * scale); 

                int iy = (int) (md.y[n] * scale); 

                gr.drawLine(ix, iy, ix, iy); 

 

            } 
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        } 

 

        if (xMax < xSize) 

            gr.clearRect(xMax, 0, xSize, ySize); 

        if (yMax < ySize) 

            gr.clearRect(0, yMax, xSize, ySize); 

        gr.setColor(Color.black); 

        gr.drawRect(0, 0, xMax - 1, yMax - 1); 

 

        g.drawImage(offScreen, 0, 0, null); 

 

    } 

 

} 
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6.3.9 Τπνινγηζκόο ηεο ηηκήο ηνπ  π θαη νινθιεξσκάησλ 

 

Γηα ηνλ ππνινγηζκφ ηνπ π δεκηνπξγνχκε  έλα ηεηαξηνθχθιην αθηίλαο 1, ηνπ νπνίνπ ην εκβαδφ είλαη 

πξνθαλψο π/4.Σν ηεηαξηνθχθιην απηφ βξίζθεηαη κέζα ζε ηεηξάγσλν πιεπξάο 1. Ρίρλνληαο ηπραία 

ζεκεία ζην ηεηξάγσλν, ν αξηζκφο ησλ ζεκείσλ πνπ πέθηνπλ κέζα ζην ηεηαξηνθχθιην πξνο ηνλ αξηζκφ 

ησλ ζεκείσλ πνπ πέθηνπλ κέζα ζην ηεηξάγσλν, δίλεη ην εκβαδφ ηνπ ηεηαξηνθπθιίνπ. 

 
Τινπνίεζε ηνπ αιγφξηζκνπ : 
 

#include <stdafx.h> 

#include <conio.h> 

#include <stdlib.h> //for system("color 0e"); 

 

const float R_Square=RAND_MAX*RAND_MAX; 

 

float monte_carlo_pi(int n) 

//Monte Carlo with n throws 

//Use one quarter of an RAND_MAX radius circle 

{ 

 int hits=0; 

 for(int i=0 ; i<n ; i++) 

 { 

  float x=rand(), y=rand(); 

  if(x*x+y*y<=R_Square) hits++;//inside 

 } 

 return (float)hits/n*4; 

} 

 

void main(void) 

{ 

 system("color 0e");// yellow on black see cmd:help color  

 for(int i=2e3 ; i<=2e4 ; i+=1e3)//2000->20,000 

  printf("%d %f\n",i,monte_carlo_pi(i)); 

 

 printf("\n%1.0e %f\n",1e6,monte_carlo_pi(1e6)); 

 printf("\n%1.0e %f\n",1e7,monte_carlo_pi(1e6)); 

 printf("\n%1.0e %f\n",1e8,monte_carlo_pi(1e6)); 

 printf("\n%1.0e %f\n",1e9,monte_carlo_pi(1e6)); 

 printf("\n%1.0e %f\n",1e10,monte_carlo_pi(1e6)); 

 

 getch(); 
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Δηθφλα 6.10: Γξαθηθή απνηθφληζε ππνινγηζκνχ ηνπ π 

 
Γεληθά  κηα κέζνδνο νινθιήξσζεο Monte Carlo, ππνινγίδεη ην εκβαδφ θάησ απφ κηα θακπχιε. Έηζη 

γηα ηνλ ππνινγηζκφ ηνπ νινθιεξψκαηνο ηεο ζπλάξηεζεο f(x) , ( ).

b

a

I f x dx  ζεσξνχκε έλα 

νξζνγψλην πνπ ζρεκαηίδεηαη απφ x=a, x=b,y=0,y=ymax  φπνπ ymax είλαη ε κέγηζηε ηηκή ηεο f(x) ζην 

δηάζηεκα [a,b]. Σν εκβαδφ ηνπ νξζνγσλίνπ είλαη ymax .(b-a) θαη επνκέλσο ε πηζαλφηεηα φηη έλα ηπραίν 

ζεκείν ζην νξζνγψλην ζα βξίζθεηαη ζηελ επηθάλεηα θάησ απφ ηε θακπχιε, ηζνχηαη κε:   

ymax.(b-a)

I
p . Μεηξψληαο πφζα ζεκεία πέθηνπλ θάησ απφ ηελ f(x) ζε ζρέζε κε ηνλ αξηζκφ ησλ 

ζεκείσλ κέζα ζην νξζνγψλην, ππνινγίδνπκε ηε πηζαλφηεηα p θαη απφ ηελ παξαπάλσ εμίζσζε 

ιχλνπκε σο πξνο Η. Οη Monte Carlo «νινθιεξψζεηο» είλαη ηδηαίηεξα ρξήζηκεο γηα ηνλ ππνινγηζκφ 

νινθιεξσκάησλ γηα ηα νπνία δελ ππάξρεη δπλαηφηεηα αλαιπηηθνχ ππνινγηζκνχ, φπσο π.ρ. ην 

νινθιήξσκα ηεο ζπλάξηεζεο  
2xe . 

Τινπνίεζε ζε C++: 
#include <cmath> 

#include <iostream> 

#include "lib.h" 

using namespace std; 

 

//     Here we define various functions called by the main program   

//     this function defines the function to integrate   

double func(double x); 

//     Main function begins here      

int main() 

{ 

     int i, n; 

     long idum; 

     double crude_mc, x, sum_sigma, fx, variance, exact;  

     printf("Read in the number of Monte-Carlo samples\n"); 

     scanf("%d", &n); 

     crude_mc = sum_sigma=0. ; idum=-1 ;  exact=acos(-1.); 

//   evaluate the integral with a crude Monte-Carlo method     
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     for ( i = 1;  i <= n; i++){ 

           x=ran0(&idum); 

           fx=func(x); 

           crude_mc += fx; 

           sum_sigma += fx*fx; 

      } 

      crude_mc = crude_mc/((double) n ); 

      sum_sigma = sum_sigma/((double) n ); 

      variance=sum_sigma-crude_mc*crude_mc; 

//    final output  

      printf("%d variance= %12.5E Inum= %12.5E pi= %12.5E\n", n, variance, crude_mc, exact);  

      return 0; 

}  // end of main program  

 

// this function defines the function to integrate  

 

double func(double x) 

{ 

  double value; 

  value = 4/(1.+x*x); 

  return value; 

} // end of function to evaluate 

 

 

N I ζN 

10 3,102630E+00 3,988020E-01 

1

100 3,029330E+00 4,048220E-01 

1000 3,133950E+00 4,228810E-01 

10000 3,141950E+00 4,111950E-01 

100000 3,140030E+00 4,141140E-01 

1000000 3,142130E+00 4,138380E-01 

10000000 3,141770E+00 4,135230E-01 

10
9
 3,141620E+00 4,135810E-01 

Πίλαθαο 6.1: Απνηειέζκαηα πξνζνκνίσζεο 
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6.3.10 ΢σκαηίδηα ζε θνπηί . 

Πξνζέγγηζε ηεο θαηάζηαζεο ηζνξξνπίαο-θαηαλόεζε ηεο ζηαηηζηηθήο ζπκπεξηθνξάο-

ηζνξξνπία εμαηηίαο ηπραίσλ γεγνλόησλ 
 

Σν παξάδεηγκα απηφ απνηειεί έλα παξάδεηγκα γηα ηελ εμέιημε ελφο ζπζηήκαηνο πξνο κηα θαηάζηαζε 

ηζνξξνπίαο θαη ην θαηλφκελν κπνξεί λα παξνπζηαζζεί κφλν κε πξνζνκνίσζε ρξεζηκνπνηψληαο φρη 

έηνηκν ινγηζκηθφ αιιά κε γιψζζα πξνγξακκαηηζκνχ. 

Ζ πινπνίεζε γίλεηαη ζε C++ : 

 

// Particles in a box 

#include <iostream> 

#include <fstream> 

#include <iomanip> 

#include "lib.h" 

 

#define IA 16807 

#define IM 2147483647 

#define AM (1.0/IM) 

#define IQ 127773 

#define IR 2836 

#define MASK 123459876 

 

double ran0(long *idum) 

{ 

   long     k; 

   double   ans; 

 

   *idum ^= MASK; 

   k = (*idum)/IQ; 

   *idum = IA*(*idum - k*IQ) - IR*k; 

   if(*idum < 0) *idum += IM; 

   ans=AM*(*idum); 

   *idum ^= MASK; 

   return ans; 

} 

 

using namespace  std; 

 

 

int main(int argc, char* argv[]) 

{ 

//  char *outfilename; 

  int initial_n_particles, max_time, time, random_n, nleft;  

  long idum; 

  

  // Read in data  

  cout << "Initial number of particles = " << endl ; 

  cin >> initial_n_particles; 

  // setup of initial conditions 

  nleft = initial_n_particles; 

  max_time = 10*initial_n_particles; 

  idum = -1; 

  // sampling over number of particles 

  

  ofstream ofile("test.txt"); 
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  for( time=0; time <= max_time; time++){ 

    random_n =  int (initial_n_particles*ran0(&idum)); 

    if ( random_n <= nleft){ 

      nleft -= 1; 

    } 

    else{ 

      nleft += 1; 

    } 

    ofile << setiosflags(ios::showpoint | ios::uppercase); 

    ofile << setw(15) << time; 

    ofile << setw(15) << nleft << endl; 

  } 

  ofile.close(); 

 

  return 0;  

} // end main function 

 

Σν απνηέιεζκα ηεο πξνζνκνίσζεο θαίλεηαη ζηε παξαθάησ εηθφλα. 

 

 
 

Δηθφλα 6.11 : Γξαθηθή απνηθφληζε πξνζνκνίσζεο 
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7 ΠΑΡΟΤ΢ΗΑ΢Ζ – ΑΞΗΟΛΟΓΖ΢Ζ  ΑΠΟΣΔΛΔ΢ΜΑΣΧΝ 
 
΢ην θεθάιαην απηφ δίλνληαη ηα απνηειέζκαηα απφ ηελ έξεπλα πνπ θάλακε γηα ηε ζπκβνιή ησλ 

δηαδηθηπαθψλ ηερλνινγηψλ θαη ηεο ηερλεηήο λνεκνζχλεο ζηελ εθπαίδεπζε θαη ηέινο ζα αμηνινγεζεί ε 

ρξήζε ηνπ θψδηθα γηα ηελ πξνζνκνίσζε ησλ θπζηθψλ θαηλνκέλσλ. Με ιίγα ιφγηα ζα δνζνχλ νη 

απαληήζεηο ζηα εξσηήκαηα πνπ έζεζε ζηελ αξρή απηή ε δηπισκαηηθή εξγαζία. 

7.1 Πξνάγνπλ ηειηθά ηελ ζπλεξγαηηθή κάζεζε ηα Blogs; 

 
Ο ιφγνο πνπ επέιεμα ηα Blogs είλαη ιφγσ ηνπ ηξφπνπ ζρεδηαζκνχ ηνπο. Μειέηεζα εθπαηδεπηηθά site 

ζην δηαδίθηπν θαη ζα παξνπζηάζσ ηα ζπκπεξάζκαηα πνπ έβγαια παξαζέηνληαο ην πην 

ραξαθηεξηζηηθφ Site απφ απηά πνπ κειέηεζα. Να ζεκεηψζσ φηη κειέηεζα «κηθξά» site γηα λα δσ πσο 

απηά αθνινπζνχλ ή φρη θάπνηνπο παηδαγσγηθνχο θαλφλεο. Σν site πνπ ζα αζρνιεζψ θαηά ζχκπησζε 

είλαη θαη Διιεληθφ.   

 

Σν site βξίζθεηαη ζηε δηεχζπλζε http://www.melinet.blogspot.com/  

Όπσο αλαθέξεη ε Μαξηάλλα ην blog απεπζχλεηαη ζε καζεηέο θαη δαζθάινπο. Σνπο δίλεη ηελ επθαηξία 

λα ζπλαληεζνχλ, λα αληαιιάμνπλ απφςεηο ζρεηηθά κε ηελ εκπεηξία κάζεζήο ηνπο, λα θάλνπλ ζρφιηα 

πάλσ ζηελ εξγαζία ηνπο, ζρφιηα γηα ην blog απηφ, γηα ηελ εθπαίδεπζε ή γηα φπνην άιιν ζέκα 

επηζπκνχλ. Έρεη δψζεη ηνλ ηίηιν Weblab ή ζηα ειιεληθά «δηαδηθηπαθφ εξγαζηήξην» 

 

Μειεηψληαο ην blog δηαπίζησζα ηνπο παξαθάησ παηδαγσγηθνχο ζηφρνπο:  

 ΢ηελ πξψηε ζειίδα δεκνζηεχεη αηνκηθέο εξγαζίεο ή πφζηεξο. Δίλαη κηα θίλεζε πνπ 

δεκηνπξγεί ζεηηθφ θίλεηξν γηα ελεξγφ ζπκκεηνρή ζην blog. Δίλαη ζεκαληηθφ, γηα φινπο καο 

πηζηεχσ, ε δνπιεηά πνπ θάλνπκε λα δεκνζηεχεηαη θαη λα κπνξνχλ λα ηε δνπλ θαη λα ηελ 

ζρνιηάζνπλ άιινη. (εηθφλα 7.1) 

 Σν blog παξέρεη ζχλδεζε κε άιια εθπαηδεπηηθά site. 

 ΢πλδέεη ην blog κε ηηο δξαζηεξηφηεηεο πνπ ιακβάλνπλ ρψξα κέζα ζηελ ηάμε. 

 Δλζαξξχλεη ηελ επηθνηλσλίαο κε αζχγρξνλν ηξφπν κεηαμχ εθπαηδεπηηθνχ θαη καζεηή 

 Δλζαξξχλεη ηε ζπλεξγαζία ζε νκάδεο  

 Δλζαξξχλεη ηε ζπκκεηνρή ζηελ παξαγσγή εξγαζηψλ είηε ζε αηνκηθφ είηε ζε νκαδηθφ επίπεδν 

(ζπγγξαθή έξγνπ κφλνο ή κε ζπλεξγάηε, εηθφλα 7.2)  

 Γίλεη ηε δπλαηφηεηα νη καζεηέο λα πξνβάιινπλ ηηο πξνηηκήζεηο ηνπο κέζα απφ ηα ζρφιηα.  

 Δπηδηψθεη ηε βειηίσζε ησλ δεμηνηήησλ παξαγσγήο αιιά θαη θαηαλφεζεο ηνπ γξαπηνχ ιφγνπ 

αθνχ ηνπο δεηείηαη θαη λα δηαβάζνπλ έλα θείκελν αιιά θαη λα γξάςνπλ έλα δηθφ ηνπο. (εηθφλα 

7.3)  

http://www.melinet.blogspot.com/
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 Υξεζηκνπνηψληαο ηελ ηερλνινγία πεηπραίλεη ηε βειηίσζε ησλ δεμηνηήησλ ρξήζεο ηνπ Ζ/Τ.  

 Βειηηψλεη επίζεο ηελ δεμηφηεηα πινήγεζεο ζην δηαδίθηπν γηα ζπγθεθξηκέλνπο ζθνπνχο. 

 

 

Δηθφλα 7.1 
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Δηθφλα 7.2 

 

 

Δηθφλα 7.3 
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Γηα λα πεηχρεη έλα blog ηνλ εθπαηδεπηηθφ ηνπ ζθνπφ δελ ρξεηάδνληαη, φπσο είδακε παξαπάλσ, πνιιά 

πξάγκαηα. Υξεηάδεηαη έλαο ζσζηφο εθπαηδεπηηθφο ζρεδηαζκφο θαη θίλεηξα γηα ζπκκεηνρή ησλ 

καζεηψλ. Δίλαη ζην ρέξη ηνπ εθάζηνηε «ζπληάθηε» - «ζρεδηαζηή»  ελφο καζήκαηνο αλ ζα 

δεκηνπξγήζεη θίλεηξα ζηνπο καζεηέο, ηη πιηθφ ζα ηνπο δψζεη, πσο ζα ηνπο βάιεη λα δνπιέςνπλ θαη ηη 

είδνπο θαζνδήγεζε ζα ηνπο πξνζθέξεη. Μπνξεί εχθνια κέζα απφ ηα Blogs λα αλαδείμεη ηελ 

ζπλεξγαζία κάζεζε, θαη λα βειηηψζεη ηελ δεμηφηεηα παξαγσγήο θεηκέλνπ. Σα blogs, κε βάζεη ηνπ ηη 

πξνζθέξνπλ, κπνξνχλ λα ρξεζηκνπνηεζνχλ κε πνιχ κεγάιε επηηπρία ζε καζήκαηα ινγνηερλίαο θαη 

ζηελ εθκάζεζε ηεο γιψζζαο ή μέλσλ γισζζψλ. Δηδηθά γηα ηελ εθκάζεζε γισζζψλ κε ρξήζε ησλ 

blogs (H/Y) ππάξρνπλ ηξεηο θάζεηο: δνκηθή, γλσζηηθή, θαη θνηλσληθν-γλσζηηθή , πνπ ραξαθηεξίδνπλ 

ηε κεηαηφπηζε απφ ην πεξηερφκελν ησλ πξνγξακκάησλ ησλ ππνινγηζηψλ ζην πεξηερφκελν ηεο 

άλζξσπν-κε-άλζξσπν αιιειεπίδξαζεο (Warschauer & Kern, 2000). Σα Blogs βνεζνχλ ζηελ 

εθκάζεζε ηεο γιψζζαο κέζσ ηεο βησκαηηθήο εκπεηξίαο ησλ καζεηψλ πνπ ηνπο νδεγεί ζε πεξαηηέξσ 

αθαδεκατθή επηηπρία. Οη Friere, Cummins θαη Roessingh (έξεπλα Douglas , 2006) έρνπλ σο ην 

βαζηθφηεξν θιεηδί γηα ηελ εθκάζεζε ηελ πξνζδηνξηζκέλε βησκαηηθή εκπεηξία ηνπ καζεηή. Οη 

δάζθαινη δελ πξέπεη, ζηε βηαζχλε ηνπο λα επηηχρνπλ ηνλ αθαδεκατθφ ζηφρν, λα απνθχγνπλ λα 

δψζνπλ ηελ επθαηξία ζηνπο καζεηέο ηνπο λα εθθξαζηνχλ ζε έλα βαζηθφ δηαπξνζσπηθφ επίπεδν. Σα 

Blogs δίλνπλ απηή ηε δπλαηφηεηα θαη κάιηζηα πνιχ πεηπρεκέλα.      

7.2 Μπνξεί ε ηερλεηή λνεκνζύλε λα ζπκβάιεη ζηελ θαηαλόεζε ησλ 

θαηλνκέλσλ ησλ θπζηθώλ επηζηεκώλ; 

 
΢χκθσλα κε ηελ ππάξρνπζα βηβιηνγξαθία νη πεξηζζφηεξνη εξεπλεηέο ηείλνπλ λα ζπκθσλήζνπλ φηη , 

κε ηελ ζσζηή πξνεηνηκαζία ησλ καζεκάησλ θαη ηελ βειηίσζε ηνπ ηξφπνπ πξνζνκνίσζεο ησλ 

πξνβιεκάησλ ησλ θπζηθψλ επηζηεκψλ, ε ρξήζε ηεο ηερλεηήο λνεκνζχλεο ζηελ εθπαίδεπζε βνεζάεη 

ζεκαληηθά. Απηά ηα ζπζηήκαηα e-learning είλαη κεγάια θαη ελζσκαηψλνπλ ηελ ππνινγηζηηθή ηερλεηή 

λνεκνζχλε ρξεζηκνπνηψληαο επθπείο πξάθηνξεο. Σέηνηα ζπζηήκαηα νλνκάδνληαη Μπαυεζηαλά 

δίθηπα.  

Ο Kwong (2000) φπσο έρσ πξναλαθέξεη είρε λα αληηκεησπίζεη ηα παξαδνζηαθά πεηξάκαηα ηεο 

θπζηθήο ζηελ β/βάζκηα εθπαίδεπζε. Απηά ηα πεηξάκαηα είλαη ζπρλά βαξεηά θαη ηηο πεξηζζφηεξεο 

θνξέο δελ πεηπραίλνπλ ηνπο εθπαηδεπηηθνχο ηνπο ζηφρνπο γηα ηνπο πεξηζζφηεξνπο ζπνπδαζηέο. Απηή 

ηελ «πξνβιεκαηηθή» κάζεζε πξνζπάζεζε λα ιχζε κε  ρξήζε ινγηζκηθνχ αλάιπζεο ζηνηρείσλ ζε 

έλαλ πξνζσπηθφ ππνινγηζηή. Έηζη πξνρψξεζε ζε έλα απηνκαηνπνηεκέλν πείξακα. Υξεζηκνπνηψληαο 

ηα εξγαιεία απεηθφληζεο θαη ηα εξγαιεία αλάιπζεο ζηνηρείσλ νη ζπνπδαζηέο κπνξνχλ λα 

παξαηεξήζνπλ ηελ επηβεβαίσζε ή ηελ αλαηξνπή ησλ ππνζέζεσλ πνπ γίλνληαλ θαηά ηε δηάξθεηα ησλ 

πεηξακάησλ. Δλεξγψληαο φπσο νη επηζηήκνλεο, κπνξνχλ λα δηαηππψζνπλ ηηο επηζηεκνληθέο ηνπο 

ππνζέζεηο ρξεζηκνπνηψληαο ηα καζεκαηηθά πξφηππα θαη λα εμεηάζνπλ – εξεπλήζνπλ ηηο ππνζέζεηο 

ηνπο  κε ηε ζχγθξηζε ησλ πεηξακαηηθψλ ζηνηρείσλ.  
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Οη Pattnaik et al. (1986) έθαλαλ κηα πξνζπάζεηα λα ζπλδέζνπλ παηδαγσγηθά ραξαθηεξηζηηθά  κε ηελ 

ρξήζε ηεο ηερλνινγίαο γηα ηελ δηδαζθαιία ηεο θπζηθήο. Ζ πξφζθαηε έθξεμε ζε πξνγξάκκαηα 

ηερλεηήο λνεκνζχλεο θέξλεη κηα απνιχησο λέα θαηεγνξία εξγαιείσλ ππνινγηζκνχ θαη 

θαηαδεηθλχνπλ ηε ρξεζηκφηεηα ηνπ αιγεβξηθνχ πξνγξακκαηηζκνχ κε ηελ παξνπζίαζε ελφο 

ζπγθεθξηκέλνπ παξαδείγκαηνο ζηελ έξεπλα ηεο θπζηθήο ζηεξεάο θαηάζηαζεο . Σα πιενλεθηήκαηα 

απηήο ηεο κεζφδνπ απεδείρζε φηη ήηαλ είλαη πνιιαπιά αθνχ ειαρηζηνπνηήζεθαλ νη πηζαλφηεηεο ηνπ 

ιάζνπο ζηελ θαηαγξαθή εμηζψζεσλ απφ ηνπο εθπαηδεπφκελνπο. Παξάιιεια νη εθπαηδεπφκελνη 

εμνηθεηψζεθαλ  κε ηνλ πξνγξακκαηηζκφ ζε γιψζζεο φπσο  REDUCE. Ζ ηερλεηή λνεκνζχλε κπνξεί 

λα εμαιείθεη ηε δπζρέξεηα κεηαμχ ηεο ζχιιεςεο κηαο ιχζεο ζε έλα πξφβιεκα θαη ηεο εθηέιεζήο ηεο, 

θαη λα δίλεη ζην ζπνπδαζηή θαη ζηνλ εξεπλεηή πεξηζζφηεξν ρξφλν λα ζθεθηεί θαη λα κάζεη, θαζψο 

επίζεο δίλεη θαη ηε δπλαηφηεηα λα επηιπζνχλ  πξνβιήκαηα κεγαιχηεξεο πνιππινθφηεηαο.  

Οη Amorim et al. (2004)  αζρνιήζεθαλ κε ηνλ γελεηηθφ αιγφξηζκν ν νπνίνο είλαη έλαο απφ ηνπο 

επηηπρέζηεξνπο ηξφπνπο γηα λα ιπζνχλ δχζθνια ζπλδπαζηηθά πξνβιήκαηα. Οη δηαδηθαζίεο πνπ 

πεξηγξάθνληαη ζην άξζξν ηνπο θαηαδεηθλχνπλ πψο νη έλλνηεο πνπ πξνέξρνληαη απφ ηα καζεκαηηθά, 

ηνπο ππνινγηζηέο θαη ηε βηνινγία  κπνξνχλ λα ρξεζηκνπνηεζνχλ γηα λα ιχζνπλ πνιιά δηαθνξεηηθά 

πξνβιήκαηα. ΢ε απηήλ ηελ εξγαζία, εμεηάδεηαη έλα πξφβιεκα ζρεδίαζεο ελφο ηειεζθφπηνπ. Οη 

έλλνηεο ηεο θπζηθήο, ησλ καζεκαηηθψλ, ηεο βηνινγίαο θαη ησλ ππνινγηζηψλ εηζάγνληαη, 

ρξεζηκνπνηνχληαη θαη κεηαηξέπνληαη ζε έλα θαιφ παξάδεηγκα ηεο δηεπηζηεκνληθήο δηδαζθαιίαο. 

Γεληθά, νη ζπνπδαζηέο  παξαθηλνχληαη εάλ νη πξαθηηθέο εθαξκνγέο ηεο δηδαζθαιίαο ησλ ζεκάησλ 

παξνπζηάδνληαη, κπνξνχλ λα πινπνηεζνχλ άκεζα θαη ζηελ πξάμε. ΢ηε ζπγθεθξηκέλε πεξίπησζε, ε 

πξφζεζε ηεο έξεπλαο ήηαλ λα πξνηείλεη πψο νη έλλνηεο απφ ηε θπζηθή, ηα καζεκαηηθά, ηνλ 

ππνινγηζκφ θαη ηε βηνινγία ζα κπνξνχζαλ λα ρξεζηκνπνηεζνχλ γηα λα ιχζνπλ πνιιά δηαθνξεηηθά 

πξνβιήκαηα. Καη ην πξφβιεκα θαη ε κέζνδνο ιχζεο πνπ πεξηγξάθεηαη ζε απηήλ ηελ εξγαζία 

ζπζρεηίδνληαη κε απηνχο ηνπο ηνκείο ηεο γλψζεο. Ζ κέζνδνο ιχζεο πνπ πεξηγξάθεηαη είλαη έλαο 

γελεηηθφο αιγφξηζκνο, ν νπνίνο αλήθεη ζηελ ηερλεηή λνεκνζχλε θαη αλ θαη ν αιγφξηζκνο πνπ 

παξνπζηάδεηαη είλαη εμαηξεηηθά απιφο, απφ ηελ άπνςε βειηηζηνπνίεζεο, εηζάγεη ην ζπνπδαζηή ζε  

έλλνηεο ηεο βηνινγίαο, ησλ καζεκαηηθψλ θαη ηνπ ππνινγηζκνχ.  

7.3 Οη έηνηκεο πιαηθόξκεο Σ.Ν. βνεζνύλ ηνπο εθπαηδεπηηθνύο λα 

ζρεδηάδνπλ καζήκαηα πνπ αλαπηύζζνπλ ηελ θξηηηθή ηθαλόηεηα ησλ 

καζεηώλ ηνπο; 

Οη έηνηκεο πιαηθφξκεο απαιιάζζνπλ ηνπο εθπαηδεπηηθνχο απφ αξθεηέο δπζθνιίεο θαηά ηελ εηνηκαζία 

ηεο εθπαηδεπηηθήο δξαζηεξηφηεηαο. Οη έηνηκνη νδεγνί θαζψο επίζεο θαη ηα εγθαηεζηεκέλα εξγαιεία 

δίλνπλ ζεκαληηθφ πιενλέθηεκα ζηνλ εθπαηδεπηηθφ πνπ ηα ρξεζηκνπνηεί. Φπζηθά ην κεηνλέθηεκά ηνπο 

βξίζθεηαη ζηελ δπλαηφηεηα αλαπαξάζηαζεο πξνβιεκάησλ πνπ δελ ππνζηεξίδνληαη απφ ηα ππάξρνληα 

εξγαιεία. ΢ήκεξα ππάξρνπλ δχν κεγάια ζπζηήκαηα πνπ ππνζηεξίδνπλ ηελ ηερλεηή λνεκνζχλε ζην 
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ρψξν ηεο θπζηθήο. Σν Andes θαη ην PHYSIMC. Βξήθα αξθεηέο κειέηεο πάλσ ζηα δχν ζπζηήκαηα. 

Όιεο είραλ πνιιά θνηλά ζεκεία γη’ απηφ ην ιφγσ επέιεμα λα παξνπζηάζσ κία απφ θάζε ζχζηεκα.  

Ζ πξψηε κειέηε πνπ έθαλα ήηαλ ησλ VanLehn θαη άιισλ (2005) νη νπνίνη αλαθέξνπλ φηη ην ζχζηεκα 

Andes αλαδεηθλχεη φηη ε καζεζηαθή δπλαηφηεηα ησλ ζπνπδαζηψλ κπνξεί λα απμεζεί ζεκαληηθά κφλν 

κε ηελ αλαβάζκηζε ηεο ππνζηήξημεο θαηά ηε δηάξθεηα επίιπζεο πξνβιεκάησλ ησλ εθπαηδεπφκελσλ. 

Αλ θαη ην Andes απνθαιείηαη  επθπέο ζχζηεκα παξάδνζεο καζεκάησλ, αληηθαζηζηά πξαγκαηηθά κφλν 

ην κνιχβη θαη ην ραξηί ησλ ζπνπδαζηψλ δεδνκέλνπ φηη  κφλν απηνί επηιχνπλ πξνβιήκαηα. Οη 

ζπνπδαζηέο θάλνπλ ηα ίδηα πξνβιήκαηα κε πξηλ, κειεηνχλ ην ίδην εγρεηξίδην, θαη παξεπξίζθνληαη ζηηο 

ίδηεο δηαιέμεηο, ηα εξγαζηήξηα θαη ηηο παξαδφζεηο. Πέληε έηε έξεπλαο έδεημαλ φηη ην ζχζηεκα Andres 

βειηηψλεη ζεκαληηθά ηελ καζεζηαθή ηθαλφηεηα ησλ ζπνπδαζηψλ. Σν θχξην ραξαθηεξηζηηθφ ηνπ 

ζπζηήκαηνο Andres εκθαλίδεηαη λα είλαη ε πςεινχ επηπέδνπ αιιειεπίδξαζε κε ην ρξήζηε. 

Δθηηκψληαο φηη ηα πεξηζζφηεξα ζπζηήκαηα παξάδνζεο καζεκάησλ παξέρνπλ ζηνπο ζπνπδαζηέο ηελ 

δπλαηφηεηα λα εηζαγάγνπλ κφλν ηελ απάληεζε ζε έλα πξφβιεκα, ην Andes δίλεη ηε δπλαηφηεηα ζηνπο 

ζπνπδαζηέο λα εηζαγάγνπλ νιφθιεξε κηα παξαγσγή ζπιινγηζκνχ, ε νπνία κπνξεί λα απνηειείηαη απφ 

πνιιά βήκαηα, φπσο ην ζρεδηαζκφ δηαλπζκάησλ, νξηζκφ κεηαβιεηψλ, θαηαγξαθή εμηζψζεσλ θιπ. 

΢ην Andes παξέρεηαη ε δπλαηφηεηα γηα  αλαηξνθνδφηεζε κεηά απφ θάζε βήκα. Όηαλ ν ζπνπδαζηήο 

δεηά ηε βνήζεηα ζηε κέζε ηεο επίιπζεο πξνβιήκαηνο, ην Andes δίλεη βνήζεηα ζε πνην ζεκείν ππάξρεη 

ιαλζαζκέλν ή αλαθξηβέο βήκα ή πνην είδνο βήκαηνο πξέπεη λα θάλεη κεηά. Οη πνιιαπιέο 

αμηνινγήζεηο δείρλνπλ φηη ην Αndes είλαη απνηειεζκαηηθφ ελψ  ην  θφζηνο δαπάλεο είλαη ρακειφ. 

Ζ δεχηεξε ησλ Jane Yung-jen θαη Chien-Jung Ting (1998) νη νπνίνη ρξεζηκνπνίεζαλ ηελ εθαξκνγή 

PHYSIMC, ε νπνία ππνζηεξίδεη ηε δνκεκέλε εθκάζεζε ηεο ζηνηρεηψδνπο θπζηθήο κέζα απφ έλα 

πεξηβάιινλ πξνζνκνίσζεο ζε έλαλ ππνινγηζηή. Σν ζχζηεκα PHYSIMC δηεπθνιχλεη ηελ επίιπζε 

πξνβιήκαηνο θπζηθήο κε ηελ παξνρή: 

 κηαο θηιηθήο πξνο ην ρξήζηε δηεπαθήο γηα ηελ πξνδηαγξαθή πξνβιήκαηνο κέζσ  ηνπ άκεζνπ 

ρεηξηζκνχ ησλ θπζηθψλ αληηθεηκέλσλ,  

 κηαο 2-Γ πξνζνκνίσζεο θηλήζεσλ ησλ θπζηθψλ αληηθεηκέλσλ,  

 κηα βηβιηνζήθεο πεξίπησζεο ησλ επηηπρψλ επεηζνδίσλ επίιπζεο πξνβιήκαηνο, θαη 

 ελφο  εξγαιείνπ αλαζθφπεζεο γηα ηα ζρεηηθά πξνβιήκαηα θαη ηηο αληίζηνηρεο ιχζεηο   ηνπο.  

Καηά ζπλέπεηα, έλαο ζπνπδαζηήο κπνξνχζε λα ρξεζηκνπνηήζεη ηελ πξνεγνχκελε εκπεηξία επίιπζεο 

πξνβιήκαηνο ζηελ πξνζπάζεηά ηνπ λα δψζεη ηε ιχζε ζε έλα λέν πξφβιεκα.  
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7.4 Τπάξρνπλ δηαζέζηκεο ειεύζεξεο εθαξκνγέο ή πξνγξάκκαηα πνπ λα 

εμππεξεηνύλ ηνπο δηδαθηηθνύο ζθνπνύο ή ζα πξέπεη ν εθπαηδεπηηθόο 

λα θηηάμεη δηθό ηνπ θώδηθα;  

΢ην δηαδίθηπν ππάξρεη πιεζψξα εθπαηδεπηηθψλ πξνγξακκάησλ είηε ειεχζεξνπ ινγηζκηθνχ είηε φρη. 

Θα εζηηάζσ ηελ πξνζνρή κνπ ζην ειεχζεξν ινγηζκηθφ. Οη ιφγνη είλαη δχν, εθηφο θπζηθά ηνπ φηη είλαη 

δσξεάλ, ππάξρεη θαιή ηεθκεξίσζε θαη δίλεηαη ε δπλαηφηεηα γηα επεμεξγαζία θαη βειηίσζε ηνπ ήδε 

ππάξρνληα θψδηθα. Ζ έξεπλα πνπ έθαλα αθνξά εθαξκνγέο ζε γιψζζα Java, απηά φπσο είδακε 

νλνκάδνληαη applets θαη javascripts. Δλδεηθηηθέο αμηφπηζηεο πεγέο γηα πξνζνκνίσζε θαηλνκέλσλ θαη 

ζεσξηψλ ησλ θπζηθψλ επηζηεκψλ πνπ κπνξνχλ λα ρξεζηκνπνηεζνχλ απ’ φινπο είλαη : 

http://www.cc.uoa.gr/~ctrikali/aplets_web/fysiki_i/p11e0105/phe/phe.htm 

http://www.lon-capa.org/~mmp/applist/applets.htm 

http://www.mip.berkeley.edu/physics/appletindex.html 

http://galileoandeinstein.physics.virginia.edu/more_stuff/Applets/ 

http://users.sch.gr/pazoulis/stage/index.htm 

http://www.physics.ntua.gr/~konstant/p102/vlab/ 

http://www.falstad.com/mathphysics.html 

http://physics.uwstout.edu/physapplets/ 

http://www.ngsir.netfirms.com/englishVersion.htm 

http://www.ph.utexas.edu/~phy-demo/resources/phys_applets.html 

http://science.uniserve.edu.au/school/curric/stage6/phys/physapplets.html 

http://www.phy.ntnu.edu.tw/java/index.html (styl blog) 

http://www.its.caltech.edu/~phys1/java.html 

http://mysite.verizon.net/vzeoacw1/applet_menu.html 

http://www.schulphysik.de/suren/Applets.html 

http://www.phys.hawaii.edu/~teb/optics/index.html 

http://www.quantum-physics.polytechnique.fr/ (platforma) 

http://www.geocities.com/SiliconValley/Lakes/3015/physicsRef.html 

http://webphysics.davidson.edu/Applets/Applets.html 

http://www.myphysicslab.com/ 

Σα πξνγξάκκαηα απηά γηα λα «ηξέμνπλ» ρξεηάδεηαη λα είλαη εγθαηαζηεκέλε ε κεραλή java ε νπνία 

δηαλέκεηαη δσξεάλ απφ ηελ εηαηξία Sun (www.java.com). Δάλ δελ ππάξρεη, κφιηο θάπνηνο ζειήζεη λα 

ηα ηξέμεη κηα εθαξκνγή θαη ην ζχζηεκά ηνπ δελ ππνζηεξίδεη ηε ζπγθεθξηκέλε έθδνζε, εκθαλίδεηαη 

κήλπκα ην νπνίν ηνλ πξνηξέπεη λα θάλεη εγθαηάζηαζε ηελ εθαξκνγή java πξνθεηκέλνπ λα 

εθηειεζηνχλ ηα πξνγξάκκαηα απηά. 

Σα παξαπάλσ site είλαη ελδεηθηηθά αθνχ ππάξρνπλ πεξίπνπ 52600 ζειίδεο (30/8/2008) κε applets γηα 

ην κάζεκα ηεο θπζηθήο. 
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Ζ ρξήζε ησλ πξνγξακκάησλ είλαη εμαηξεηηθά απιή θαη ππνζηεξίδνπλ γξαθηθφ πεξηβάιινλ. Κάλνπλ 

αλαπαξάζηαζε ζπγθεθξηκέλεο ζεσξίαο θαη αλ δελ δίλεηαη ν πεγαίνο θψδηθαο αιιαγέο κπνξεί λα 

γίλνπλ κφλν ζηηο παξακέηξνπο ηεο ζεσξίαο ή ηνπ πξνβιήκαηνο. Σα ζπγθεθξηκέλα πξνγξάκκαηα 

νπηηθνπνίεζε ηα θαηλφκελα θαη ηηο ζεσξίεο θαη ζπκβάιινπλ ζηελ θαηαλφεζε απηψλ. Απφ ηε ζηηγκή 

πνπ είλαη ειεχζεξα ν καζεηήο κπνξεί λα αλαηξέμεη ζε απηά νπνηαδήπνηε ζηηγκή ζειήζεη είηε online 

ζην δηαδίθηπν είηε θαηεβάδνληάο ηα ζηνλ ππνινγηζηή ηνπ θαη εθηέιεζή ηνπο απφ εθεί.  

7.5 Μπνξνύλ νη εθπαηδεπόκελνη από κόλνη ηνπο λα δεκηνπξγήζνπλ 

γξαθηθέο παξαζηάζεηο ησλ ζεσξηώλ ησλ θπζηθώλ επηζηεκώλ;  

   
Σε ζεκεξηλή επνρή φιν θαη πεξηζζφηεξνη λένη θαη λέεο ρξεζηκνπνηνχλ ηνπο ππνινγηζηέο. Απηφ φκσο 

δελ ηνπο θάλεη πξνγξακκαηηζηέο. Οη καζεηέο πνπ επηζπκνχλ λα δεκηνπξγήζνπλ δηθά ηνπο 

παξαδείγκαηα ή πξνζνκνηψζεηο πάλσ ζηηο θπζηθέο επηζηήκεο ζα πξέπεη είηε λα θαηαθχγνπλ ζε κία 

έηνηκε πιαηθφξκα φπσο ην Andres ή ην Physlets ή λα αλαηξέμεη ζηα πξνγξάκκαηα Interactive 

Physics, Modellus ή Crocodile Physics (Δίλαη πξνγξάκκαηα πνπ έρσ κειεηήζεη θαηά ηε δηάξθεηα ηνπ 

κεηαπηπρηαθνχ). Έρνπλ φκσο ηε δπλαηφηεηα καζαίλνληαο βαζηθά πξάγκαηα πάλσ ζηηο γιψζζεο 

πξνγξακκαηηζκνχ είηε λα δεκηνπξγήζνπλ ηελ δηθή ηνπο πξνζνκνίσζε είηε λα επεμεξγαζηνχλ κία 

ππάξρνπζα πξνθεηκέλνπ λα θηηάμνπλ έλα δηθφ ηνπο κνληέιν ή λα εξεπλήζνπλ κηα ππφζεζε. 

Πξνο απηή ηελ θαηεχζπλζε ππάξρνπλ δηαδηθηπαθά site ηα νπνία δίλνπλ πιεξνθνξίεο θαη ηε 

κεζνδνινγία πξνθεηκέλνπ έλαο αξράξηνο βήκα-βήκα λα θηάζεη ζην επηζπκεηφ γη’ απηφλ απνηέιεζκα. 

Έλα ηέηνην site είλαη θαη ην: http://www.particle.kth.se/~fmi/ kurs/PhysicsSimulation/Lectures/ 

LectureTable.html. Μέζα απφ απηφ ην site ν νπνηνζδήπνηε κπνξεί βήκα-βήκα λα μεθηλήζεη ηελ επαθή 

ηνπ κε ηελ γιψζζα java θαη ζηγά-ζηγά λα αξρίζεη λα δεκηνπξγεί κφλνο ηνπο εθαξκνγέο.  

΢ηελ έξεπλα πνπ έθαλα είδα φηη αξθεηά εθπαηδεπηηθά site αλάινγα κε ην επίπεδν πνπ βξίζθνληαη 

(πξσηνβάζκηα, δεπηεξνβάζκηα ή ηξηηνβάζκηα ) παξέρνπλ θαηάιιειεο πιεξνθνξίεο. Γηα παξάδεηγκα, 

γηα καζεηέο δεκνηηθνχ δεηείηαη λα ηξέμνπλ κηα ζπγθεθξηκέλε εθαξκνγή θαη λα θαηαγξάςνπλ ηα 

απνηειέζκαηα ζχκθσλα κε ηηο απαηηήζεηο ηνπ πξνβιήκαηνο, θακία πξνγξακκαηηζηηθή ελέξγεηα, γηα 

καζεηέο ηεο δεπηεξνβάζκηαο κπνξεί λα δίλεηαη κέξνο ηνπ θψδηθα θαη νη καζεηέο απιά έρνπλ λα 

ζπκπιεξψζνπλ θάπνην θνκκάηη ή λα έρνπλ λα ζρνιηάζνπλ ηε ιεηηνπξγία θάπνηνπ ηκήκαηνο θαη ζην 

ηέινο λα εθηειέζνπλ ην πξφγξακκα θάησ απφ δηαθνξεηηθέο ζπλζήθεο θάζε θνξά θαη λα 

παξνπζηάζνπλ γξαθηθά ηα απνηειέζκαηα είηε κε ηε κνξθή δηαγξακκάησλ είηε κε ηε κνξθή πηλάθσλ. 

Σέινο γηα ηελ ηξηηνβάζκηα κπνξεί απιά λα δίλεηαη κέξνο θψδηθα θαη λα απαηηείηαη ε ζπκπιήξσζή ηνπ 

ή λα δίλεηαη ην πξφβιεκα «ινγηθά» θαη λα απαηηείηαη ν ζρεδηαζκφο θαη ε πινπνίεζε ηνπ 

πξνγξάκκαηνο αλάινγα κε ηηο ζεκαηηθέο ελφηεηεο ηηο ζρνιήο. 

΢ηελ παξνχζα εξγαζία ην ηκήκα ηνπ θψδηθα ην νπνίν δεκηνχξγεζα αλήθεη ζηελ πξψηε θαηεγνξία 

δειαδή, ππήξρε θψδηθαο ν νπνίνο δελ έηξερε. Έπξεπε λα βξσ ηη ιάζε ππήξραλ λα ηα δηνξζψζσ θαη λα 

ζπκπιεξψζσ ηκήκαηα πνπ έιιεηπαλ.   
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΢ηελ δηάξθεηα ηνπ κεηαπηπρηαθνχ καο παξνπζηάζηεθαλ νη έηνηκεο πιαηθφξκεο Interactive Physics, 

Modellus φπνπ δηαβάδνληαο ηηο νδεγίεο ρξήζεηο ηνπ πξνγξάκκαηνο αιιά θαη χζηεξα απφ ηελ επίδεημε 

ηνπ θαζεγεηή γηα ηε θηινζνθία θαη ηηο δπλαηφηεηεο ησλ πξνγξακκάησλ καο δεηήζεθε λα 

πεηξακαηηζηνχκε θαη λα εθηειέζνπκε θάπνηα πεηξάκαηα. Ζ φιε δηαδηθαζία γηα κέλα πξνζσπηθά ήηαλ 

άθξσο δηαζθεδαζηηθή. Ξεθηλψληαο απιά απφ έλα θηβψηην πνπ έπεθηε άξρηδεο λα καζαίλεηο ηνλ λφκν 

ηεο βαξχηεηαο. Παίδνληαο κε ηηο παξακέηξνπο, βάξνο, αληίζηαζε αέξα, πεηξακαηηδφκνπλ γηα ην ηη 

ίζρπε θάζε θνξά. Έθαλα ζπγθξίζεηο ζε ζπλζήθεο απψιεηαο βαξχηεηαο ή έθαλα κεηξήζεηο ρξφλνπ 

πηψζεηο αλάινγα κε ηε βαξχηεηα πνπ ππάξρεη ζε δηαθνξεηηθφ πςφκεηξν. Έλα παηρλίδη πνπ παξάγεη 

γλψζε. 

Μέζα απφ απηήλ ηελ εκπεηξία κνπ κπνξψ λα πσ φηη ην ίδην κπνξνχλ λα θάλνπλ θαη νη καζεηέο. Αθνχ 

«κάζνπλ» πνηνο είλαη ν ζηφρνο ηνπ καζήκαηνο θαη πνπ πξέπεη λα εζηηάζνπλ ηελ πξνζνρή ηνπο, κε 

ιίγα ιφγηα λα γίλεη ν παηδαγσγηθφο ζρεδηαζκφο, ηφηε κπνξνχλ είηε αηνκηθά είηε νκαδηθά λα 

δνπιέςνπλ θαη λα βγάινπλ ηα ζπκπεξάζκαηά ηνπο πνπ είηε ζα ζηεξίμνπλ ηελ αξρηθή ηνπο ππφζεζε 

είηε ζα ηελ αλαηξέςνπλ.  

7.6 Γηαηί λα επηιέμνπκε ηελ γιώζζα πξνγξακκαηηζκνύ Java θαη όρη ηελ 

C++ ή ηε Fortran γηα ηηο πξνζνκνηώζεηο εθπαηδεπηηθώλ εθαξκνγώλ 

ζην δηαδίθηπν; 

΢ηελ ηξέρνπζα δηπισκαηηθή εξγαζία έρεη δεκηνπξγεί θψδηθαο θαη ηελ πξνζνκνίσζε ζεσξηψλ θαη 

θαηλνκέλσλ ησλ θπζηθψλ επηζηεκψλ. Έγηλε επηινγή ζπγθεθξηκέλσλ γισζζψλ πξνγξακκαηηζκνχ 

πξνθεηκέλνπ λα γίλεη ε πινπνίεζε ηνπ έξγνπ. Όπσο έρσ αλαθέξεη ζε πξνεγνχκελν θεθάιαην νη 

γιψζζεο πνπ επηιέρζεθαλ είλαη ε Java, C++ θαη Fortran 90. Ζ επηινγή δελ έγηλε ηπραία. Οη ηξεηο 

απηέο γιψζζεο ρξεζηκνπνηνχληαη επξχηαηα ζην ρψξν ηεο πιεξνθνξηθήο θαη εηδηθά ζην ρψξν ησλ 

πξνζνκνηψζεσλ. Ζ Fortran είλαη κηα θαζαξά «επηζηεκνληθή – ππνινγηζηηθή» γιψζζα 

πξνγξακκαηηζκνχ αθνχ ε δνκή ηεο ηελ θαζηζηά θαηάιιειε γηα επίιπζε καζεκαηηθψλ θαη 

επηζηεκνληθψλ πξνβιεκάησλ. Ζ ζπγθεθξηκέλε γιψζζα έρεη ρξεζηκνπνηεζεί παξάιιεια κε ηηο 

ππφινηπεο γηα ζχγθξηζε ζηνλ ηξφπν πινπνίεζεο. Καη απηφ γηαηί; Γηαηί απιά ε ζπγθεθξηκέλε γιψζζα 

ζηηο εθαξκνγέο φπνπ ρξεζηκνπνηείηαη πεξηέρεη ιηγφηεξεο εληνιέο, άξα είλαη ηαρχηεξε φζν αλαθνξά 

ηελ εμαγσγή απνηειεζκάησλ αιιά σο εθεί. Με ηελ ρξήζε ηεο ζπγθεθξηκέλεο γιψζζαο δελ κπνξνχκε 

λα έρνπκε γξαθηθφ πεξηβάιινλ, δελ κπνξνχκε λα έρνπκε online αιιαγέο ζηηο ηηκέο. Κάζε θνξά πνπ 

ζέινπκε λα αιιάμνπκε κηα κεηαβιεηή πξέπεη λα μαλαθάλνπκε ηελ ίδηα απηνκαηνπνηεκέλε δηαδηθαζία 

δειαδή παηψληαο «εθηέιεζε» ην πξφγξακκα λα ειέγμεη γηα ζθάικαηα ζηνλ θψδηθα, λα δεκηνπξγήζεη 

αξρείν πξνγξάκκαηνο απφ εθεί ν «ζπλδέηεο» (linker) λα δεκηνπξγήζεη εθηειέζηκν αξρείν θαη κεηά λα 

βγνπλ ηα απνηειέζκαηα. Δίλαη κηα επίπνλε δηαδηθαζία εηδηθά αλ ζέινπκε λα πάξνπκε απνηειέζκαηα 

πνιιαπιψλ θαηαζηάζεσλ θαη δελ καο ελδηαθέξεη πάξα πνιχ ε αθξίβεηα ησλ απνηειεζκάησλ. Ζ 

ζπγθεθξηκέλε γιψζζα αθφκε θαη ζήκεξα ρξεζηκνπνηείηαη θαη αλαπηχζζεηαη θαλνληθά ιφγσ ηεο 

αθξίβεηα ησλ απνηειεζκάησλ πνπ δίλεη. 
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Ζ γιψζζα C++ είλαη κία γιψζζα αληηθεηκελνζηξαθήο φπσο θαη ε Java. Ζ δηαθνξά ηνπο είλαη φηη ε 

C++ δελ είλαη ζπκβαηή κε ην πξσηφθνιιν HTML νπφηε δελ κπνξεί λα ρξεζηκνπνηεζεί ζην δηαδίθηπν 

θαη ζε online εθαξκνγέο. Ζ C++  είλαη θαηάιιειε γιψζζα γηα ηελ αλάπηπμε δνκεκέλσλ εθαξκνγψλ. 

Ζ δεκηνπξγία ςεθηαθψλ βηβιηνζεθψλ θαη επαλαρξεζηκνπνηνχκελνπ θψδηθα είλαη πνιχ απιή. Απηφ 

έρεη σο απνηέιεζκα νπνηαδήπνηε εθαξκνγή «ρξεηάδεηαη» κέξνο ηνπ θψδηθα κηαο εθαξκνγήο πνπ έρεη 

πινπνηεζεί απηφ «δαλείδεηαη» κε ηελ κνξθή βηβιηνζήθεο ή εμσηεξηθήο ηάμεο κε ηελ ρξήζε κηαο 

ηδηφηεηαο ,πνπ ηζρχεη θαη ζηελ Java, ηεο θιεξνλνκηθφηεηαο. Τπνζηεξίδεη ην γξαθηθφ πεξηβάιινλ ηφζν 

ζε πεξίπησζε δηεπηθάλεηαο φζν θαη απνηειεζκάησλ. Βαζηθφ κεηνλέθηεκα ε αλάγθε χπαξμεο θαη εδψ 

compiler (κεηαγισηηηζηή). ΢ε πεξηβάιινλ Linux ην παθέην ηεο GNU πξνζθέξεη πιεζψξα 

κεηαγισηηηζηψλ φπσο απηφ ηεο C++, C, Fortran θαη άιινπο. ΢ε πεξηβάιινλ Windows εθηφο απφ ηνπο 

εκπνξηθνχο ηεο ΗΒΜ ηεο Borland θαη ηελ Microsoft ππάξρνπλ θαη νη δσξεάλ φπσο ν Bloodshed Dev-

C++ . Έλα ζεκαληηθφ πξφβιεκα είλαη ε αζπκβαηφηεηα πνπ ππάξρεη ζηνλ πεγαίν θψδηθα κεηαμχ ησλ 

δηαθνξεηηθψλ εθδφζεσλ ηεο C++ αιιά θαη ηελ Fortran. Σν ηειηθφ «πξντφλ» ηξέρεη παληνχ αιιά ν 

θψδηθαο κπνξεί λα πεξηέρεη εληνιέο πνπ θάπνηα άιιε έθδνζε δηαθνξεηηθήο εηαηξίαο λα κελ ηελ 

ππνζηεξίδεη. (Σν ζπγθεθξηκέλν πξφβιεκα ην ζπλάληεζα ζηνλ θψδηθα πνπ δηφξζσζα. Ο 

ζπγθεθξηκέλνο θψδηθαο ήηαλ γξακκέλνο ζε πεξηβάιινλ Linux θαη ρξεηάζηεθε λα θάλσ θάπνηεο κηθξέο 

αιιαγέο πξνθεηκέλνπ λα ηξέμεη.)             

Όια απηά ηα πξνβιήκαηα μεπεξληνχληαη κε ηελ ρξήζε ηεο Java. Ξεθηλάκε απφ ην φηη είλαη δσξεάλ. 

Έρεη πνιχ θαιή ηεθκεξίσζε θαη φπσο είδακε θαη παξαπάλσ ππάξρνπλ πνιιέο πεγέο ζην δηαδίθηπν 

ηφζν γηα ηελ εθκάζεζή ηεο φζν θαη γηα πξσηνγελή θψδηθα. Υξεζηκνπνηείηαη επξχηαηα ζην δηαδίθηπν 

ηφζν ζηελ δεκηνπξγία εθέ ζηηο ζειίδεο φζν θαη γηα ηελ δεκηνπξγία γξαθηθψλ. Τπνζηεξίδεη γξαθηθφ 

πεξηβάιινλ θαζψο επίζεο θαη ηελ δεκηνπξγία ςεθηαθψλ βηβιηνζεθψλ ή παθέησλ γηα ηελ 

επαλαρξεζηκνπνίεζε θψδηθα. ΢εκαληηθφ πιενλέθηεκα γηα ηελ ρξήζε ηεο ζηηο πξνζνκνηψζεηο είλαη ηα 

πξνγξακκαηάθηα – κηθξνεθαξκνγέο κε ηελ νλνκαζία applets. Απηά ρξεζηκνπνηνχληαη επξχηαηα γηα 

εθπαηδεπηηθνχο ζθνπνχο θαη εηδηθά γηα πξνζνκνίσζε πεηξακάησλ αθνχ ν ηξφπνο πινπνίεζεο είλαη 

ηέηνηνο πνπ ππνζηεξίδεη θαη ην γξαθηθφ πεξηβάιινλ ηφζν ζηελ δηεπηθάλεηα φζν θαη ζην ηειηθφ 

απνηέιεζκα, θαη επηπιένλ πξνζθέξεη ηε δπλαηφηεηα ζην ρξήζηε λα αιιάμεη ηηο παξακέηξνπο online 

θαη λα πάξεη δηαθνξεηηθά απνηειέζκαηα. 

Έλα αθφκε ζεηηθφ ζηνηρείν ηεο Java είλαη φηη είλαη ζπκβαηή κε φια ηα ζπζηήκαηα θαη ε ίδηα 

εθαξκνγή ρσξίο θακία αιιαγή κπνξεί λα ηελ ηξέμεη ή λα ηελ επεμεξγαζηεί θάπνηνο ζε φπνην ζχζηεκα 

ζέιεη ρσξίο θαλέλα πξφβιεκα (Windows/Linux). Καη απφ ηελ ζηηγκή πνπ ν θψδηθαο είλαη αλνηθηφο 

θαη κπνξεί θάπνηνο λα ηνλ επεμεξγαζηεί, κπνξεί λα κεηαθέξεη ηηο νδεγίεο θαη ηηο εληνιέο ζηε γιψζζα 

πνπ επηζπκεί (Διιεληθά, Αγγιηθά θ.α) 

Ζ Java κπνξεί λα ρξεζηκνπνηεζεί θαη σο εξγαιείν αμηνιφγεζεο αθνχ ππνζηεξίδεη ηελ δεκηνπξγία 

αζθήζεσλ ή εξσηεκαηνινγίσλ κε άκεζε ή έκκεζε βαζκνιφγεζε. 

Απηνί είλαη θαη νη ιφγνη πνπ ε πιεηνςεθία ησλ εθπαηδεπηηθψλ εθαξκνγψλ πνπ ππάξρνπλ ζην 

δηαδίθηπν έρνπλ πινπνηεζεί ζηε γιψζζα απηή.  
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8 ΢ΤΜΠΔΡΑ΢ΜΑΣΑ 
 

΢ε απηή ηελ ελφηεηα ζα ζπλνςίζνπκε ηα ζεκαληηθφηεξα ζπκπεξάζκαηα πνπ πξνθχπηνπλ απφ ηηο 

αλαιχζεηο πνπ παξνπζηάζηεθαλ ζηα πξνεγνχκελα θεθάιαηα.  

8.1 Ζ ρξήζε Blog – Wiki - Webquest ζηελ εθπαίδεπζε 

Ζ ρξεζηκνπνίεζε ηεο ηερλνινγίαο Web 2.0 ζηελ εθπαίδεπζε έρεη θέξεη λέα δεδνκέλα ζην ηξφπν 

κάζεζεο ζην δηαδίθηπν. Ζ επηθνηλσλία κεηαμχ ησλ ζπκκεηερφλησλ θαζψο θαη ε ζπγθξφηεζε νκάδσλ 

εξγαζηψλ θεξδίδεη ην «ζηνίρεκα» γηα κηα θαιχηεξε δηαδηθηπαθή δηαδηθαζία κάζεζεο. 

Με ηε ρξήζε ηνπ Web 2.0 δελ απαηηείηαη ε χπαξμε αθξηβνχ εμνπιηζκνχ γηα ηελ πινπνίεζή ηνπ νχηε 

παλάθξηβα ινγηζκηθά. Οπζηαζηηθά απηφ πνπ ρξεηάδεηαη έλα εθπαηδεπηηθφ site είλαη :  

 ζσζηφο παηδαγσγηθφο ζρεδηαζκφο ( ψζηε ε δηαδηθαζία κάζεζεο λα ζηεξίδεηαη ζε 

ζπγθεθξηκέλεο ζεσξίεο κάζεζεο θαη λα είλαη κηα νξγαλσκέλε πξνζπάζεηα) 

 ζηφρνη καζήκαηνο θαη πνξεία λα γίλνπλ ζαθείο ( ψζηε νη εθπαηδεπφκελνη λα μέξνπλ ηη έρνπλ 

λα θάλνπλ θαη πνπ ζα πξέπεη λα θαηεπζπλζνχλ γηα ηελ ζπιινγή εθπαηδεπηηθψλ πιεξνθνξηψλ) 

 παξνρή αλαηξνθνδφηεζεο (ψζηε νη εθπαηδεπφκελνη ζε πεξίπησζε πνπ δπζθνιεπηνχλ ζε 

θάπνην ζεκείν λα κελ αηζζάλνληαη «μεθξέκαζηνη» θαη ηα παξαηήζνπλ, αθνχ δελ ππάξρεη ε 

θπζηθή παξνπζία ηνπο ζηελ ηάμε, θάηη πνπ δεκηνπξγεί κηα ζρεηηθή πίεζε νινθιήξσζεο ηνπ 

έξγνπ) 

 επηθνηλσλία κεηαμχ ζπκκεηερφλησλ (λα έρνπλ ηελ δπλαηφηεηα λα αληαιιάζνπλ ηδέεο θαη 

γλψζεηο) 

 παξνρή θηλήηξσλ γηα ζπλέρηζε ηεο πξνζπάζεηαο (επηβξάβεπζε ησλ πξνζπαζεηψλ κε 

δεκνζίεπζε ησλ εξγαζηψλ ηνπο ζηηο ζειίδεο ηνπο καζήκαηνο) 

 δπλαηφηεηα νκαδηθήο εξγαζίαο (αλάπηπμε θνηλσληθήο ζπκπεξηθνξάο ησλ ζπκκεηερφλησλ θαη 

ηεο ζπλεξγαηηθήο κάζεζεο) 

Όια ηα παξαπάλσ ππνζηεξίδνληαη απφ ην web 2.0 online. Αλάινγα κε ηνπο ζηφρνπο κάζεζεο 

κπνξνχλ λα ρξεζηκνπνηεζνχλ είηε ηα Blogs είηε ηα Wikis είηε ηα Webquest. Καη ηα ηξία 

ππνζηεξίδνπλ φιεο ηηο απαηηήζεηο γηα κηα εθπαηδεπηηθή δηαδηθαζία αιιά ην θαζέλα αλάινγα κε ηνλ 

πξνγξακκαηηζκφ ηεο εθπαηδεπηηθήο δηαδηθαζίαο κπνξεί λα πεηχρεη θαιχηεξα απνηειέζκαηα ζε 

ζπγθεθξηκέλνπο ζηφρνπο. Γηα παξάδεηγκα : 

 Μηα νκαδηθή εξγαζία, ε νπνία πινπνηείηαη ζε πξαγκαηηθφ ρξφλν, θάζε κέινο ηεο νκάδνο 

ζέιεη λα ζπκπιεξψλεη ζην έξγν ηε δηθή ηνπ δνπιεηά θαη ε ππφινηπνη λα βιέπνπλ αλά πάζα 

ζηηγκή ηελ πνξεία ηεο εξγαζίαο, ε επηινγή είλαη ην Wiki.  

 Αλ ν εθπαηδεπηήο ζέιεη λα βειηηψζεη ηηο δεμηφηεηεο αλάγλσζεο θαη γξαθήο ησλ 

εθπαηδεπνκέλσλ ηνπ απηφ πνπ ζα επηιέμεη είλαη ε δεκηνπξγία ελφο Blog 
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 Σέινο αλ ζέιεη λα ειέγμεη ηελ φιε δηαδηθαζία θαη λα θαζνδεγεί ηνπ εθπαηδεπνκέλνπο ηνπο 

ηφηε ε ρξήζε ηνπ Webquest είλαη επηβεβιεκέλε.  

8.2 Ζ ρξήζε ΣΝ ζηελ εθπαίδεπζε 

 

Ζ ρξήζε ηεο Σ.Ν ζην ζρεδηαζκφ ελφο επθπνχο ζπζηήκαηνο δηδαζθαιίαο απνδεηθλχεη ζρεηηθή 

βειηηζηνπνίεζε ζηε γλσζηηθή επίδνζε ησλ εθπαηδεπφκελσλ. 

Ο ζρεδηαζκφο ησλ δηαθφξσλ ηκεκάησλ ελφο επθπνχο ζπζηήκαηνο δηδαζθαιίαο(Δ΢Γ) γηα ηηο θπζηθέο 

επηζηήκεο κε ζθνπφ ηελ εθπαηδεπηηθή ή/θαη δηδαθηηθή ηνπο αμηνπνίεζε   ζα πξέπεη λα αληρλεχεη ηηο 

καζεζηαθέο δπζθνιίεο ησλ εθπαηδεπφκελσλ. 

Γηα ην ζθνπφ απηφ ζα πξέπεη ζηα δηάθνξα ηκήκαηα ηνπ ζπζηήκαηνο λα παξέρεηαη θαηάιιειν πιηθφ, 

ππνδείμεηο, ελαιιαθηηθέο κέζνδνη ιχζεο (scaffolding) ελψ νη δηδαθηηθέο ιεηηνπξγίεο –ζηα δηάθνξα 

ηκήκαηα ηνπ Δ΢Γ- ζα πξέπεη λα παξέρνπλ ηε δπλαηφηεηα γηα : 

1. πξφβιεςε ( δειαδή δηαθνξεηηθνχο ηξφπνπο παξνπζίαζεο ηνπ γλσζηηθνχ αληηθεηκέλνπ) 

2. έιεγρν( δειαδή παξνρή βνήζεηαο, ππνδείμεσλ, επηινγή βαζκνχ δπζθνιίαο πξνβιήκαηνο) θαη  

3. δηφξζσζε( δειαδή ππνδείμεηο γηα ηηο παξαλνήζεηο, ζρεηηθή ζεσξία, απφθαζε γηα πξφβιεκα άιινπ 

βαζκνχ δπζθνιίαο θιπ). 

Σα Δ΢Γ κπνξνχλ λα ρξεζηκνπνηεζνχλ γηα ηελ αλίρλεπζε ησλ καζεζηαθψλ δπζθνιηψλ αιιά θαη ηεο 

κεηαγλσζηηθήο ζηξαηεγηθήο.  

Ζ δηαζχλδεζε ησλ Δ΢Γ θαη ησλ κεηαγλσζηηθψλ ζηξαηεγηθψλ είλαη εκθαλήο θαζψο ε κεηαγλσζηηθή 

«κεζνδνινγία» πεξηιακβάλεη  

1. Σε δηδαζθαιία ησλ καζεηψλ(εθπαηδεπφκελσλ)  ψζηε λα ιακβάλνληαη  ππφςε παξάγνληεο πνπ 

ζρεηίδνληαη κε ηε ιχζε πξνβιεκάησλ 

2. Σε δηδαζθαιία πνπ επηηξέπεη ζηνπο καζεηέο λα ειέγρνπλ ηηο δηαδηθαζίεο ηηο ζρεηηθέο κε ηελ 

επίιπζε πξνβιεκάησλ  

3. Σελ αχμεζε ηεο απνηειεζκαηηθφηεηαο ηνπο ζηε ρξήζε εηδηθψλ γλσζηηθψλ δεμηνηήησλ πνπ 

εθαξκφδνληαη θαηά ηελ επίιπζε πξνβιεκάησλ ( ηαθηηθέο απηναμηνιφγεζεο, θσδηθνπνίεζε ηεο 

πιεξνθνξίαο θιπ). 

8.3 Ζ ρξήζε ηεο πξνζνκνίσζεο ζηελ εθπαίδεπζε 

Όπσο είδακε κε ηελ ρξήζε ηεο πξνζνκνίσζεο ζε ζεσξίεο ηεο θπζηθήο δίλεηαη ε δπλαηφηεηα ζηνπο 

εθπαηδεπφκελνπο λα επηβεβαηψλνπλ ή φρη ηηο ζεσξίεο θαη ηηο ππνζέζεηο πνπ είραλ θάλεη πξηλ απφ ηελ 

εθηέιεζή ηεο. Δδψ φκσο ηίζεηαη έλα εξψηεκα. Δίλαη πάληα επηηπρεκέλε απηή ε δηαδηθαζία; Τπάξρεη 

πεξίπησζε παξά ηελ ρξήζε ησλ λέσλ ηερλνινγηψλ θαη ησλ πξνζνκνηψζεσλ  λα κελ έρνπκε ηα 
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επηζπκεηά απνηειέζκαηα; Οη Reinhold θαη Freudenreich (2003) ζηελ έξεπλά ηνπο γηα ηελ ρξήζε 

πξνζνκνίσζεο ζε καζήκαηα θπζηθήο επηβεβαίσζαλ ηνπο ηζρπξηζκνχο ησλ Eisenstadt θαη Vincent 

(2000: xi) ζρεηηθά κε ηελ αλάγθε χπαξμεο παηδαγσγηθνχ πξνηχπνπ θαη ζρεδηαζκνχ. Σα απνηειέζκαηά 

ηνπο δελ ήηαλ ηα αλακελφκελα. Γηαπίζησζαλ φηη είραλ θάλεη ιάζε ζην ζρεδηαζκφ ηεο δηαδηθαζίαο 

ηέιεζεο ησλ δχν πεηξακάησλ. Σα ζνβαξφηεξα είραλ λα θάλνπλ κε ιάζε ζην ζρεδηαζκφ : γηα ην πξψην 

πείξακα ήηαλ ζηηο νδεγίεο θαη γηα ην δεχηεξν ζηνλ ηξφπν πνπ έπξεπε λα αμηνπνηήζνπλ ηα 

απνηειέζκαηα πξνθεηκέλνπ λα εθηειέζνπλ ην δεχηεξν ζσζηά.    

Αλ ππνζέζνπκε φηη ν ζρεδηαζκφο είλαη ζσζηφο ε ρξήζε ησλ «εηθνληθψλ» εξγαζηεξίσλ δίλνπλ 

εθπαηδεπφκελνπο : 

 Διεπζεξία θηλήζεσλ ζηελ ηέιεζε ησλ πεηξακάησλ ( κπνξνχλ ειεχζεξα λα αιιάδνπλ ηηο 

παξακέηξνπο θαη λα δεκηνπξγνχλ ηηο ζπλζήθεο πνπ επηζπκνχλ) 

 Αζθάιεηα (δελ ππάξρεη θαλέλαο θίλδπλνο γηα ηελ ζσκαηηθή ηνπο αζθάιεηα) 

 Σε δπλαηφηεηα λα κπνξνχλ λα θαηαγξάςνπλ ην θαηλφκελν θαη λα ην ρξεζηκνπνηήζνπλ 

αξγφηεξα ( κία δχζθνιε πξνζνκνίσζε κπνξεί λα δεκηνπξγεζεί κέζα ζε έλα ρξνληθφ 

δηάζηεκα) 

 Σε δπλαηφηεηα λα κπνξνχλ λα δνπιέςνπλ νκαδηθά ( ην θάζε κέινο λα αλαιάβεη ηελ 

δεκηνπξγία κέξνπο ηεο πξνζνκνίσζεο θαη ζην ηέινο λα ελσζνχλ φια ηα θνκκάηηα 

πξνθεηκέλνπ λα εθηειεζηή ε πξνζνκνίσζε) 

 Σε δπλαηφηεηα λα ηεθκεξηψλνπλ ην θάζε βήκα ψζηε φηαλ αλαηξέμνπλ ζηε ζπγθεθξηκέλε 

πξνζνκνίσζε λα κπνξνχλ λα «ζπκεζνχλ» ην γηαηί θαη ην πσο 
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ΠΑΡΑΡΣΖΜΑΣΑ 
 

ΠΑΡΑΡΣΖΜΑ A: Πώο λα θηηάμνπκε έλα Webquest κε ην Microsoft Word 

Σν παξαθάησ θείκελν είλαη απφ ην Radford City Schools site( http://rcs.rcps.k12.va.us) θαη δίλεη βήκα 

– βήκα ηε δηαδηθαζία γηα ηελ πινπνίεζε ελφο απινχ webquest κε ηελ ρξήζε ηνπ πην γλσζηνχ 

θεηκελνγξάθνπ, ηνπ Word ηεο Microsoft. 

Files and Folders: 

1. Insert disk into the A: drive 

2. Double-click My Computer 

3. Double-click the A: drive icon 

4. Click on File > New > Folder 

5. Before doing anything else, type in the new name of your folder then click anywhere off your 

folder  

 Folder names should contain no spaces and no capital letters 

 Everything you use for your WebQuest must be saved to this folder 

6. Close all windows 

 

Starting a Web page in Word: 

1. Open Word  

2. Before typing anything, go to File > Save as HTML  

 Remember to save inside your folder on the A: drive and name it something with no spaces or 

capital letters (This name is the one you will see when you put it in your favorites or 

bookmarks.) 

 You will actually type only the words / phrases in an italic font.  

 

Inserting Clip Art: 

1. Center your first line by clicking the Center button on the formatting tool bar 

2. Click on Insert > Picture > ClipArt  

http://rcs.rcps.k12.va.us/
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3. Select the picture you want > click on the Insert button 

4. Resize if necessary (click on picture, drag the handles inward to the desired size)  

 Note: Clip Art that is inserted through Word will be automatically saved with your page into 

the same folder. 

5. Click to the right of the clipart to deselect the image (the blinking cursor should appear) 

  

Inserting Scrolling Text: 

1. Click on Insert > Scrolling Text 

2. Change the words "sample text" to your WebQuest title 

3. Make any other changes as necessary - you can always come back and change the settings and 

colors as you complete your Web page.  

4. Click OK (Note: it may not move in this view) 

5. A border around a text box means that it is selected and you can change the font.  Increase the font 

size (use the A with the little up-arrow) and change the box size if needed. 

6. Click to the right of the scrolling text box to deselect it and press Enter 

 

Inserting a Horizontal Rule (or Line): 

1. Make sure your cursor is still centered 

2. Click on Insert > Horizontal Line 

3. If presented with multiple options, choose your design and click OK 

4. You will most likely need to resize the line - in general you want it slightly shorter than the 

longest line of text. 

5. Click to the right of the scrolling text box to deselect it and press Enter 

6. Left align your cursor by using the button on the formatting toolbar 

 

Save Often 

Adding the Text for the WebQuest: 

1. On the new line, type Introduction: in bold 

2. Hold down the Shift key and press Enter (this gives you a paragraph break without the space 

added when you just press Enter) 
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3. Type the following (not bolded): Top Priority: You have been chosen to embark on a training 

mission that involves the discovery and understanding of the how to build a WebQuest. In order to 

fulfill this mission you will need to relax, keep smiling, and follow the instructions to the letter. 

4. Press Enter 

 

1. On the new line, type Task: in bold 

2. Hold down the Shift key and press Enter 

3. Type the following (not bolded):   

The objectives of your mission are:  

4. Press Enter then click on the numbering button on the toolbar. 

5. Type the following: 

1. to seek out and investigate the various kinds of known WebQuests (Press Enter) 

2. to understand the basic principles of a WebQuest (Press Enter) 

3. to return to your school with an example WebQuest you have built (Press Enter) 

6. Press Enter then click on the numbering button again to turn it off. 

 

1. On the new line type Process: in bold 

2. Hold down the Shift key and press Enter 

3. Type the following (not bolded): Listen to your team leaders, follow instructions, and refer to your 

handouts when necessary. Learning advice: Keep smiling, have fun, and pay attention so we can 

have time for a break.  

4. Press Enter 

 

Save Often 

Making a hyperlink to the Web: 

1. On the new line, type Resources: in bold 

2. Press Enter 

3. Take off the bolding and add a bulleted list by clicking on the button on the formatting tool bar  

4. Type the following: Free clipart can be found at Barry’s Clipart! and at ClipArt.com 
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5. Send Microsoft Word to the taskbar using the first control button at the top right of the program  

6. Open the Internet either from the desktop icon or from Start > Programs > the Internet browser 

7. Type the following into the address field: http://www.barrysclipart.com/  then push Enter 

8. To copy the address, click in the address field one time to turn it blue then click on Edit > Copy 

9. Click on the Microsoft Word button on the taskbar 

10. Select (highlight) the words Barry’s Clipart! 

11. Click on Insert > Hyperlink 

12. Hold down Ctrl and press the letter v once to paste the address into the Link to File or URL field 

(the first one) 

13. Make sure there is NOT a checkmark beside the words "Use relative path for hyperlink"  

14. Click OK  

15. Notice how the words Barry’s Clipart! have changed to a hyperlink 

 

Part 2:  

Link the word ClipArt.com to the Web site http://www.clipart.com/  (Remember to type the address 

into the browser to check for accuracy, then copy and paste it back to Word to make the link). 

To check your links, click on File > Web Page Preview.  The default browser will open to show you 

your Web page so far. Click on the links to test them. To get out of the preview, close the Internet or 

click on Word on the taskbar.   

Part 3: 

1. Press Enter for a new bullet  

2. Go back to the Internet (using the button on the taskbar) and type in the following web address: 

http://www.mediabuilder.com/  and press Enter 

3. Right click on the word MediaBuilder, then left click on Save Picture As 

4. Rename the file to mediabuilder and save it to your folder on the A: drive 

5. Move back to Word 

6. Go to Insert > Picture > From File and click 

7. Browse to the A: drive, your folder, click on mediabuilder, then click on the Insert button 

8. Resize if necessary and type on the same line will help you create buttons, animated banners, and 

more. 
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9. Go back to the Internet and copy the address 

10. Move to Word and click once on the mediabuilder image > Insert > Hyperlink > paste the address 

as before, uncheck the Relative Path box, and click OK  

11. Move your cursor to the end of the sentence (to the right of the word more) and press Enter 

12. Turn off the bulleted list by clicking on the bullet button again 

 

Save Often 

Inserting an Animated GIF: 

1. Press the Centering button on the formatting toolbar 

2. Move back to the Internet using the button on the task bar 

3. Type in the following address: http://www.animatedgifs.com/ 

4. Right click on the animation of the day in the center of the page, then left click on Save Picture As 

5. Rename the file to anofday and save it to your folder on the A: drive 

6. Move back to Word 

7. Go to Insert > Picture > From File and click 

8. Browse to the A: drive, your folder, click on anofday, then click on the Insert button 

9. Resize if necessary (Note that it may not animated in this view) 

10. Click to the right of the animation to deselect it and press Enter 

11. Left align your cursor using the button on the formatting toolbar 

Adding the Evaluation Rubric in a Table Form: 

1. On the new line, type Evaluation: in bold  

2. Hold down the Shift key and press Enter 

3. Type the following (not bolded): In order to determine the success of your mission it is important 

to understand exactly what you are expected to do. 

4. Press Enter 

5. Click on Table > Insert Table > 4x5 table and Click 

6. Type the following in the cells across the top of your table (use the Tab key to move to the next 

cell) 

7. Cell one – Task 
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8. Cell two – Okay (1-3) 

9. Cell three – Good (4-7) 

10. Cell four – Excellent (8+) 

11. Cell five – Total 

12. Move your cursor to the cell directly under the word Task 

13. Type: Made a WebQuest > Push the down arrow key 

14. Type: Understand WebQuest Principles > Push the down arrow key 

15. Type: Saved my WebQuest 

16. With your cursor still inside the table, click on Table > Select Table 

17. Click on Table again > Borders > Grid, change the line width if desired then click OK 

18. You may want to resize your table by clicking and dragging the right border (Word's tables tend to 

widen when seen on the Internet and will add a horizontal scroll bar to your browser.) 

19. Click below the table and press Enter 

 

Save Often 

Now Let’s Sum It All Up: 

1. Type Conclusion: in bold 

2. Hold down the Shift key and press Enter 

3. Type the following (not bolded): I kept smiling, I had fun, and I paid close attention to my team 

leaders. Now I will take this knowledge home and create the best WebQuest ever! 

 

Save Often 

 

Inserting a Menu Bar: 

1. Click to the right of the scrolling text box at the top of the page 

2. Press Enter and make sure your cursor is center aligned 

3. Type Introduction > Space > Shift+Backslash > Space 

4. Type Task > Space > Shift+Backslash > Space 

5. Type Process > Space > Shift+Backslash > Space 
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6. Type Resources > Space > Shift+Backslash > Space 

7. Type Evaluation > Space >Shift+Backslash > Space 

8. Type Conclusion > Space  

 

Linking Your Menu Bar: 

1. Click in front of the word Introduction: within the body of the page (where the paragraph is 

located) 

2. Click on Insert > Bookmark and name it Introduction > click Add 

3. Double Click the word Introduction that is located directly below the clipart and scrolling text 

(this selects the word) 

4. Click on Insert > Hyperlink 

5. Click on the Browse button beside the “Named location in File” field (the lower one) and choose 

the Introduction bookmark that you just created 

6. Make sure there IS a checkmark beside the words "Use Relative Path for Hyperlink"  

7. Click OK 

8. Repeat steps 1 – 7 for each word, linking it to its proper section 

9. Test your links 

 

Save Often 

 

 

 

Word WebQuests & Web Pages: Tips and Tricks  

 Help and Undo are your friends!  Use them often! 

 To edit your Web page, first open Word, then open your html file.  If you simply click on the file 

from your disk, it will open in the browser where you are unable to make changes.   

 

Adding a background to your Web page: 

 Format > Background > take a look at the Fill Effects and the More Colors options 

Congratulations, you have completed your basic WebQuest training!  

To view your WebQuest through your browser, click on File > Web 

Page Preview. 
 

When you post your WebQuest to a server or to desktop, move the 

entire folder. 
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 Remember to use high contrast colors between the background and the text 

 

To change the word wrap around a picture: 

 You must have your picture toolbar turned on (Click on View > Toolbars > Picture) and the 

image selected (click on it).  

 The toolbar will show buttons that allow different text wrapping. 

 

 The smaller your picture files are the faster they will load.  Picture files should have the extensions 

of either .jpg or .gif 

 

To actually view the html code, click on View > HTML Source. To get back, click on the Exit HTML 

Source button (top left).  A lot of good things can be learned from viewing other pages source codes. 

In the address http://edweb.sdsu.edu/webquest/webquest.html - edweb.sdsu.edu is the name of the 

server, webquest is the name of the folder, and webquest.html is the name of the actual Web page you 

are viewing.  

Any WebQuest can be tailored to suit any purpose needed - it can be downsized, shortened, or extra 

worksheets and Internet sites can be added.  But, if you are modifying someone else's work to fit your 

needs, PLEASE be sure to give the original author credit and site the WebQuest's original location. 

 

A computer lab is the ideal setting for WebQuests since each student (or group of students) is provided 

with a computer and Internet access. WebQuests are harder to adapt to large monitor/single computer 

classroom settings.  However, they are wonderful for individual or self-paced studies within the 

classroom or home. 

Usually WebQuests require an Internet connection, however, software like WebWhacker or 

WebBuddy allows one to save and use a WebQuest without the benefit of an Internet connection. In 

addition, sites come and go - saving the sites one links to also allows the project to be used year to 

year. Burning the projects onto a CD allows easy movement and access to the files. If you do not have 

a server to post your WebQuest on or are unsure how to do that, consider moving the entire WebQuest 

folder onto desktop.  This will allow students to access your Web page and still be able to follow the 

links to the Internet.
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